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Access lets you trap some errors that can occur during program execution. By using the error-
trapping commands mentioned in Chapter 7, “Handling Your Errors in Access with VBA,” you
can anticipate errors and handle them accordingly.

The following table lists both Access 2002 application/VBA errors and Jet 4.0 errors. The error
numbers can potentially go up to 32767, with user-definable errors from 30000 on.

The code in Listing E.1 creates the data in the upcoming table.

LISTING E.1 Storing All Access and Jet Errors to a Table

Sub CreateErrorTable()
Dim cnn As ADODB.Connection
Dim rst As New ADODB.Recordset
Dim lngCurr As Long

Set cnn = CurrentProject.Connection
cnn.Execute “Delete • From tblErrors”
rst.Open “tblErrors”, cnn, adOpenKeyset, adLockOptimistic

For lngCurr = 1 To 33000
If Len(AccessError(lngCurr)) > 0 And AccessError(lngCurr) <> _

“Application-defined or object-defined error” Then
rst.AddNew
rst![Error Number] = lngCurr
rst!Description = AccessError(lngCurr)
rst.Update

End If
Next lngCurr

End Sub

A few items to note:

• Some Jet errors use the | symbol, which is a placeholder for variables passed to the
errors. An example of this is error number 3006, Database ‘|’ is exclusively
locked., in which the pipe would be replaced with the name of the database exclusively
locked.

• It’s best to create user-defined errors by using error numbers 30000 and above. By start-
ing at 30000, you have a smaller chance of Access expanding its own errors up that far.

• Errors in which the message is an • are special errors that Access handles in different
ways.



• Errors not listed here are either application-defined or object-defined errors, or are
reserved for future use in new versions of Access or with the Jet engine.

ErrorCode ErrorString

5 Invalid procedure call or argument

6 Overflow

7 Out of memory

9 Subscript out of range

10 This array is fixed or temporarily locked

11 Division by zero

13 Type mismatch

14 Out of string space

16 Expression too complex

17 Can’t perform requested operation

18 User interrupt occurred

28 Out of stack space

47 Too many DLL application clients

48 Error in loading DLL

49 Bad DLL calling convention

51 Internal error

52 Bad file name or number

53 File not found

54 Bad file mode

55 File already open

57 Device I/O error

58 File already exists

59 Bad record length

61 Disk full

62 Input past end of file

63 Bad record number

67 Too many files

68 Device unavailable

70 Permission denied

71 Disk not ready
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ErrorCode ErrorString

74 Can’t rename with different drive

75 Path/File access error

76 Path not found

93 Invalid pattern string

96 Unable to sink events of object because the object is already firing
events to the maximum number of event receivers that it supports

97 Can not call friend function on object which is not an instance of defin-
ing class

98 A property or method call cannot include a reference to a private
object, either as an argument or as a return value

321 Invalid file format

322 Can’t create necessary temporary file

325 Invalid format in resource file

380 Invalid property value

381 Invalid property array index

382 Set not supported at runtime

383 Set not supported (read-only property)

385 Need property array index

387 Set not permitted

393 Get not supported at runtime

394 Get not supported (write-only property)

422 Property not found

423 Property or method not found

424 Object required

429 ActiveX component can’t create object

430 Class does not support Automation or does not support expected inter-
face

432 File name or class name not found during Automation operation

438 Object doesn’t support this property or method

440 Automation error

442 Connection to type library or object library for remote process has
been lost. Press OK for dialog to remove reference.

443 Automation object does not have a default value
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ErrorCode ErrorString

445 Object doesn’t support this action

446 Object doesn’t support named arguments

447 Object doesn’t support current locale setting

448 Named argument not found

449 Argument not optional

450 Wrong number of arguments or invalid property assignment

451 Property let procedure not defined and property get procedure did not
return an object

452 Invalid ordinal

453 Specified DLL function not found

454 Code resource not found

455 Code resource lock error

457 This key is already associated with an element of this collection

458 Variable uses an Automation type not supported in Visual Basic

459 Object or class does not support the set of events

460 Invalid clipboard format

461 Method or data member not found

462 The remote server machine does not exist or is unavailable

463 Class not registered on local machine

481 Invalid picture

482 Printer error

735 Can’t save file to TEMP

744 Search text not found

746 Replacements too long

2001 You canceled the previous operation.

2002 You tried to perform an operation involving a function or feature that
was not installed in this version of Microsoft Access.

2004 There isn’t enough memory to perform this operation. Close unneeded
programs and try the operation again.

2005 There isn’t enough free memory to start Microsoft Access. Close
unneeded programs and try again. For information on freeing memory,
search the Microsoft Windows Help index for ‘memory, trouble-
shooting’.
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ErrorCode ErrorString

2006 The object name ‘|’ you entered doesn’t follow Microsoft Access
object-naming rules. For more information about naming objects, click
Help.

2007 You already have an open database object named ‘|.’ Use a different
name for each database object of the same type. If you want this object
to replace the original object, close the original object, and then save
this object using the same name. For more information on renaming a
database object, click Help.

2008 You can’t delete the database object ‘|’ while it’s open. Close the data-
base object, and then delete it.

2009 You can’t rename the database object ‘|’ while it’s open. Close the data-
base object, and then rename it.

2010 You can’t delete the database object ‘|’ while it’s open. Close the data-
base object, and then delete it.

2011 The password you entered is incorrect.

2014 You have given this |1 the same name as an existing |2 in your data-
base. You can’t give a table and a query the same name. Give this
object a name that isn’t already used by another table or query.

2015 There are no registered wizards of this type. Rerun Microsoft Access or
Microsoft Office Setup to reinstall the wizards. If you want to preserve
your security or custom settings, back up the Microsoft Access work-
group information file. For more information on backing up files,
search the Microsoft Windows Help index for ‘backing up files’.

2016 You can’t modify the attributes of System Tables.

2017 This Visual Basic for Applications Project has been protected with a
password. You must supply the password in the Visual Basic Editor
before you can perform this operation.

2018 The data access page name ‘|’ you entered is misspelled or refers to a
data access page that isn’t open or doesn’t exist.

2019 The number you used to refer to the data access page is invalid. Use
the Count property to count the open data access pages and make sure
that the page number is not greater than the number of open data
access pages minus one.

2020 The data access page theme name ‘|’ you entered is misspelled or refers
to a theme name that doesn’t exist.

2021 One or more operators in the filter expression is invalid. For a valid list
of operators refer to the help file.
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ErrorCode ErrorString

2022 You entered an expression that requires a data access page to be the
active window.

2023 The file name you specified for the data access page already exists.

2024 The report snapshot was not created because you don’t have enough
free disk space for temporary work files. To fix this, free up disk space
(for example, empty the Recycle Bin or delete unnecessary files).

2025 The file is not in the correct format for a Microsoft Access project.

2026 Your computer is missing at least one of the Microsoft Access 97
object libraries. Your converted database will not work until you open
this database using Access 97 and then fix any missing references.
Press OK to continue saving this database in the Access 97 format with
missing references, or press Cancel if you no longer wish to save this
database.

2027 This operation is not supported for Microsoft Access 1.X databases.

2028 Microsoft Access was unable to close the database object.

2029 Microsoft Office applications cannot suspend while you have docu-
ments open from a network location. Exit the applications or close the
open documents and try again.

2030 The Microsoft Access project ‘|’ will be opened read-only because one
of the following occurred: The file is locked for editing by another
user, or the file (or the folder in which it is located,) is marked as read-
only, or you specified that you wanted to open this file read-only.

2031 You can’t convert or enable an MDE file.

2032 Some errors happened during the conversion. No converted database
was generated.

2033 Name conflicts with existing module, project, or object library.

2034 Cannot Compile Project.

2035 Cannot Load Project of wrong version.

2036 Microsoft Access does not support using ADP Projects when running
in Runtime Mode.

2037 Microsoft Access could not perform name AutoCorrect during this
operation. The ‘Log name AutoCorrect’ option is set, but the Data and
Misc. Objects is not checked out.

2038 The file ‘|’ cannot be opened because it has been locked by another
user.

2039 You cannot convert a workgroup file from Microsoft Access2000 to
Access 97. You must create new security settings in Access 97.
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ErrorCode ErrorString

2040 Microsoft Access can’t run.

2041 Microsoft Access couldn’t find file ‘|’. This file is required for startup.

2042 A system error occurred, or there isn’t enough free memory to start
Microsoft Access. Close unneeded programs and try again.

2043 Microsoft Access can’t find the database file ‘|.’ Make sure you entered
the correct path and file name.

2044 You can’t exit Microsoft Access now. If you’re running a Visual Basic
module that is using OLE or DDE, you may need to interrupt the mod-
ule.

2045 The command line you used to start Microsoft Access contains an
option that Microsoft Access doesn’t recognize. Exit and restart
Microsoft Access using valid command-line options.

2046 The command or action ‘|’ isn’t available now.

•  You may be in a read-only database or an unconverted database from
an earlier version of Microsoft Access.

•  The type of object the action applies to isn’t currently selected or
isn’t in the active view. Use only those commands and macro actions
that are currently available for this database.

2048 There isn’t enough free memory to open the file ‘|.’ Close unneeded
programs and try again. For more information on freeing memory,
search the Microsoft Windows Help index for ‘memory, troubleshoot-
ing’.

2049 The Tahoma font is not present. To restore it, please run Detect and
Repair from the Help menu.

2050 Enter an OLE/DDE Timeout setting from 0 through 300 seconds.

2051 The object name ‘|1’ can’t be longer than |2 characters according to
Microsoft Access object-naming rules.

2052 There isn’t enough free memory to update the display. Close unneeded
programs and try again.

2053 The command name can’t be blank. Please choose a name.

2054 Microsoft Access is unable to load the Visual Basic for Applications
dynamic-link library (DLL) Vbe6. Rerun the Microsoft Access Setup
program.

2055 The expression ‘|’ you entered is invalid.

2056 Microsoft Access can’t supply context-sensitive Help.

2057 There isn’t enough stack memory left to perform the operation. The
operation is too complicated. Try simplifying the operation.
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ErrorCode ErrorString

2058 The file ‘|’ is incompatible. Microsoft Access needs to be reinstalled.
Run Setup to reinstall Microsoft Access. If you want to preserve your
security or custom settings, back up the Microsoft Access workgroup
information file. For more information on backing up files, search the
Microsoft Windows Help index for ‘backing up files’.

2059 Microsoft Access cannot find the object ‘|’. Make sure the object exists
and that you spell its name correctly.

2060 You can’t create a field list based on the action query ‘|.’ Action queries
don’t have fields. A form or report must be based on a table, or on a
select or crosstab query. Change the RecordSource property for the
form or report, or open the action query and change it to a select query.

2061 Enter a zero or greater-than-zero number for this option.

2062 The command name must be shorter than 255 Characters. Please
choose a name.

2063 Microsoft Access can’t create, open, or write to the index file ‘|’; the
information (.inf) file it uses to keep track of dBASE indexes. The
index file may be damaged, or you may not have read/write permission
for the network drive you’re trying to link to. You can link to the
dBASE file without specifying any dBASE indexes, but the existing
indexes will not be used with the linked table.

2064 The menu bar value ‘|’ is invalid. You supplied an argument to the
DoMenuItem method that refers to a menu bar that is invalid. Use an
intrinsic constant or numeric value that refers to a valid menu bar
value, such as acFormbar.

2065 The name for the menu, command, or subcommand you entered is
invalid. You supplied an argument to the DoMenuItem method that
refers to a menu name, command, or subcommand that is invalid. Use
an intrinsic constant or numeric value that refers to a valid menu, com-
mand, or subcommand value, such as acRecordsMenu.

2066 A video adapter resolution of at least 640 x 480 pixels is required to
run Microsoft Access.

2067 A menu bar macro can only be run if the menu bar macro name is the
setting used by particular properties or options. You tried to run a menu
bar macro containing the AddMenu action. Set one of the following
properties or options to the name of the menu bar macro:

•  The MenuBar property of a form or report.

•  The ShortcutMenuBar property of a form, report, or control.
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ErrorCode ErrorString

•  The Menu Bar or Shortcut Menu Bar option in the Startup dialog
box.

This error also occurs if Microsoft Access attempts to run a menu bar
macro containing an AddMenu action that follows an action that makes
some other object the active object. For example, the OpenForm action.

2068 The selected item is customized and doesn’t have context-sensitive
Help. For more information on creating custom Help for a form, report,
or control, click Help.

2069 The key or key combination |1 in |2 has invalid syntax or is not
allowed. Use the SendKeys syntax to specify the key or key combina-
tions. For the allowed key or key combinations, click Help.

2070 You already assigned the key or key combination |1 in |2 to another
macro. Only the first key or key combination will be used.

2071 The Docking property can’t be set to ‘|1’ at this time. If you want to set
the Docking property to ‘|2’, move the toolbar from its current position
and try again.

2072 Successfully imported ‘|’.

2073 Successfully exported ‘|’.

2074 This operation is not supported within transactions.

2075 This operation requires an open database.

2076 Successfully linked ‘|’.

2077 This Recordset is not updateable.

2078 Help isn’t available due to lack of memory or improper installation of
Microsoft Windows or Microsoft Access. For more information on
troubleshooting a low memory problem, search the Microsoft Windows
Help index for ‘memory, troubleshooting’. If you need to reinstall
Microsoft Access, you may want to preserve your security or custom
settings. To do so, back up the Microsoft Access workgroup informa-
tion file. For more information on backing up files, search the
Microsoft Windows Help index for ‘backing up files’.

2079 Form is read-only, because the Unique Table property is not set.

2080 The toolbar or menu | already exists. Do you want to replace the exist-
ing toolbar or menu?

2081 The Create From Macro command only works when a macro is
selected in the Database window.

2082 Only fields from the Unique Table can be edited.
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ErrorCode ErrorString

2083 The database ‘|’ is read-only. You can’t save changes made to data or
object definitions in this database.

2084 Field ‘|’ is based on an expression and can’t be edited.

2085 The ODBC Refresh Interval setting must be from 1 through 32,766
seconds.

2086 Recordset requires a form to be updateable.

2087 Microsoft Access can’t display the Add-ins submenu. The Add-ins
submenu expression ‘|’ you entered exceeds the 256-character limit.
Shorten the macroname or functionname expression in the Menu Add-
ins key of the Windows Registry setting, and then restart Microsoft
Access. For more information on customizing Microsoft Access set-
tings in the Windows Registry, click Help.

2088 Microsoft Access can’t display the Add-ins submenu | because a setting
you entered in the Windows Registry is missing a macro name or func-
tion name expression. Supply the missing expression in the Menu Add-
ins key of the Windows Registry, and then restart Microsoft Access.
For more information on customizing Microsoft Access settings in the
Windows Registry, click Help.

2089 Microsoft Access can’t display the same menu more than once in a
menu bar.

2090 An action within the current global menu’s macro group can’t change
the global menu bar. Microsoft Access can’t display the global menu
bar because the macro called when you first set the global menu
includes another action that tries to reset the global menu. Check your
menu bar macros, and make sure that you set the global menu bar only
once.

2091 ‘|’ is an invalid name.

2092 The value you specified for the setting argument in the SetOption
method isn’t the correct type of Variant for this option. You specified a
string when Microsoft Access expected a number. Check the Options
dialog box (Tools menu) to see what type of data is required to set this
particular option. For example, the setting for the Default Database
Folder option must be a string. To see what type of Variant you passed
to the SetOption method, use the VarType function. For more informa-
tion, search the Help index for ‘Variant data type’ and ‘VarType
function’.
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ErrorCode ErrorString

2093 The numeric value for the setting argument in the SetOption method
doesn’t correspond to any list box or option group settings in the
Options dialog box. Valid settings are 0 (the first item in the list)
through | (the last item in the list).

2094 Microsoft Access can’t find the toolbar ‘|.’You tried to run a macro that
includes a ShowToolbar action or a Visual Basic procedure that
includes a ShowToolbar method.

•  The toolbar name may be misspelled.

•  This action may refer to a custom toolbar that was deleted from or
renamed in the current database.

•  This action may refer to a custom toolbar that exists in a different
database.

2095 Microsoft Access can’t switch to |. The Microsoft application you tried
to open can’t be found or hasn’t been installed on your computer.

2096 Microsoft Access can’t open the Microsoft Office application because
it can’t find the dynamic-link library Mstool32. Run Setup to reinstall
Microsoft Access. If you want to preserve your security or custom set-
tings, back up the Microsoft Access workgroup information file. For
more information on backing up files, search the Microsoft Windows
Help index for ‘backing up files’.

2097 The table you tried to create an import/export specification for was cre-
ated in an earlier version of Microsoft Access. Convert this database to
the current version of Microsoft Access by using the Convert Database
command (Tools menu, Database Utilities submenu).

2100 The control or subform control is too large for this location. The num-
ber you entered for the Left, Top, Height, or Width property is too
large or is a negative number. Reduce the size of the control or sub-
form control, or enter a positive number.

2101 The setting you entered isn’t valid for this property. To see the valid
settings for this property, search the Help index for the name of the
property.

2102 The form name ‘|’ is misspelled or refers to a form that doesn’t exist. If
the invalid form name is in a macro, an Action Failed dialog box will
display the macro name and the macro’s arguments after you click OK.
Open the Macro window, and enter the correct form name.
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2103 The report name ‘|’ you entered in either the property sheet or macro is
misspelled or refers to a report that doesn’t exist. If the invalid report
name is in a macro, an Action Failed dialog box will display the macro
name and the macro’s arguments after you click OK. Open the Macro
window, and enter the correct report name.

2104 You entered the control name ‘|,’ which is already in use. You already
have a control on the form with this name, or an existing control has its
name mapped to this name for Visual Basic. Visual Basic maps spaces
in control names to underscores. For example, My Control and
My_Control are treated as duplicate names.

2105 You can’t go to the specified record. You may be at the end of a record-
set.

2106 | errors occurred when you loaded the form or report. You loaded a
form or report that has controls or properties that Microsoft Access
doesn’t recognize and will ignore.

2107 The value you entered doesn’t meet the validation rule defined for the
field or control. To see the validation rule, click Design view, click the
appropriate field, and then, if the property sheet isn’t open, click the
Properties button on the toolbar. Then click the Data tab. To solve this
problem, enter a value that meets the validation rule, or press ESC to
undo your changes.

2108 You must save the field before you execute the GoToControl action,
the GoToControl method, or the SetFocus method. You tried to move
the focus to another control using the SetFocus method, GoToControl
action, or the GoToControl method. Set the macro or method to the
AfterUpdate property instead of the BeforeUpdate property so it saves
the field before changing the focus.

2109 There is no field named ‘|’ in the current record.

2110 Microsoft Access can’t move the focus to the control |.

•  The control may be a type that can’t receive the focus, such as a
label.

•  The control’s Visible property may be set to No.

•  The control’s Enabled property may be set to No.

2111 The changes you made can’t be saved. The save operation may have
failed due to the temporary locking of the records by another user.

• Click OK to try again. You may need to click OK several times (or
wait until the other user closes the table).

• Click Cancel if repeated attempts to save your changes fail.
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ErrorCode ErrorString

2112 The item on the Clipboard can’t be pasted into this control.

2113 The value you entered isn’t valid for this field. For example, you may
have entered text in a numeric field or a number that is larger than the
FieldSize setting permits.

2114 Microsoft Access doesn’t support the format of the file ‘|,’ or file is too
large. Try converting the file to BMP or GIF format.

2115 The macro or function set to the BeforeUpdate or ValidationRule prop-
erty for this field is preventing Microsoft Access from saving the data
in the field.

•  If this is a macro, open the macro in the Macro window and remove
the action that forces a save (for example, GoToControl).

•  If the macro includes a SetValue action, set the macro to the
AfterUpdate property of the control instead.

•  If this is a function, redefine the function in the Module window.

2116 The value in the field or record violates the validation rule for the
record or field. For example, you may have changed a validation rule
without verifying whether the existing data matches the new validation
rule. Click Undo on the Edit menu to restore the previous value, or
enter a new value that meets the validation rule for the field.

2117 Microsoft Access has canceled the Paste operation. The text on the
Clipboard is too long to paste into the form. For example, you may
have pasted too much text into a label or entered too much text in the
ColumnWidths property. Paste smaller sections. For labels, you must
paste fewer than 2,048 characters.

2118 You must save the current field before you run the Requery action.

• If you are running a macro from the Database window, save the field
first, and then run the macro.

• If the macro name is the setting of the BeforeUpdate property in a
Visual Basic function, set the AfterUpdate property to the name of the
macro instead.

2119 The Requery action can’t be used on the control ‘|.’ Certain controls,
such as labels and rectangles, can’t receive the focus; therefore, you
can’t apply a Requery action to them.

2120 To create a form, report or data access page using this wizard, you
must first select the table or query on which the form, report or data
access page will be based.
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2121 Microsoft Access can’t open the form ‘|.’ It contains data that
Microsoft Access doesn’t recognize. Re-create the form or, if you
maintain backup copies of your database, retrieve a copy of the form.

2122 You can’t view a form as a continuous form if it contains a subform, an
ActiveX control, or a bound chart. Set the DefaultView property of the
form to Single Form, Datasheet, PivotTable, or PivotChart.

2123 The control name you entered doesn’t follow Microsoft Access object-
naming rules.

2124 The form name you entered doesn’t follow Microsoft Access object-
naming rules.

2125 The setting for the FontSize property must be from 1 through 127.

2126 The setting for the ColumnCount property must be from 1 through 255.

2127 The setting for the BoundColumn property can’t be greater than the
setting for the ColumnCount property.

2128 Microsoft Access encountered errors while importing |1. For more
detailed error information, see the file ‘|2’.

2129 The setting for the DefaultEditing property must be Allow Edits, Read
Only, Data Entry, or Can’t Add Records. Enter 1, 2, 3, or 4 for the
DefaultEditing property.

2130 The settings for the GridX and GridY properties must be from 1
through 64.

2131 An expression can’t be longer than 2,048 characters.

2132 The setting for the DecimalPlaces property must be from 0 through 15,
or 255 for Auto (default).

2133 You can’t place a form (or report) within itself. Select or enter a differ-
ent form or report to serve as the subform or subreport.

2134 The setting for the Width property must be from 0 through 22 inches
(55.87 cm).

2135 This property is read-only and can’t be set.

2136 To set this property, open the form or report in Design view. For more
information on this property, search the Help index for the name of the
property.

2137 You can’t use Find or Replace now. The fields are not searchable due
to one of the following:

• The fields are controls (such as buttons or OLE objects).

• The fields have no data.

• There are no fields to search.
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ErrorCode ErrorString

2138 You can’t search the field for the specified value. Resolve the error
given in the previous error message before you attempt to search again.

2139 You can’t replace the current value of the field with the replacement
text. Resolve any errors before making further replacements.

2140 Microsoft Access can’t save the change you made to the record in the
Replace operation for the reason given in the previous error message.
Click Undo Current Record on the Edit menu, or enter a new value in
the field.

2141 Microsoft Access can’t find the text you specified in the Find What
box.

2142 The FindRecord action requires a Find What argument. You tried to run
a macro set to one of the current field’s properties, but you left the Find
What argument blank. When you click OK, an Action Failed dialog
box will display the macro name and the macro’s arguments. In the
Macro window, enter text or an expression for the Find What argu-
ment, and try the Search operation again.

2143 You didn’t specify search criteria with a FindRecord action. In the
Macro window, insert a FindRecord action before the FindNext action.

2144 The setting for the ListRows property must be from 1 through 255.

2145 The ColumnWidths property setting must be a value from 0 through 
22 inches (55.87 cm) for each column in a list box or a combo box. If
there is more than one column, separate the numbers with either a
semicolon or the list separator character. List separator characters are
defined in the Regional Settings section of Windows Control Panel.

2146 Microsoft Access can’t save the last change for the reason given in the
previous error message. For example, you may have entered a duplicate
value in a field with an index that prohibits duplicate values. Click
Undo on the Edit menu, or enter a new value in the field.

2147 You must be in Design view to create or delete controls.

2148 The number you used to refer to the form or report section is invalid.
Make sure that the number is less than the number of sections in the
form or report.

2149 The constant you entered for the control type is invalid. For a list of
valid constants you can use to create a control, click Help.

2150 This type of control can’t contain other controls.

2151 The parent control can’t contain the type of control you selected. For
example, you used the CreateControl function to designate an option
group as the parent of a text box.
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2152 You can set group levels for reports only, not for forms.

2153 You can’t specify more than 10 group levels.

2154 You can’t call this function when the Sorting and Grouping box is
open.

2155 Microsoft Access has encountered an error in compiling the Visual
Basic code. You don’t have permission to edit code; inform someone
who does have permission about this error.

2156 Microsoft Access has encountered an error in compiling the Visual
Basic code. Do you want to view the error in its context?

2157 The sum of the top margin, the bottom margin, the height of the page
header, and the height of the page footer is greater than the length of
the page you are printing on.

2158 You can use the Print method and the report graphics methods (Circle,
Line, PSet, and Scale) only in an event procedure or a macro set to the
OnPrint, the OnFormat, or the OnPage event property.

2159 There isn’t enough memory to initialize the Print method or one of the
report graphics methods (Circle, Line, PSet, Scale). Close unneeded
programs and try again to print or preview the report. For more infor-
mation on freeing memory, search the Microsoft Windows Help index
for ‘memory, troubleshooting’.

2160 Microsoft Access couldn’t create the graphic or text. An error occurred
while initializing the Print method or one of the report graphics meth-
ods (Circle, Line, PSet, Scale). Close unneeded programs and try again
to print or preview the report. For information on freeing memory,
search the Microsoft Windows Help index for ‘memory, troubleshoot-
ing’.

2161 The text or expression you entered doesn’t match the type of data you
are searching for. Redefine the text or expression, or search in a differ-
ent field.

2162 A macro set to one of the current field’s properties failed because of an
error in a FindRecord action argument. In the Macro window, change
the Search As Formatted argument to Yes. If you want the argument
setting to remain No, do all of the following:

• Select No for the Match Case argument.

• Select Yes for the Only Current Field argument.

• Make sure you are searching in a bound control.

Access 2002 and Jet 4 Errors

APPENDIX E

E

A
C

C
ESS

2002
A

N
D

JET
4

E
R

R
O

R
S

17



ErrorCode ErrorString

2163 The page number you used as an argument for the GoToPage action or
method doesn’t exist in this form.

2164 You can’t disable a control while it has the focus.

2165 You can’t hide a control that has the focus.

2166 You can’t lock a control while it has unsaved changes.

2167 This property is read-only and can’t be modified.

2169 You can’t save this record at this time. Microsoft Access may have
encountered an error while trying to save a record. If you close this
object now, the data changes you made will be lost. Do you want to
close the database object anyway?

2170 There isn’t enough memory to retrieve data for the list box. Close
unneeded programs. Then close and reopen the active form, and click
the list box again. For more information on freeing memory, search the
Microsoft Windows Help index for ‘memory, troubleshooting’.

2171 You can’t have more than seven nested subforms in a main form.
Remove the eighth nested subform.

2172 You can’t use a pass-through query or a non-fixed-column crosstab
query as a record source for a subform or subreport. Before you bind
the subform or subreport to a crosstab query, set the query’s
ColumnHeadings property.

2173 The control ‘|’ the macro is attempting to search can’t be searched. Try
one of the following:

• Add a GoToControl action before the FindRecord action.

• For the FindRecord action, change the Only Current Field action
argument from Yes to No.

• Change the focus to a searchable control.

2174 You can’t switch to a different view at this time. Code was executing
when you tried to switch views. If you are debugging code, you must
end the debugging operation before switching views.

2175 There isn’t enough free memory to continue the Search operation.
Close unneeded programs. Then try the Search operation again. For
more information on freeing memory, search the Microsoft Windows
Help index for ‘memory, troubleshooting’.

2176 The setting for this property is too long. You can enter up to either 255
or 2,048 characters for this property, depending on the data type.

2177 You can’t insert a report into a form. A report can be inserted only into
a report.

Appendixes for Web Site

PART VI
18



ErrorCode ErrorString

2178 You can’t add another section now. The maximum total height for all
sections in a report, including the section headers, is 200 inches 
(508 cm). Remove or reduce the height of at least one section, and then
add the new section.

2181 You can’t sort on a calculated field in a form. You can sort on a calcu-
lated field only in a query. Create a calculated field in a query, sort the
field, and then base the form on the query. Because the query must
execute before the form opens, the form will open more slowly.

2182 You can’t sort on this field.

2183 Microsoft Access can’t create an object of the type requested. You are
trying either to create a form from a report that has been saved as text,
or to create a report from a saved form.

2184 The value you used for the TabIndex property isn’t valid. The correct
values are from 0 through |.

2185 You can’t reference a property or method for a control unless the con-
trol has the focus. Try one of the following:

• Move the focus to the control before you reference the property. In
Visual Basic code, use the SetFocus method. In a macro, use the
GoToControl action.

• Reference or set the property from a macro or event procedure that
runs when the GotFocus event for the control occurs.

2186 This property isn’t available in Design view. Switch to Form view to
access this property, or remove the reference to the property.

2187 This property is available only in Design view.

2188 The object you attempted to load from text has an invalid value for the
property ‘|1’ on a |2.

2189 Your code contains a syntax error, or a Microsoft Access function you
need isn’t available. If the syntax is correct, check the Control Wizards
subkey or the Libraries key in the Microsoft Access section of the
Windows Registry to verify that the entries you need are listed and
available. If the entries are correct, you need to correct the Microsoft
Access Utility Add-in or the file acWzlib or this wizard has been dis-
abled. To reenable this wizard, click About Microsoft Access on the
Help menu, and then click the Disabled Items button to view a list of
addins which you can enable. Rerun Microsoft Access or Microsoft
Office Setup to reinstall Microsoft Access. Before you reinstall, delete
the Windows Registry keys for the Microsoft Access Utility Add-in and
acWzlib.
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2190 This property has been replaced by a new property; use the new prop-
erty instead.

2191 You can’t set the | property in print preview or after printing has
started. Try setting this property in the OnOpen event.

2192 The bitmap you specified is not in a device-independent bitmap (.dib)
format. You tried to set the PictureData property of a form, report, but-
ton, or image control.

2193 The left margin, right margin, or both margins are wider than the paper
size specified in the Print Setup dialog box.

2194 You can’t set the PictureData property in Datasheet view. To see the
valid settings for this property, search the Help index for ‘PictureData
property’.

2195 The section name you entered doesn’t follow Microsoft Access object-
naming rules.

2196 Microsoft Access can’t retrieve the value of this property. The property
isn’t available from the view in which you’re running the macro or
Visual Basic code, or Microsoft Access encountered an error while
retrieving the value of the property. To see the valid settings for this
property, search the Help index for the name of the property.

2197 You can’t set a subform control’s SourceObject property to a zero-
length string if you’re displaying the main form in Form view. You can
set this property to a zero-length string from Design view, Datasheet
view, or Print Preview.

2200 The number you entered is invalid.

2201 There was a problem retrieving printer information for the |1 on |2. The
object may have been sent to a printer that is unavailable.

2202 You must install a printer before you print. To install a printer, point to
Settings on the Windows Start menu, click Printers, and then double-
click Add Printer. Follow the instructions in the wizard.

2203 The dynamic-link library Commdlg failed: error code ‘0x|’. The printer
driver for the selected printer may be incorrectly installed. For informa-
tion on selecting another printer or reinstalling this printer from
Microsoft Windows, search the Windows Help index for ‘printer
setup’.

2204 The default printer driver isn’t set up correctly. For information on set-
ting a default printer, search the Microsoft Windows Help index for
‘default printer, setting’.
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2205 The default printer driver isn’t set up correctly. For information on set-
ting a default printer, search the Microsoft Windows Help index for
‘default printer, setting’.

2206 The page number you entered is invalid. For example, it may be a neg-
ative number or an invalid range, such as 6 to 3.

2207 Microsoft Access can’t print macros. You tried to use the PrintOut
action or method, but the active object is a macro. If you want to print
an object other than a macro, use the SelectObject action or method to
select the desired object before you run the PrintOut action.

2210 Microsoft Access can’t print or preview the page because the page size
you selected is larger than 22.75 inches.

2211 Microsoft Access can’t print or preview the Debug window.

2212 Microsoft Access couldn’t print your object. Make sure that the speci-
fied printer is available. For information on setting a default printer,
search the Windows Help index for ‘default printer, setting’.

2213 There was a problem retrieving printer information for this object. The
object may have been sent to a printer that is unavailable.

2214 There was a problem retrieving information from the printer. New
printer has not been set.

2220 Microsoft Access can’t open the file ‘|’.

2221 The text is too long to be edited.

2222 This control is read-only and can’t be modified.

2223 The file name ‘|’ is too long. Enter a file name that’s 256 characters or
less.

2225 Microsoft Access couldn’t open the Clipboard. The Clipboard isn’t
responding, probably because another application is using it. Close all
other applications and try the operation again.

2226 The Clipboard isn’t responding, so Microsoft Access can’t paste the
Clipboard’s contents.

• Another application may be using the Clipboard.

• There may not be enough free memory for the paste operation. Close
all other applications, and then copy and paste again.

2227 The data on the Clipboard is damaged, so Microsoft Access can’t paste
it. There may be an error in the Clipboard, or there may not be enough
free memory. Try the operation again.
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2229 Microsoft Access can’t start the OLE server. You tried to use a form,
report, or datasheet that contains an OLE object, but the OLE server
(the application used to create the object) may not be registered prop-
erly. Reinstall the OLE server to register it correctly.

2234 Microsoft Access can’t paste the OLE object.

2237 The text you entered isn’t an item in the list. Select an item from the
list, or enter text that matches one of the listed items.

2239 The database ‘|’ needs to be repaired or isn’t a Microsoft Access data-
base file. You may have quit Microsoft Access unexpectedly with the
database open. To repair the database, click the Repair Database com-
mand on the Tools menu (Database Utilities submenu). If the database
can’t be repaired, the .mdb file is unusable. Restore the database from a
backup copy or create a new database.

2243 The data in the Clipboard isn’t recognizable; Microsoft Access can’t
paste the OLE object.

2244 The file name you specified in the Picture property for a command but-
ton or toggle button can’t be read.

• The file you specified may be corrupted. Restore the file from a
backup copy or re-create the file.

• The disk where the file is located may be unreadable.

2245 The file you specified doesn’t contain valid icon data. Specify a valid
icon file.

2246 Microsoft Access can’t run the query; the parameter values are too
large. The total length of all the values entered for the parameters can-
not exceed 1,024 characters.

2260 An error occurred while sending data to the OLE server (the applica-
tion used to create the object).

• You may have tried to send too much data. If you’re creating a chart
and the chart is based on a query, modify the query so that it selects
less data. If the chart is based on a table, consider basing it on a query
instead so that you can limit the data.

• You may be using an OLE server that doesn’t accept the Clipboard
format.

• You may not be able to start the OLE server because it’s not properly
registered. Reinstall it to register it.

• Your computer may be low on memory. Close other application win-
dows to free up memory.
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2262 This value must be a number.

2263 The number is too large.

2264 Microsoft Access didn’t recognize the unit of measurement. Type a
valid unit, such as inches (in) or centimeters (cm).

2265 You must specify a unit of measurement, such as inches (in) or cen-
timeters (cm).

2266 ‘|’ may not be a valid setting for the RowSourceType property, or there
was a compile error in the function. For information on valid settings
for the RowSourceType property, click Help.

2267 There is not enough disk space to create a temporary buffer file for
printing. Free up some disk space to make room for the temporary
buffer file.

2269 Some library databases couldn’t be loaded because too many were
specified. To change library database references, click References on
the Tools menu.

2272 The setting for the Update Retry Interval must be from 0 through 1,000
milliseconds.

2273 The setting for Update Retries must be from 0 through 10.

2274 The database ‘|’ is already open as a library database.

2275 The string returned by the builder was too long. The result will be 
runcated.

2276 The custom builder you’re using caused an error by changing the focus
to a different window while you were using it. Enter a value without
using the custom builder.

2277 There was a font initialization error.

2278 Microsoft Access can’t save your changes to this bound OLE object.
Either you don’t have permission to write to the record in which the
object is stored, or the record is locked by another user. Copy the
object to the Clipboard (select the object and click Copy on the Edit
menu), and click Undo Current Record on the Edit menu. Then open
the application you used to create the object, paste the object from the
Clipboard, and save it.

2279 The value you entered isn’t appropriate for the input mask ‘|’ specified
for this field.

2280 You have added more output formats to the Windows Registry than
Microsoft Access can initialize. Some output formats will not be avail-
able. Remove those formats that you never or least often use.
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2281 The formats that enable you to output data as a Microsoft Excel, rich-
text format, MS-DOS text, or HTML file are missing or incorrectly
registered in the Windows Registry. Run Setup to reinstall Microsoft
Access or, if you’re familiar with the settings in the Registry, try to cor-
rect them yourself. For more information about the Registry, click
Help.

2282 The format in which you are attempting to output the current object is
not available. Either you are attempting to output the current object to a
format that is not valid for its object type, or the formats that enable
you to output data as a Microsoft Excel, rich-text format, MS-DOS
text, or HTML file are missing from the Windows Registry. Run Setup
to reinstall Microsoft Access or, if you’re familiar with the settings in
the Registry, try to correct them yourself. For more information on the
Registry, click Help.

2283 The format specification for ‘|’ is invalid. You can’t save output data to
a file in this format until you correct the setting for the format in the
Windows Registry. Run Setup to reinstall Microsoft Access or, if
you’re familiar with the settings in the Registry, try to correct them
yourself. For more information on the Registry, click Help.

2284 Microsoft Access can’t write to the file.

• The network may not be working. Wait until the network is working,
and then try again.

• You may be out of memory. Close one or more Microsoft Access
windows, close other applications, and then try again.

2285 Microsoft Access can’t create the output file.

• You may be out of disk space on the destination drive.

• The network may not be working. Wait until the network is working,
and then try again.

• You may be out of memory. Close one or more Microsoft Access
windows, close other applications, and then try again.

2286 Microsoft Access can’t close the file.

• The network may not be working. Wait until the network is working,
and then try again.

• You may be out of memory. Close one or more Microsoft Access
windows, close other applications, and then try again.

2287 Microsoft Access can’t open the mail session. Check your mail appli-
cation to make sure that it’s working properly.
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2288 Microsoft Access can’t load the ‘|’ format. The setting for this format
in the Windows Registry is incorrect. You can’t save the output data to
a file in this format until you correct the setting in the Registry. Run
Setup to reinstall Microsoft Access or, if you’re familiar with the set-
tings in the Registry, try to correct them yourself. For more informa-
tion on the Registry, click Help.

2289 Microsoft Access can’t output the module in the requested format.

2290 There were too many message recipients; the message was not sent.

2291 There are too many message attachments; the message was not sent.

2292 The message text is too long, so it was not sent.

2293 Microsoft Access can’t send this e-mail message. Before attempting to
send an e-mail message from Microsoft Access, resolve the problem
identified in the previous message, or configure your computer to send
and receive e-mail messages.

2294 Microsoft Access can’t attach the object; the message was not sent.

• The network may not be working. Wait until the network is working,
and then try again.

• You may be out of memory. Close one or more Microsoft Access
windows, close other applications, and then try again.

2295 Unknown message recipient(s); the message was not sent.

2296 The password is invalid; the message wasn’t sent.

2297 Microsoft Access can’t open the mail session. You may be out of mem-
ory. Close one or more Microsoft Access windows, close other applica-
tions, and then try again. You may also want to check your mail
application to ensure that it’s working properly.

2298 Microsoft Access can’t start the wizard, builder, or add-in.

• The library database containing the wizard, builder, or add-in may not
be installed. Point to Add-ins on the Tools menu, and then click Add-
in Manager to see if the library database is installed.

• The wizard, builder, or add-in code may not be compiled and
Microsoft Access can’t compile it. There may be a syntax error in the
code.

• The key for the add-in in the Windows Registry file may be incorrect.

2299 Microsoft Access can’t open the Zoom box. The Microsoft Access
Utility add-in is missing or was modified. Rerun Microsoft Access or
Microsoft Office Setup to reinstall Microsoft Access and the Microsoft
Access Utility add-in.
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2300 Microsoft Access can’t output because there are too many controls
selected that have different styles, such as color and font. Select fewer
controls, and then try again.

2301 There are not enough system resources to output the data. Close one or
more Microsoft Access windows and close other applications. Then try
to output the data again.

2302 Microsoft Access can’t save the output data to the file you’ve selected.

• The file may be open. If so, close it, and then save the output data to
the file again.

• If you are using a template, check to make sure the template exists.

• If the file isn’t open, check to make sure that you have enough free
disk space.

• Make sure that the file exists on the path specified.

2303 Microsoft Access can’t output data now.

• The network may not be working. Wait until the network is working,
and then try again.

• You may be out of disk space. Free up disk space and try again.

2304 Microsoft Access can’t save output data to the specified file. Make sure
that you have enough free disk space on your destination drive.

2305 There are too many columns to output, based on the limitation speci-
fied in the output format or by Microsoft Access.

2306 There are too many rows to output, based on the limitation specified by
the output format or by Microsoft Access.

2307 You haven’t selected any data, or the object you’ve selected is blank.

2308 The file ‘|’ already exists. Do you want to replace the existing file?

2309 There is an invalid add-in entry for ‘|.’ There is an error in the Windows
Registry for this add-in. Correct the setting and restart Microsoft
Access. For information on the Registry, click Help.

2311 There isn’t enough memory to run the NotInList event procedure.

2312 The shortcut ‘|’ must be re-created. The file may be missing, damaged,
or in an older format that can’t be read.

2313 Microsoft Access can’t find the shortcut databases ‘|1’ or ‘|2.’ Re-create
the shortcut with the correct locations of the databases.

2314 Microsoft Access can’t find the shortcut database ‘|.’ Re-create the
shortcut with the correct location of the database.
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2315 The input string is too long.

2316 This table or query can’t be opened because it has no visible fields.
This can result if the table or query has only system fields, and the
Show System Objects option is off. To turn on the Show System
Objects option, click Options on the Tools menu, click the View tab,
and select the System Objects check box.

2317 The database ‘|’ can’t be repaired or isn’t a Microsoft Access database
file.

2319 Microsoft Access can’t import the object ‘|’ while it is open.

2320 Microsoft Access can’t display the field for which you entered Where
in the Total row. Clear the Show check box for that field. If you want
this field to appear in the query’s results, add it to the design grid
twice. For the field that will appear in the query’s results, don’t specify
Where in the Total row, and make sure the Show check box is checked.

2321 You can’t set criteria before you add a field or expression to the Field
row. Either add a field from the field list to the column and enter an
expression, or delete the criteria.

2322 You can’t sort on the asterisk (•). Because the asterisk represents all
fields in the underlying table or query, you can’t sort on it. Add the
asterisk to the query design grid, along with the specific fields you
want to sort on. Clear the Show check box for the sorting fields, and
then specify a sort order.

2323 You can’t specify criteria for the asterisk (•). Because the asterisk rep-
resents all the fields in the underlying table or query, you can’t specify
criteria for it. Add the asterisk to the query design grid, along with the
field(s) you want to set criteria for, and then enter criteria for the spe-
cific fields. In the query design grid, clear the Show check box for the
criteria field(s), before you run the query.

2324 You can’t calculate totals on the asterisk (•). Because the asterisk rep-
resents all the fields in the table, you can’t calculate totals on it.
Remove the asterisk from the query design grid. Add the fields you
want to use to the design grid, and then select the total you want to cal-
culate for specific fields.

2325 The field name you entered exceeds the LinkMasterFields property’s
64-character limit. When you use the Relationships command (Tools
menu) to define a relationship between the tables underlying a form
and subform, Microsoft Access links the form and subform automati-
cally and sets the LinkChildFields and LinkMasterFields properties.
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2326 You can’t specify Group By, Expression, or Where in the Total row for
this column. Specify an aggregate function, such as Sum or Count, for
the field or expression you designate as the Value in the crosstab query.
For more information on aggregate functions, click Help.

2327 You must enter Group By in the Total row for a field that has Column
Heading in the Crosstab row. The values derived from the field or
expression that you designate as the Column Heading are used to group
data in the crosstab query.

2328 You can’t run an update query on the asterisk (•). Because the asterisk
represents all the fields in the table, you can’t update it. Remove the
asterisk from the query design grid. Add the fields you want to update
to the design grid.

2329 To create a crosstab query, you must specify one or more Row
Heading(s) options, one Column Heading option, and one Value option.

2330 Microsoft Access can’t represent the join expression | in Design view.

• One or more fields may have been deleted or renamed.

• The name of one or more fields or tables specified in the join expres-
sion may be misspelled.

• The join may use an operator that isn’t supported in Design view,
such as > or <.

2331 You must enter Group By in the Total row for at least one of the Row
Heading options you enter in the Crosstab row.

2332 Microsoft Access can’t match the fields you added using the asterisk
(•) in the append query. Because the asterisk represents all the fields in
the underlying table or query, you can’t append an asterisk to one field
or expression, and you can’t append a single field or expression to an
asterisk. Append an asterisk to an asterisk (for example, a table to a
table), or append specific fields.

2333 You must enter the name of the table you are creating or appending
records to. You tried to define a make-table or append query without
specifying a destination table.

2334 Microsoft Access can’t print ‘|’ because it is an action query. Because
action queries don’t produce a recordset, you can’t print a Datasheet
view of them.

Note that an exclamation point (!) joined to a query icon in the
Database window marks an action query. To print a Datasheet view of
the records that will be selected by the query, display the query in
Design view, click the Datasheet button, and then click the Print 
button.
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2335 You must use the same number of fields when you set the
LinkChildFields and LinkMasterFields properties. You entered a differ-
ent number of fields for one property than you did for the other. If you
use the Relationships command (Tools menu) to define a relationship
between the tables underlying the form and subform, Microsoft Access
will link the form and subform automatically and then set the
LinkChildFields and LinkMasterFields properties.

2337 You can’t specify criteria on the same field for which you entered
Value in the Crosstab row. You tried to display a crosstab query after
entering Value in the Crosstab row and criteria in the Criteria row. If
you want this field to supply the cross-tabulated values in the crosstab
query, delete the entry in the Criteria row. If you want this to be a crite-
ria field, leave the Crosstab row blank.

2338 Microsoft Access truncated the expression you entered. The expression
‘|’ exceeds the 1,024-character limit for the query design grid.

2339 Microsoft Access can’t create a temporary link. You reached the limit
for the number of links in your database. Microsoft Access needs to
create a temporary link in order to import your ODBC table. Remove
all unneeded links or tables.

2340 The expression you entered exceeds the 1,024-character limit for the
query design grid.

2342 A RunSQL action requires an argument consisting of an SQL state-
ment. For example, an action query that appends records starts with
INSERT INTO. A data-definition query that creates a table starts with
CREATE TABLE.

2343 The value you entered exceeds the Alias property’s 64-character limit.

2344 For the TopValues property in the query property sheet, you must enter
an integer greater than zero.

2345 For the TopValues property in the query property sheet, you must enter
a percentage from 1 through 100.

2346 For the TopValues property in the query property sheet, you must enter
a number greater than zero.

2347 Microsoft Access can’t find the file name you entered for the
DestinationDB property in an action query’s property sheet. You may
have misspelled the database file name, or the file may have been
deleted or renamed.

2348 You can’t leave the Alias property blank.
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2349 For the TopValues property in the query property sheet, you must enter
a number smaller than 2,147,483,647.

2350 Microsoft Access can’t save the query.

• The query is a pass-through query and can’t be represented as a sim-
ple SQL string. Save the query as a named query from the Query
Builder. When you close the Query Builder, Microsoft Access will fill
the RecordSource or RowSource property with the saved query name.

• Make sure the query doesn’t have an SQL syntax error.

2351 Microsoft Access can’t represent an implicit VALUES clause in the
query design grid. Edit this in SQL view.

2352 You can’t modify this query because it has been deleted or renamed by
another user.

2353 Bad query parameter ‘|’.

2360 A field name is missing. You have defined a data type or a description
for a field without specifying the field name. Enter a name for the field,
or delete the row.

2361 Microsoft Access can’t save this table. There are no fields in this table.
Define at least one field by entering a field name and selecting a data
type.

2362 You already have a field named ‘|.’

2363 Microsoft Access allows only one AutoNumber field per table. Use the
Number data type for similar fields.

2364 Microsoft Access can’t open the table in Datasheet view.

2366 Microsoft Access was unable to save the field ordering. All other
changes were saved successfully. Close this database and choose the
Repair Database command on the Tools menu (Database Utilities sub-
menu).

2370 Removing or changing the index for this field would require removal
of the primary key. If you want to delete the primary key, select that
field and click the Primary Key button.

2371 Microsoft Access can’t create a primary key. Your changes weren’t
saved.

2372 The field name is not valid. Make sure that the name doesn’t contain a
period (.), exclamation point (!), bracket ([]), leading space, or non-
printable character such as a carriage return. If you have pasted the
name from another application, try pressing ESC and typing the name
again.
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2373 The setting for the FieldSize property must be from 0 through 255.

2374 You can’t create an index or primary key on more than 10 fields.

2375 You can’t paste beyond the end of a table. You have attempted to paste
fields beyond the 255th row in a table in Design view.

2376 Microsoft Access can’t create a primary key. You have selected too
many fields for a multiple-field primary key.

2377 Once you enter data in a table, you can’t change the data type of any
field to AutoNumber, even if you haven’t yet added data to that field.
Add a new field to the table, and define its data type as AutoNumber.
Microsoft Access then enters data in the AutoNumber field automati-
cally, numbering the records consecutively starting with 1.

2378 This table is read-only. Use a different name in the Save As dialog box
to save your changes.

2379 You can’t create a primary key on a field of this data type. You can’t
define a primary key on fields with an OLE Object data type.

2380 Microsoft Access can’t create a primary key because no fields have
been selected. You have selected a row with no fields defined. Place the
insertion point somewhere in the row of the field you want to define as
the primary key.

2381 Microsoft Access can’t create a primary key because the field doesn’t
have a name. Name the field, and then define it as a primary key field.

2382 You can’t switch to Datasheet view and you can’t return to Design
view. Another user has opened this table or a query, form, or report that
is bound to this table.

2383 Microsoft Access can’t change the data type. There isn’t enough disk
space or memory.

2384 You can’t change one field from an AutoNumber data type and add
another AutoNumber field at the same time. Do the following:

1. Delete the AutoNumber field you added, and click Save on the File
menu.

2. Add the new AutoNumber field, and save the table again.

2385 Errors were encountered during the save operation. |

2386 Microsoft Access was unable to create the table.

2387 You can’t delete the table ‘|’; it is participating in one or more relation-
ships. If you want to delete this table, first delete its relationships in the
Relationships window.
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2388 You can’t change the primary key. This table is the primary table in
one or more relationships. If you want to change or remove the primary
key, first delete the relationship in the Relationships window.

2389 You can’t delete the field ‘|.’ It is part of one or more relationships. If
you want to delete this field, first delete its relationships in the
Relationships window.

2390 You can’t change the data type or field size of this field; it is part of
one or more relationships. If you want to change the data type of this
field, first delete its relationships in the Relationships window.

2391 Field ‘|1’ doesn’t exist in destination table ‘|2.’ Microsoft Access was
unable to complete the append operation. The destination table must
contain the same fields as the table you are pasting from.

2392 You can’t set the Unique property of a primary key to No. A primary
key, by definition, contains only unique values. If you want to allow
nonunique values in this field, remove the primary key definition by
setting the Primary property to No.

2393 You can’t set the IgnoreNulls property of a primary key to Yes. A pri-
mary key, by definition, can’t allow null values. If you want null values
in this field, remove the primary key definition by setting the Primary
property to No.

2394 The index name is invalid. The index name may be too long (over 64
characters) or contain invalid characters.

2395 Indexes must have names.

2396 Microsoft Access can’t create an index or primary key. One or more
field names are missing. Enter or select at least one field in the Field
Name column for each index you name.

2397 You already have an index named ‘|.’

2398 The primary key has been changed. This table is the primary table in
one or more relationships. Changes to the primary key won’t be saved.

2399 The setting for the FieldSize property must be from 1 through 8000.

2400 The row you inserted in the grid exceeds the limit of 255 rows (fields)
for a table or 1,000 rows (actions) for a macro.

2420 The expression you entered has an invalid number.

2421 The expression you entered has an invalid date value.

2422 The expression you entered has an invalid string. A string can be up to
2048 characters long, including opening and closing quotation marks.
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2423 The expression you entered has an invalid . (dot) or ! operator or
invalid parentheses. You may have entered an invalid identifier or typed
parentheses following the Null constant.

2424 The expression you entered has a field, control, or property name that
Microsoft Access can’t find.

2425 The expression you entered has a function name that Microsoft Access
can’t find.

2426 The function you entered can’t be used in this expression.

• You may have used a DoEvents, LBound, UBound, Spc, or Tab func-
tion in an expression.

• You may have used an aggregate function, such as Count, in a design
grid or in a calculated control or field.

2427 You entered an expression that has no value. The expression may refer
to an object that has no value, such as a form, a report, or a label con-
trol.

2428 You entered an invalid argument in a domain aggregate function.

• A field in the string expression may not be in the domain.

• A field specified in the criteria expression may not be in the domain.

2429 The In operator you entered requires parentheses.

2430 You did not enter the keyword And in the Between…And operator. The
correct syntax is as follows:

expression [Not] Between value1 And value2

2431 The expression you entered contains invalid syntax. You may have
entered a comma without a preceding value or identifier.

2432 The expression you entered contains invalid syntax, or you need to
enclose your text data in quotes. You may have entered an invalid
comma or omitted quotation marks. For example, if the Default Value
property of a text field is “Huey, Louie, and Dewey,” it must be
enclosed in quotes if you mean it as a literal text string. This avoids the
confusion with the expression “Huey Louie” And “Dewey”.

2433 The expression you entered contains invalid syntax. You may have
entered an operator, such as the + operator, in an expression without a
corresponding operand.

2434 The expression you entered contains invalid syntax. You may have
entered an operand without an operator.

2435 The expression you entered has too many closing parentheses.
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2436 The expression you entered is missing a closing parenthesis, bracket
(]), or vertical bar (|).

2437 The expression you entered has invalid vertical bars (|).

2438 The expression you entered contains invalid syntax. You omitted an
operand or operator, you entered an invalid character or comma, or you
entered text without surrounding it in quotation marks.

2439 The expression you entered has a function containing the wrong num-
ber of arguments.

2440 You must enclose IIf function arguments in parentheses.

2442 The expression you entered has invalid parentheses. You may have used
the parenthesis syntax for an identifier in a query. Use the standard
identifier syntax:

Forms![Form]![Control].

2443 You can use the Is operator only in an expression with Null or Not
Null.

2445 The expression you entered is too complex.

2446 There isn’t enough memory available to perform this calculation. Close
unneeded programs, and try again. For more information on freeing
memory, search the Microsoft Windows Help index for ‘memory, trou-
bleshooting’.

2447 There is an invalid use of the . (dot) or ! operator or invalid parenthe-
ses. You may have entered an invalid identifier or typed parentheses
following the Null constant.

2448 You can’t assign a value to this object.

• The object may be a control on a read-only form.

• The object may be on a form that is open in Design view.

• The value may be too large for this field.

2449 There is an invalid method in an expression. For example, you may
have tried to use the Print method with an object other than Report or
Debug.

2450 Microsoft Access can’t find the form ‘|’ referred to in a macro expres-
sion or Visual Basic code.

• The form you referenced may be closed or may not exist in this data-
base.

• Microsoft Access may have encountered a compile error in a Visual
Basic module for the form.
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2451 The report name ‘|’ you entered is misspelled or refers to a report that
isn’t open or doesn’t exist.

2452 The expression you entered has an invalid reference to the Parent prop-
erty. For example, you may be using the Parent property with a control
on a main form or report rather than with a control on a subform or
subreport.

2453 The control name ‘|’ you entered in your expression is misspelled or
refers to a control on a form or report that isn’t open or doesn’t exist.

2454 The object name ‘|’ you entered following the ! operator in the expres-
sion is invalid. For example, you may have tried to enter an identifier
with two control names separated by the ! operator.

2455 You entered an expression that has an invalid reference to the property
|. The property may not exist or may not apply to the object you speci-
fied.

2456 The number you used to refer to the form is invalid. Use the Count
property to count the open forms and make sure that the form number
is not greater than the number of open forms minus one.

2457 The number you used to refer to the report is invalid. Use the Count
property to count the open reports and make sure that the report num-
ber is not greater than the number of open reports.

2458 The control number you specified is greater than the number of con-
trols. Use the Count property to count the controls on the form or
report and then check that the control number you cite is within the
range of existing controls.

2459 You can’t refer to the Parent property of a form or report when either is
open in Design view.

2460 You can’t refer to the RecordsetClone property of a form open in
Design view.

2461 Use a section number, not a string, to refer to a form or report section.

2462 The section number you entered is invalid.

2463 Use a number, not a string, to refer to a group level.

2464 There is no sorting or grouping field or expression defined for the
group level number you used. A valid group level number can be from
0 (for the first field or expression you sort or group on) through 9 (for
the tenth). Count the group levels in the report starting with zero.

2465 Microsoft Access can’t find the field ‘|’ referred to in your expression.
You may have misspelled the field name, or the field may have been
renamed or deleted.
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2466 The expression you entered has an invalid reference to the Dynaset
property. For example, you may have used the Dynaset property with a
form that isn’t based on a table or query.

2467 The expression you entered refers to an object that is closed or doesn’t
exist. For example, you may have assigned a form to a Form object
variable, closed the form, and then referred to the object variable.

2468 The value you entered for the interval, number, or date argument in the
function is invalid. Check the argument to make sure that you entered it
correctly. For more information on valid argument values, search the
Help index for ‘DatePart function,’ ‘DateAdd function,’ or ‘DateDiff
function’.

2469 The expression |2 you entered in the form control’s ValidationRule
property contains the error |1. Microsoft Access can’t parse the
ValidationRule expression you entered. For example, if you enter the
expression =MyFunction() in the ValidationRule property, and the
function MyFunction doesn’t exist, Microsoft Access displays the
following message:

Unknown function name in validation rule: ‘MyFunction’.

To help you create expressions as arguments in Visual Basic, use the
Expression Builder. For more information, search the Help index for
‘Expression Builder’.

2470 There is a(n) ‘|’ in the form control’s ValidationRule property. To help
you create expressions as arguments in Visual Basic, use the
Expression Builder. For more information, search the Help index for
‘Expression Builder’.

2471 The expression you entered as a query parameter produced this error: ‘|’

2472 The LinkMasterFields property setting has produced this error: ‘|’

2473 The expression |2 you entered as the event property setting produced
the following error: |1.

• The expression may not result in the name of a macro, the name of a
user-defined function, or [Event Procedure].

• There may have been an error evaluating the function, event, or
macro.

2474 The expression you entered requires the control to be in the active
window. Try one of the following:

• Open or select a form or report containing the control.

• Create a new control in the active window, and try the operation
again.
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2475 You entered an expression that requires a form to be the active window.

2476 You entered an expression that requires a report to be the active
window.

2477 You entered an invalid objecttype value ‘|’ in an If TypeOf object Is
objecttype condition of an If…Then…Else statement. The objecttype
can be any one of the following: BoundObjectFrame, CheckBox,
ComboBox, CommandButton, Label, Line, ListBox,
UnboundObjectFrame, OptionButton, OptionGroup, PageBreak,
Rectangle, Subform, Subreport, TextBox, ToggleButton, ImageControl,
or OLEControl.

2478 Microsoft Access doesn’t allow you to use this method in the current
view. Most methods, including the SetFocus and Requery methods,
can’t be used in form or report Design view.

2479 The event procedure ‘|’ can’t be a Function procedure; it must be a Sub
procedure. If you want to run a Function procedure when an event
occurs, try one of the following:

• Set the event property to the name of a macro containing a RunCode
action that runs the Function procedure.

• Set the event property to =FunctionName().

2480 You referred to a property by a numeric argument that isn’t one of the
property numbers in the collection. Check the property numbers in the
collection.

2481 You can’t set a value while a document is in Print Preview.

2482 Microsoft Access can’t find the name ‘|’ you entered in the expression.
You may have specified a control that wasn’t on the current object
without specifying the correct form or report context. To refer to a con-
trol on another form or report, precede the control name with the name
of a collection, usually either Forms or Reports, and the name of the
form or report to which the control belongs. For example,
Forms![Products]![Units In Stock].

2483 You can’t move to a previous control when only one control has had
the focus. Use the PreviousControl property only after you’ve moved
the focus to a second control.

2484 There is no active datasheet.

2485 Microsoft Access can’t find the macro ‘|.’ The macro (or its macro group)
doesn’t exist, or the macro is new but hasn’t been saved. Note that when
you enter the macrogroupname.macroname syntax in an argument, you
must specify the name the macro’s macro group was last saved under.
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2486 You can’t carry out this action at the present time. You tried to run a
macro or used the DoCmd object in Visual Basic to carry out an action.
However, Microsoft Access is performing another activity that prevents
this action from being carried out now. For example, no actions on a
form can be carried out while Microsoft Access is repainting a control
or calculating an expression. Carry out the action later.

2487 The Object Type argument for the action or method is blank or invalid.

• For a Close, GoToRecord, or RepaintObject action, enter values for
both arguments, or leave both blank to perform the action on the
active object.

• For a DeleteObject, Rename, or CopyObject action, enter values for
both arguments, or leave both blank to perform the action on the
object currently selected in the Database window.

• For a SendObject or OutputTo action, enter values for both argu-
ments, or leave the Object Name argument blank if you want the
action performed on the active object of the specified object type.

• If you’re using a method with the DoCmd object, use an intrinsic
constant that equates to a valid object type or the corresponding
numeric value for the argument name.

2488 You can’t use the ApplyFilter action on this window.

• You tried to use the ApplyFilter action or method, but you didn’t
apply the filter to a table, query, form, or report.

• You may have applied the filter to a form, but the form wasn’t open
in Form or Datasheet view.

• You may have applied the filter to a report but didn’t use the
ApplyFilter action in a macro specified by the OnOpen property set-
ting. Use the SelectObject action or method to select the table, query,
form, or report before applying the filter.

2489 The object ‘|’ isn’t open.

• The macro you are running (directly or indirectly) contains a
GoToRecord, RepaintObject, or SelectObject action, but the Object
Name argument names an object that is closed.

• The objectname argument for the GoToRecord, RepaintObject, or
SelectObject method names an object that is closed. Use one of the
Open actions or methods to open the object so that you can carry out
the desired action.
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2491 The action or method is invalid because the form or report isn’t bound
to a table or query. You tried to use the ApplyFilter action or method.
However, the form or report you applied the filter to is not based on a
table or query, so the form or report doesn’t have any records to apply
a filter to. Use the SelectObject action or method to select the desired
form or report before you run the ApplyFilter action. To base a form or
report on a table or query, open the form or report in Design view, and
enter the table or query name in the RecordSource property.

2492 Microsoft Access can’t find the macro ‘|2’ in the macro group ‘|1.’You
used the macrogroupname.macroname syntax to specify a macro. You
then tried to run the macro (directly or indirectly), or you used the
RunMacro method to run the macro. However, the macro you specified
isn’t in this macro group. Create the macro in the macro group, specify
the correct macro group, or specify the correct macro name.

2493 This action requires an Object Name argument.

2494 The action or method requires a Form Name argument. You tried to use
the OpenForm action or method, but you left the Form Name argument
blank. In the Form Name argument, enter the name of a form in the
current database.

2495 The action or method requires a Table Name argument. You tried to use
the OpenTable, TransferSpreadsheet, or TransferText action or method,
but you left the Table Name argument blank. In the Table Name argu-
ment, enter the name of a table that is in the current database.

2496 The action or method requires a Query Name argument. You tried to
use the OpenQuery action or method, but you left the Query Name
argument blank. In the Query Name argument, enter a query name.

2497 The action or method requires a Report Name argument. You tried to
use the OpenReport action or method, but you left the Report Name
argument blank. In the Report Name argument, enter the name of a
report.

2498 An expression you entered is the wrong data type for one of the argu-
ments. You tried to run a macro or use a method to carry out an action,
but an expression evaluated to the wrong data type. For example, for
the Close method you specified a string for the Object Type argument,
but this argument can be set only to certain intrinsic constants or their
numeric equivalents.
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2499 You can’t use the GoToRecord action or method on an object in Design
view. Try one of the following:

• Switch to Form or Datasheet view for a form.

• Switch to Datasheet view for a query or table.

• If you are running a macro or Visual Basic procedure containing an
action that opens the object, set the View argument to the correct
view before you carry out the GoToRecord action.

2500 You must enter a number greater than zero for a Repeat Count argu-
ment. You tried to use the RunMacro action or method, but you entered
a value less than zero (or an expression that evaluates to less than zero)
in the Repeat Count argument. To run the macro once, leave this argu-
ment blank.

2501 The | action was canceled. You used a method of the DoCmd object to
carry out an action in Visual Basic, but then clicked Cancel in a dialog
box. For example, you used the Close method to close a changed form,
then clicked Cancel in the dialog box that asks if you want to save the
changes you made to the form.

2502 The action or method requires a Macro Name argument.

• You tried to use the RunMacro action or method, but you left the
Macro Name argument blank.

• Microsoft Access tried to create a custom menu bar for a form or
report, but the Menu Macro Name argument of the AddMenu action
is blank. In the Menu Macro Name argument, enter the name of a
macro or macro group that is in the current database.

2503 You can’t use this action with the DoCmd object. For a list of the
actions that the DoCmd object doesn’t support and some alternatives to
using these actions, click Help. Any actions that aren’t in this list can
be used with the DoCmd object.

2504 The action or method requires at least | argument(s). You tried to run 
a macro containing an action or used a method or action with the
DoCmd object, but you didn’t set the required number of arguments.
For example, if you use the MoveSize action, you must set at least one
of the four arguments.

2505 An expression in argument | has an invalid value. You tried to run a
macro or used the DoCmd object in Visual Basic. The argument num-
ber above is the position of the argument as it appears in the Macro
window, the Action Failed dialog box, or the Object Browser (if you’re
using the DoCmd object). Try one of the following:
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• Select a setting from the drop-down list box in each argument.

• Use an intrinsic constant equating to a valid object type.

• Substitute the correct corresponding expression.

2506 A value you entered for the Transfer Type argument is invalid. An
expression in the Transfer Type argument doesn’t evaluate to a valid
numeric value. Valid values for the Transfer Type argument are as 
follows:

• 0, 1, and 2 for the TransferDatabase action.

• 0, 1, and 2 for the TransferSpreadsheet action.

• 0 through 6 for the TransferText action.

2507 The | type isn’t an installed database type or doesn’t support the opera-
tion you chose. You used the TransferDatabase method, but an expres-
sion in the databasetype argument doesn’t evaluate to a valid database
type for importing, exporting, or linking. For information on valid
database types, click Help.

2508 A value you entered for the spreadsheettype argument is invalid. You
used the TransferSpreadsheet method, and an expression in the spread-
sheettype argument doesn’t evaluate to a valid numeric value. Valid
values are 0, 2, 3, 4, 5, 6, 7, and 8. Note that 1 is an invalid value; you
can’t import or export to a Lotus .wks format file.

2509 The setting for the Range argument can’t be longer than 255 
characters.

2510 The expression you entered in the Specification Name argument
exceeds the 64-character limit. Select one of the existing specification
names from the argument list box when you use the TransferText
action in a macro, or enter a name in Visual Basic that follows
Microsoft Access object-naming rules.

2511 The action or method requires a Specification Name argument. You
tried to use the TransferText action or method and you specified a
Transfer Type argument but left the Specification Name argument
blank. In the Specification Name argument, enter an existing specifica-
tion name from the argument list box.

2512 Microsoft Access can’t parse the expression: ‘|’. Click OK to return to
the action argument or conditional expression where this expression
appears, and then correct the syntax.

2513 The Macro Name argument can’t be longer than 64 characters accord-
ing to Microsoft Access object-naming rules.
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2514 The action or method requires a Control Name argument. You tried to
use the GoToControl action or method, but you left the control name
blank. In the Control Name argument, enter a control or field name
from the active form or datasheet.

2515 Microsoft Access can’t open the macro ‘|’ because it was saved using a
different version of Microsoft Access. Re-create the macro in the cur-
rent version of Microsoft Access.

2516 Microsoft Access can’t find the module ‘|.’You tried to use the
OpenModule action or method, but Microsoft Access can’t find the
module you specified in the Module Name argument. Enter a valid
module name from the current database.

2517 Microsoft Access can’t find the procedure ‘|.’

• You may have used the Run method in Visual Basic but entered an
invalid procedure name, or you used the Run method without first
opening a database.

• You tried to use the OpenModule action or method, but you used an
invalid procedure name.

2519 The database must be open for the SelectObject method to run. You
tried to run a function in a library database, and the function contains
the SelectObject method.

2520 The action or method requires a Module or Procedure Name argument.
You tried to use the OpenModule action or method, but you didn’t
enter a name in either the Module Name or the Procedure Name
argument in the Macro window. Enter a valid name in one of these
arguments.

2521 You have specified a Transfer Type that doesn’t support the HTML
Table Name argument. Leave the HTML Table Name argument blank
unless you are using the Import HTML or Link HTML Transfer Types.

2522 The action or method requires a File Name argument. You tried to use
the TransferSpreadsheet or TransferText action or method. In the File
Name argument, enter a file name.

2523 The value you entered for the show argument is invalid. You used the
ShowToolbar method. Valid values for this argument are acToolbarYes,
acToolbarWhereApprop, and acToolbarNo, or the corresponding
numeric values 0, 1, and 2.

2524 Microsoft Access can’t invoke the application using the RunApp
action. The path to the application is invalid, or a component of the
application is missing. Check the path in Windows Explorer or File
Manager.
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2525 A macro can call itself a maximum of 20 times. Your macro contains a
RunMacro action that calls the same macro more than 20 times. Use a
condition to stop the macro after it has been run 20 times, or call
another macro with the RunMacro action.

2526 The SendKeys action requires the Microsoft Access Utility Add-in to
be loaded. Rerun Microsoft Access or Microsoft Office Setup to rein-
stall Microsoft Access and the Microsoft Access Utility Add-in.

2527 Lotus .wks file formats aren’t supported in the current version of
Microsoft Access. Convert your .wks file to a more recent format, such
as .wk1.

2528 The RunCommand macro action argument is missing, or you entered
an invalid command ID for the RunCommand method.

2529 The Toolbar argument can’t be longer than 64 characters.

2530 The SelectObject method can’t be used on a report that is currently
printing.

2531 Your HTML file does not contain any tabular data that Microsoft
Access can import.

2532 Microsoft Access can’t find the macro or sub procedure ‘|.’ The speci-
fied macro, macro group, or sub procedure doesn’t exist. Note that
when you enter the macrogroupname.macroname syntax in an argu-
ment, you must specify the name the macro’s macro group was last
saved under. Also, ensure that the referenced macro has been saved, or
that the referenced sub procedure expects 0 arguments.

2533 The ApplyFilter action requires that either the Filter Name or Where
Condition argument is set. You tried to run a macro containing an
ApplyFilter action, but you didn’t set the required arguments.

2534 The action or method requires a data access page Name argument. You
tried to use the OpenDataAccessPage action or method, but you left the
data access page Name argument blank. In the data access page Name
argument, enter the name of a data access page in the current database.

2535 The ApplyFilter action contains a Filter Name that cannot be applied.
The filter name is not a valid argument in the ApplyFilter action in
Client Server.

2536 Macros are disabled in this database.

2540 The file ‘|’ you tried to replace is a Microsoft Access system file that is
in use and can’t be replaced or deleted.

Access 2002 and Jet 4 Errors

APPENDIX E

E

A
C

C
ESS

2002
A

N
D

JET
4

E
R

R
O

R
S

43



ErrorCode ErrorString

2541 The contents of the Clipboard have been deleted and can’t be pasted.
Some applications do not put large objects on the Clipboard. Instead,
they put a pointer to the object on the Clipboard. The pointer may van-
ish before the paste happens.

2542 Specify the database name in the command line so that Microsoft
Access can find the macro.

2543 You can’t paste a database object onto itself.

2544 Microsoft Access can’t find the | you referenced in the Object Name
argument. The macro you tried to run includes a SelectObject action
with an invalid name for the Object Name argument. In the Database
window, verify the name of the object you want the macro to select.
Then open the macro in the Macro window and enter the correct name
for the Object Name argument.

2545 The CopyObject action requires you to specify a different destination
database or a new name to copy from the current database. The macro
you are running includes a CopyObject action. Open the macro in the
Macro window, and select the CopyObject action. Enter a destination
database or a new name in the appropriate argument box.

2546 Select a database object in the Database window before you run the
macro containing the | action.

2547 The database ‘|’ you tried to delete and replace is read-only and can’t
be deleted or replaced. Enter a different name for the new database.

2548 Microsoft Access can’t run the Security Wizard because this database
is open in exclusive mode. Do you want Microsoft Access to open the
database in shared mode and run the Security Wizard?

2549 Microsoft Access can’t delete |1 after compacting it. The compacted
database has been named |2. If you compact a database using the same
name, Microsoft Access creates a new compacted database and then
deletes the original database. In this case, however, the original data-
base wasn’t deleted because it is read-only. If you can, remove the
read-only status, delete the original database, and then rename the new
database using the original name. If you can’t remove the read-only
status, inform your workgroup administrator.

2550 Microsoft Access can’t delete |1 after encrypting it. The encrypted
database has been named |2. If you encrypt a database using the same
name, Microsoft Access creates a new encrypted database, and then
deletes the original database. In this case, however, the original data-
base can’t be deleted because it is read-only. If you can, remove the 
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read-only status, delete the original database, and then rename the new
database using the original name. If you can’t remove the read-only
status, inform your workgroup administrator.

2551 Microsoft Access can’t delete |1 after decrypting it. The decrypted
database has been named |2. If you decrypt a database using the same
name, Microsoft Access creates a new decrypted database, and then
deletes the original database. In this case, however, the original data-
base can’t be deleted because it is read-only. If you can, remove the
read-only status, delete the original database, and then rename the new
database using the original name. If you can’t remove the read-only
status, inform your workgroup administrator.

2552 You can’t encrypt a database that you didn’t create or don’t own. See
the owner of the database or your workgroup administrator.

2553 You can’t decrypt a database that you didn’t create or don’t own. See
the owner of the database or your workgroup administrator.

2554 Can’t find the database you specified, or you didn’t specify a database
at all. Specify a valid database name in the command line, and include
a path if necessary.

2556 Microsoft Access can’t run the Security Wizard because the database
has had a password set on it. You will have to unset the database pass-
word by choosing Tools|Security|Unset Database Password.

2557 The database you tried to convert was either created in or was already
converted to the requested version of Microsoft Access.

2559 Microsoft Access was unable to refresh the linked table ‘|1’ in database
‘|2’ during conversion. Try and refresh the links manually by using the
Linked Table Manager (Tools menu, Database Utilities submenu).

2560 Microsoft Access is unable to load the Database Properties.

2561 Microsoft Access can’t display the Database Properties dialog box.

2562 Microsoft Access is unable to save the Database Properties.

2563 Microsoft Access can’t load a dynamic-link library. Run Setup to rein-
stall Microsoft Access. If you want to preserve your security or custom
settings, back up the Microsoft Access workgroup information file. For
information on backing up files, search the Microsoft Windows Help
index for ‘backing up files’.

2564 You can’t hide the document ‘|’ while it is open. Close the database
object first, and then hide it.

2565 You can’t unhide the database object ‘|’ while it is open. Close the
database object first, and then unhide it.
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2566 Microsoft Access is unable to set the application’s icon to the file ‘|’.
Make sure the file is a valid icon (.ico) file. If you’re using Microsoft
Windows, you can also use .bmp files.

2567 Microsoft Access can’t open or convert this previous version database.
The database was created in an earlier version of Microsoft Access.
You don’t have appropriate security permissions to open or convert
databases created in earlier versions.

2568 Microsoft Access can’t undo this operation. An object with the same
name already exists. Another user might have created an object named
‘|’ after you had performed this operation on an object with the same
name.

2569 Microsoft Access can’t delete |1 after enabling it. The enabled database
has been named |2. If you enable a database using the same name,
Microsoft Access creates a new enabled database and then deletes the
original database. In this case, however, the original database wasn’t
deleted because it is read-only. If you can, remove the read-only status,
delete the original database, and then rename the new database using
the original name. If you can’t remove the read-only status, inform
your workgroup administrator.

2571 You can’t modify objects created using an earlier version of Microsoft
Access. To convert this database to the current version of Microsoft
Access, close the database, point to Database Utilities on the Tools
menu, and then click Convert Database.

2572 This database is in an unexpected state; Microsoft Access can’t open it.
This database has been converted from a prior version of Microsoft
Access by using the DAO CompactDatabase method instead of the
Convert Database command on the Tools menu (Database Utilities sub-
menu). This has left the database in a partially converted state. If you
have a copy of the database in its original format, use the Convert
Database command on the Tools menu (Database Utilities submenu) to
convert it. If the original database is no longer available, create a new
database and import your tables and queries to preserve your data. Your
other database objects can’t be recovered.

2573 This database is a replica created in a different version of Access. You
can only convert this replica by synchronizing with its Design Master.
Convert the Design Master of this replica set then synchronize the
replica with the Design Master.
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2574 You can’t create another Microsoft Access database with the same
name and location as an existing database. You carried out the Make
MDE File command, but tried to give the new database the same
extension as the old one. Accept the default .mde extension for your
new MDE database.

2575 You can’t create a Microsoft Access MDE database from a database
replica.

2576 This database is a Microsoft Access 7.0/8.0/9.0 Design Master/Replica.
If you click OK, the database you selected will be renamed to |1 and
then converted to |2. Everyone using a replica of this database will
have to upgrade to Microsoft Access 2000 after the next synchroniza-
tion.

2577 The database | is already open. Close the database before carrying out
the Make MDE File command.

2578 Microsoft Access was unable to create an MDE database.

2579 Local forms, reports, macros, and modules in this replica will not be
converted. To retain these objects, please be sure to import them into
the Design Master from the original replica.

2580 The record source ‘|’ specified on this form or report does not exist.
You misspelled the name, or it was deleted or renamed in the current
database, or it exists in a different database. In the Form or Report’s
Design view, display the property sheet by clicking the Properties but-
ton, and then set the RecordSource property to an existing table or
query.

2581 You must define a sort field or expression for the group header or
footer in the report you tried to preview or print.

2582 You can’t set the GroupInterval property to zero when the GroupOn
property is set to Interval. Click Sorting and Grouping on the View
menu and try one of the following:

• Change the GroupInterval property setting to a number higher than
zero.

• Change the GroupOn property setting to Each Value.

2583 The ApplyFilter action or method can be carried out only from an
Open macro or Open event procedure.

• You may have tried to run a macro or procedure containing the
ApplyFilter action or method from a report property other than the
OnOpen property.
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• You may have tried to run a macro or event procedure on a report that
is already open. To use the ApplyFilter action in a report, set the
OnOpen property to the name of the macro, close the report, and then
reopen it.

2584 You can’t use aggregate functions in a page header or footer. The page
header or footer of the report you tried to preview contains a calculated
control with an aggregate function in its expression. If you want to
show the result of an aggregate function in a page header or footer, cre-
ate a hidden calculated control in an appropriate section of the report.
Then create an unbound text box in the page header or footer. If you
are running a macro, use the SetValue action to set the unbound text
box value to the value in the hidden control.

2585 This action can’t be carried out while processing a form or report
event. A macro specified as the OnOpen, OnClose, OnFormat,
OnRetreat, OnPage, or OnPrint property setting contains an invalid
action for the property. When you click OK, an Action Failed dialog
box will display the name of the macro that failed and its arguments.

2586 Microsoft Access changed the MoveLayout and NextRecord properties
to True from False. The macro or Visual Basic function run by the
OnFormat property of one of the sections of the report set both the
MoveLayout and NextRecord properties to False. Having both proper-
ties set to False can make the report print continuously. Revise the
macro or function so that it sets these properties to the values you
want.

2587 Microsoft Access can’t complete the Output operation. The Visual
Basic code you entered contains a syntax error or the Output proce-
dures are not available. Make sure there isn’t a syntax error in your
code. If the syntax is correct, run Setup to reinstall Microsoft Access. If
you want to preserve your security or custom settings, back up the
Microsoft Access workgroup information file. For information on back-
ing up files, search the Microsoft Windows Help index for ‘backing up
files’.

2588 You must select a form to save as a report.

2589 The expression ‘|’ is invalid. Aggregate functions are only allowed on
output fields of the Record Source.

2590 The Var and VarP aggregate functions are not supported in an Access
project.

2591 You can’t change printer properties in the OnOpen event of a report.

2592 You cannot bind a hierarchical report to a DAO Recordset.
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2593 This feature is not available in an MDB.

2594 You cannot Filter By Form when form record source is a recordset
object.

2595 Microsoft Access cannot set this property when DefaultSize property is
set to True.

2596 Printer object is not available on subforms and subreports.

2597 Unable to bind the report to the specified recordset because the shape
does not match the sorting and grouping specified on the report.

2598 Recordset property not available for natively bound reports in MDB
files.

2600 Verify the new password by retyping it in the Verify box and clicking
OK.

2601 You don’t have permission to read ‘|.’ To read this object, you must
have Read Design permission for it. For more information on permis-
sions and who can set them, click Help.

2602 You don’t have permission to modify ‘|.’ To modify this object, you
must have Modify Design permission for it. If the object is a table, you
must also have Delete Data and Update Data permissions for it. For
more information on permissions and who can set them, click Help.

2603 You don’t have permission to run ‘|.’ To run this object, you must have
Open/Run permission for it. For more information on permissions and
who can set them, click Help.

2604 You can’t view this object’s permissions. To view or change permis-
sions for this object, you must have Administer permission for it. For
more information on permissions and who can set them, click Help.

2605 You can’t remove this user account from group ‘|.’

• You may have tried to remove a user account from the default Users
group. Microsoft Access automatically adds all users to the default
Users group. To remove a user account from the Users group, you
must first delete the account.

• You may have tried to remove all users from the Admins group.
There must be at least one user in the Admins group.

2606 The object type is invalid.

2607 You don’t have permission to cut ‘|.’ To cut this object, you must have
Modify Design permission for it. If the object is a table, you must also
have Delete Data permission for it. For more information on permis-
sions and who can set them, click Help.
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2608 You don’t have permission to copy ‘|.’ To copy this object, you must
have Read Design permission for it. If the object is a table, you must
also have Read Data permission for it. For more information on per-
missions and who can set them, click Help.

2609 You don’t have permission to delete ‘|.’ To delete this object, you must
have Modify Design permission for it. If the object is a table, you must
also have Delete Data permission for it. For more information on per-
missions and who can set them, click Help.

2610 You must enter a personal identifier (PID) consisting of at least 4 and
no more than 20 characters and digits. Microsoft Access uses the com-
bination of the user or group name and the PID to identify the user or
group. Note that Microsoft Access hides the PID after you create it, so
make sure to write down the exact user or group account name and the
PID entries. If you ever have to re-create the account, you must supply
the same name and PID entries.

2611 Microsoft Access can’t find the workgroup file ‘|.’ Would you like to
use the default workgroup file?

2612 The account name is invalid. For information about naming conven-
tions, click Help.

2613 You don’t have permission to rename ‘|.’ To rename a database object,
you must have Modify Design permission for the object. For more
information on permissions and who can set them, click Help.

2614 You don’t have permission to insert this form into another form. To
insert a form into another form as a subform, you must have Read
Design permission for the form being inserted. For more information
on permissions and who can set them, click Help.

2615 You don’t have permission to change the owner of ‘|.’ To change the
owner of a database object, you must have Administer permission for
it. For more information on permissions and who can set them, click
Help.

2616 You can’t change permissions for ‘|.’ To change permissions for this
object, you must have Administer permission for it. For more informa-
tion on permissions and who can set them, click Help.

2617 You don’t have permission to import, export, or link to ‘|.’ To import,
export, or link to this object, you must have Read Design and Read
Data permissions for it. For more information on permissions and who
can set them, click Help.
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2618 You need to have the database open for exclusive use to set or unset
the database password. To open the database exclusively, close the
database, and then reopen it using the Open command on the File
menu. In the Open dialog box, click the arrow to the right of the Open
button, and then choose Open Exclusive.

2619 You can’t change permissions for ‘|’ in a replica. Permissions may only
be changed in the Design Master for the replica set.

2620 The password you entered in the Old Password box is incorrect. Please
enter the correct password for this account.

2621 That password isn’t valid. You may have used a semicolon.

2622 You can’t save ‘|’ because it is read-only. To save, switch to Design
View and choose Save As from the File menu.

2623 Saving the database to the previous version of Access will create a new
database that contains none of the security information that you have
set. Are you sure you want to proceed?

2624 An error has occurred while changing workgroup database.

2625 Workgroup Administrator couldn’t create the workgroup information
file. Make sure that you have specified a valid path and file name, that
you have adequate permissions to create the file, and that you have
enough disk space on the destination drive. (|)

2626 Reserved error (|); there is no message for this error.

2627 There’s not enough disk space.

2628 One of your parameters is invalid.

2629 Could not open workgroup file. This is a directory.

2630 The specified path is invalid.

2631 The specified path is too long.

2632 Change Workgroup cannot proceed without your Name, PIN, and a
path to the new Workgroup Information File.

2633 Microsoft Access cannot change the password for the logon account ‘|’
because the current connection is using Microsoft Windows NT inte-
grated security.

2634 The new password doesn’t match the verify password value.

2635 Microsoft Access is unable to change the password because the old
password doesn’t match the password of the currently logged in user.

2636 Workgroup file already exists.
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2637 Unable to start SQL Server service. To restart the SQL Server service,
double click on the SQL Server System Manager icon in the system
tray and click Start/Continue. Once the service is started, point to
Connection on the File menu in Access and click OK.

2638 Unable to start SQL Server service. To restart the SQL Server service,
double click on the SQL Server System Manager icon in the system
tray and click Start/Continue. If the service fails to start, go to the
Services console and verify that the MSSQLServer service Log On
information is correct. Once the service is started, point to Connection
on the File menu in Access and click OK.

2646 Microsoft Access can’t create this relationship and enforce referential
integrity. Data in the table ‘|’ violates referential integrity rules. For
example, there may be records relating to an employee in the Related
table, but no record for the employee in the primary table. Edit the data
so that records in the primary table exist for all related records. If you
want to create the relationship without following the rules of referential
integrity, clear the Enforce Referential Integrity check box.

2648 Microsoft Access created a one-to-one relationship instead of a one-to-
many relationship because there is a unique index on the field(s) speci-
fied for the related table. If you want to define a one-to-many
relationship between these tables, try one of the following:

• Delete the one-to-one relationship, and then change the setting of the
Indexed property for the foreign key field from No Duplicates to
Duplicates OK.

• Choose different matching fields.

2649 Microsoft Access can’t enforce referential integrity for this relation-
ship. Make sure the fields you drag are primary key fields or uniquely
indexed and that the unique index or primary key is correctly set. If
you want to create the relationship without following the rules of refer-
ential integrity, clear the Enforce Referential Integrity check box.

2650 Microsoft Access can’t create this relationship and enforce referential
integrity.

• The fields you chose may have different data types.

• The fields may have the Number data type but not the same FieldSize
property setting. Try one of the following:

• Select fields with the same data type.

• Open the tables in Design view, and change the data types and
field sizes so that the fields match.
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If you want to create the relationship without following the rules of
referential integrity, clear the Enforce Referential Integrity check box.

2651 You can’t create a relationship between fields with the Memo, OLE
Object, Yes/No, or Hyperlink data type. You tried to enforce referential
integrity for a relationship, but one or more of the fields you chose
have the Memo, OLE Object, Yes/No, or Hyperlink data type. Select
fields in the grid that don’t have these data types, or open the tables in
Design view and change data types.

2652 You can’t delete a relationship inherited from a linked database.

2680 The form or report includes more OLE objects than Microsoft Access
can display at one time. Delete some of the bound or unbound object
frames.

2683 There is no object in this control.

2684 The OLE object is empty. You can’t edit a bound object frame if the
field in the underlying table doesn’t contain an OLE object. Embed or
link an OLE object into the bound object frame using the Object com-
mand on the Insert menu.

2685 The object doesn’t have an OLE object data type. The bound object
frame containing the object you tried to edit isn’t bound to a field with
the OLE object data type. If you want to display an OLE object, set the
ControlSource property for the bound object frame to a field with the
OLE object data type. Or use a different control, such as a text box, to
display the data.

2686 Microsoft Access is unable to save the | object. Your computer ran out
of disk space while Microsoft Access was saving the OLE object. For
information on freeing disk space, search the Microsoft Windows Help
index for ‘disk space, freeing’.

2687 There was a problem reading the | object.

2690 A system resource necessary for displaying the | object isn’t available.
Your computer may be low on memory. Close unneeded programs, and
try the operation again. For more information on freeing memory, search
the Microsoft Windows Help index for ‘memory, troubleshooting’.

2691 Microsoft Access can’t communicate with the OLE server. The OLE
server may not be registered. To register the OLE server, reinstall it.

2694 The Clipboard isn’t available. The Clipboard may be in use by another
application, or your computer may be low on memory. If your com-
puter is low on memory, close unneeded programs, and then try the
operation again. For more information on freeing memory, search the
Microsoft Windows Help index for ‘memory, troubleshooting’.
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2695 Microsoft Access is unable to display the converted | object. Delete the
object in the bound object frame, and then re-create it.

2696 Microsoft Access can’t read the OLE object. Delete the object in the
bound object frame, and then re-create it.

2697 There was a problem loading the | object. The object you tried to create
or edit is not a valid OLE object. Re-create the object, and then embed
or link it again.

2698 The | object you tried to create or edit is too large to save.

• Your database may not contain enough space for the object.

• Your computer may be out of disk space. For information on freeing
disk space, search the Microsoft Windows Help index for ‘disk space,
freeing’.

2699 The connection with the OLE server was lost, or the OLE server
encountered an error while you were using it. Restart the OLE server,
and then try the operation again.

2700 Microsoft Access can’t find an OLE server or a dynamic-link library
(DLL) required for the OLE operation. The OLE server or DLL may
not be registered. To register the OLE server or DLL, reinstall it.

2701 The OLE server for the OLE object you tried to create is already open.
Switch to the OLE server window and close it. Then try to create or
edit the OLE object again.

2702 The | object isn’t registered. The object may be calling an application
that isn’t installed. To register the application, reinstall it.

2703 Microsoft Access can’t read the | object because communication was
interrupted. If the OLE server application is located on a network
server, make sure your computer is connected to it.

2704 The | object you tried to edit doesn’t have any displayable information.

2707 Microsoft Access can’t open the file containing the OLE object.

• You may have specified an invalid file name or an invalid unit of data
(such as a range of cells from a worksheet) within the file for the
OLE object.

• The file you specified may not be available because it’s locked by
another user or you don’t have permission to use it. Try one of the
following:

• Make sure the file is available and that you used the correct file
name.

• Check the OLE server’s documentation for information about the
syntax to use when specifying an OLE object’s data.
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2711 The file name argument in the GetObject function of the Visual Basic
procedure you ran is invalid.

• You may not have entered, or may have misspelled, the file name.

• The unit of data (such as a range of cells from a worksheet) may not
be valid. Try one of the following:

• Make sure the file is installed on your computer and that you used
the correct file name.

• Check the OLE server’s documentation for information about the
syntax to use when specifying an OLE object’s data.

2713 A problem occurred when Microsoft Access tried to access the | object.

• You may have specified an invalid file name or an invalid unit of data
(such as a range of cells from a worksheet) within the file for the
OLE object.

• The file you specified may not be available because it’s locked by
another user or you don’t have permission to use it. Try one of the
following:

• Make sure that the file is installed on your computer and that you
used the correct file name.

• Check the OLE server’s documentation for information about the
syntax to use when specifying an OLE object’s data.

2714 The | object doesn’t support verbs that can be performed on an OLE
object, such as play or edit. Check the OLE server’s documentation for
information on the verbs the OLE object supports, or use the
ObjectVerbs property or the ObjectVerbsCount property to find the
verbs supported by an OLE object.

2715 The index for the Action or the Verb property for the | object is invalid.
The setting you entered may be a negative number or may be too large.

2717 The | object has no displayable information. You tried to perform an
operation on a bound or unbound object frame containing an OLE
object, but the OLE object is empty. Use the Object command on the
Insert menu to create an OLE object or to embed or link an OLE object
from a file that isn’t empty.

2719 A problem occurred while accessing the | object.

• The OLE server may not be available because it’s on a network
server and you lost the connection. Try re-establishing the 
connection.
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• The OLE object may be stored in a linked file, but the file isn’t avail-
able. Activate the OLE server outside of Microsoft Access, and then
open the file containing the OLE object to verify that it still exists
and can be accessed.

2723 The | object doesn’t support the attempted operation. The OLE object
was changed to a picture, or the link to the object was broken. If you
want to perform the operation, delete the OLE object, and then embed
or link it again.

2724 One or more dynamic-link libraries required for using OLE objects is
an incorrect version. Run Setup to reinstall Microsoft Access. If you
want to preserve your security or custom settings, back up the
Microsoft Access workgroup information file. For information on back-
ing up files, search the Microsoft Windows Help index for ‘backing up
files’.

2725 The OLE server isn’t registered. To register the OLE server, reinstall it.

2726 Microsoft Access can’t perform the OLE operation because it was
unable to read the Windows Registry where the OLE server is regis-
tered. Reinstall the OLE server, and then try the operation again. If
problems continue, reinstall Microsoft Windows and the other applica-
tions on your computer.

If you reinstall Microsoft Access, you may want to back up your
Microsoft Access workgroup information file first to preserve any cus-
tom settings. For information on backing up files, search the Microsoft
Windows Help index for ‘backing up files’.

For information on the Windows Registry, search the Microsoft
Windows Help index for ‘registry’.

2727 Microsoft Access can’t perform the OLE operation because it was
unable to write to the Windows Registry where the OLE server is regis-
tered. Reinstall the OLE server, and then try the operation again. If
problems continue, reinstall Microsoft Windows and the other applica-
tions on your computer.

If you reinstall Microsoft Access, you may want to back up your
Microsoft Access workgroup information file first to preserve any cus-
tom settings. For information on backing up files, search the Microsoft
Windows Help index for ‘backing up files’.

For information on the Windows Registry, search the Microsoft
Windows Help index for ‘registry’.

2729 The OLE object you tried to edit is busy. Try again later.
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2730 There was a problem communicating with the OLE server. Try 
again later. If you still can’t access the object, try one or more of 
the following:

• Free up system memory. For information on freeing memory, search
the Microsoft Windows Help index for ‘memory, troubleshooting’.

• Reinstall the OLE server to make sure it’s registered.

• Check the OLE server’s documentation for information about the
syntax to use when specifying an OLE object’s data.

2731 An error occurred while accessing the OLE server. The OLE server
may not be registered. To register the OLE server, reinstall it.

2732 Microsoft Access can’t read the | object. Communication between
Microsoft Access and the OLE server was interrupted. Make sure your
computer is connected to the network server on which the OLE server
is located.

2733 The OLE object you tried to edit can’t be accessed. You don’t have
permission to change the object, or another user opened and locked the
object.

2734 You can’t save the | object now. The OLE server is running an opera-
tion, or another user opened and locked the object. Try to save the
object again later.

2735 This disk is write-protected. You can’t save the | object to it.

2737 Microsoft Access can’t find the file containing the linked OLE object
you tried to update using the OLE/DDE Links command. You may
have misspelled the file name, or the file may have been deleted or
renamed. If the file has been moved to a different location, use the
OLE/DDE Links command to change the source. Or delete the object,
and create a new linked object.

2738 There isn’t enough memory to complete the operation. Close unneeded
programs and try the operation again. For more information on freeing
memory, search the Microsoft Windows Help index for ‘memory, trou-
bleshooting’.

2739 An error occurred during the operation with an OLE object. The object
is in use.

2741 Your computer ran out of disk space while Microsoft Access was sav-
ing the changes you made to the | object. For information on freeing
disk space, search the Microsoft Windows Help index for ‘disk space,
freeing’.
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2742 Microsoft Access was unable to create more files. Your computer may
be low on memory or disk space. Close unneeded programs and try the
operation again. For information on freeing memory or disk space,
search the Microsoft Windows Help index for ‘memory, troubleshoot-
ing’ or ‘disk space, freeing’.

2743 The | object is stored in a format that is incompatible with the version
of OLE on your computer.

2744 Microsoft Access can’t find the OLE server. The setting for the
SourceDoc property may be invalid, or the file may have been deleted,
renamed, or moved.

2745 Share.exe or Vshare.386 is missing from your computer; OLE support
needs these files to work correctly. Rerun Microsoft Access or
Microsoft Office Setup to reinstall Microsoft Access, the Share pro-
gram, and Vshare.386. If you want to preserve your security or custom
settings, back up the Microsoft Access workgroup information file.
Then restore the file to its original location. For information on backing
up files, search the Microsoft Windows Help index for ‘backing up
files’.

2746 You can’t switch to Design view because your form contains too many
OLE objects. Close other applications, close the form, and then open
the form again in Design view. Then delete some of the OLE objects or
move them to a different form.

2747 The OLE server can’t display the | object. There is a problem with the
file containing the OLE object, or there isn’t enough memory available.
Open the OLE server outside of Microsoft Access, and then open the
OLE object file. If you can do this, then your computer may be low on
memory. Close other programs, and then try the operation again. For
more information on freeing memory, search the Microsoft Windows
Help index for ‘memory, troubleshooting’.

2748 The Automation object operation isn’t available for the | object. Check
the component’s documentation for information on which operations
are available for an Automation object.

2749 There isn’t enough memory to complete the Automation object opera-
tion on the | object. Close unneeded programs and try the operation
again. For more information on freeing memory, search the Microsoft
Windows Help index for ‘memory, troubleshooting’.

2750 The operation on the | object failed. The OLE server may not be regis-
tered. To register the OLE server, reinstall it.
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2751 The Exit or Update operation failed. You pressed the ESC key (or
another key used in the OLE server to stop an operation) while
Microsoft Access was saving the changes you made to an OLE object
in a form or report. Try to exit or update again.

2753 A problem occurred while Microsoft Access was communicating with
the OLE server or ActiveX Control. Close the OLE server and restart it
outside of Microsoft Access. Then try the original operation again in
Microsoft Access.

2754 A problem occurred while Microsoft Access was communicating with
the OLE server. Try one or more of the following:

• Make sure you’re connected to the network server where the OLE
server application is located.

• Close the OLE server and restart it outside of Microsoft Access. Then
try the original operation again from within Microsoft Access.

• Reinstall the OLE server to ensure that it’s registered.

2755 There was a problem referencing a property or method of the object.
You tried to run a Visual Basic procedure that references an object
property or method. Try one or more of the following:

• Make sure the component is properly registered.

• Make sure your computer is connected to the network server where
the component is located.

• Close the component and restart it outside of Microsoft Access. Then
try again to run the procedure in Microsoft Access.

2756 A problem occurred when Microsoft Access tried to access the OLE
object. Close the Microsoft Access form or report that displays the
OLE object, and close the OLE server. Then reopen the form or report
to see if it can display the OLE object.

2757 There was a problem accessing a property or method of the OLE
object. Try one or more of the following:

• Verify that the OLE server is registered correctly by reinstalling it.

• Make sure your computer is connected to the server on which the
OLE server application resides.

• Close the OLE server and restart it outside of Microsoft Access. Then
try the original operation again from within Microsoft Access.

2758 There was a problem initializing the dynamic-link library Msole20
when you tried to perform the OLE operation.
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• You may have too many Microsoft applications open. Close Windows
applications other than Microsoft Access, and try the OLE operation
again.

• Your computer may have an older version of the dynamic-link library
Msole20, in which case you will need to run Setup to reinstall
Microsoft Access.

If you need to reinstall Microsoft Access, you may want to preserve
your security or custom settings by backing up the Microsoft Access
workgroup information file. For information on backing up files,
search the Microsoft Windows Help index for ‘backing up files’.

2759 The method you tried to invoke on an object failed.

• You may have specified too many or too few arguments for a prop-
erty or method of an object. Check the component’s documentation
for information on the properties and methods it makes available for
Automation operations.

• There may not be enough memory to run the procedure. Close
unneeded programs and try to run the procedure again. For more
information on freeing memory, search the Microsoft Windows Help
index for ‘memory, troubleshooting’.

2760 An error occurred while referencing the object. You tried to run a
Visual Basic procedure that improperly references a property or
method of an object.

2761 There was a problem referencing a property or method of an object.
Check the component’s documentation for information on the proper-
ties and methods it makes available for Automation operations.

2762 | returned an error while referencing a property of an object. Check the
component’s documentation for information on the properties and
methods it makes available for Automation operations.

2763 |1 returned the error: |2. Check the component’s documentation for
information on the properties and methods it makes available for
Automation operations.

2764 The object’s property or method can’t be set. You tried to run a Visual
Basic procedure to set a property or apply a method for an object.
However, the property or method doesn’t support named arguments.
Check the component’s documentation for information on the proper-
ties and methods it makes available to Automation operations.
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2765 Visual Basic can’t convert the data type of one of the arguments you
entered. You tried to run a Visual Basic procedure that executes a
method or sets a property of an object. Check the component’s docu-
mentation for information on the properties and methods it makes
available for Automation operations.

2766 The object doesn’t contain the Automation object ‘|.’You tried to run a
Visual Basic procedure to set a property or method for an object.
However, the component doesn’t make the property or method avail-
able for Automation operations. Check the component’s documentation
for information on the properties and methods it makes available for
Automation operations.

2767 The object doesn’t support American English; it was developed using a
different language. Use a version of the object developed in Visual
Basic that supports the language you are using.

2768 The number you used to reference an element in the array is outside
the bounds of the array. For example, the array is from 0 through 10,
and you entered a -1 or an 11. Check the component’s documentation
for information on the properties and methods it makes available for
Automation operations.

2769 A property of the Automation object requires or returns a data type that
isn’t supported by Visual Basic. You tried to run a Visual Basic proce-
dure that references an Automation object’s property. However, the
value of the property isn’t supported by Visual Basic. Check the com-
ponent’s documentation for information on the properties and methods
it makes available for Automation operations.

2770 The object you referenced in the Visual Basic procedure as an OLE
object isn’t an OLE object.

2771 The bound or unbound object frame you tried to edit doesn’t contain
an OLE object. Use the Object command on the Insert menu to add an
OLE object to the bound or unbound object frame.

2774 The component doesn’t support Automation. You tried to run a Visual
Basic procedure that references an Automation object. Check the com-
ponent’s documentation for information on whether it supports
Automation.

2775 You specified too many arguments in the Visual Basic procedure, or
there isn’t enough memory to run the procedure. Specify fewer argu-
ments, or close unneeded programs, and then try to run the procedure
again. For more information on freeing memory, search the Microsoft
Windows Help index for ‘memory, troubleshooting’.
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2777 The class argument in the CreateObject function of the Visual Basic
procedure you’re trying to run is invalid. Try one of the following:

• Make sure the file is installed on your computer and that you used the
correct file name.

• Check the OLE server’s documentation for information about the syn-
tax to use when specifying an OLE object’s data.

2778 Microsoft Access tried to create an OLE link, but there was no source
document for this object.

2782 You must specify a property or method for the object. You tried to run
a Visual Basic procedure that references and sets a property or method
for the object. Enter a property or method for the object.

2783 You entered an invalid setting for the Action property. Use one of the
Microsoft Access intrinsic constants for the Action property. For a list
of valid settings you can use with the Action property, click Help.

2784 The path you entered for the SourceDoc property setting for a linked
OLE object is too long. Move the file to a location with a shorter path.

2785 The OLE server wasn’t able to open the object.

• The OLE server may not be installed.

• You may have specified an invalid setting for the SourceDoc or
SourceItem property in a property sheet, a macro, or a Visual Basic
procedure. To see the valid settings for either of these properties,
search the Help index for the property topic.

2786 The OLE server doesn’t support linking. You tried to run a Visual Basic
procedure using the Action property. However, you provided insuffi-
cient information to establish a link.

2788 The | object isn’t a linked object. The property you tried to set in Visual
Basic applies only to linked objects.

2790 You can’t embed an OLE object into a bound or unbound object frame
if the OLETypeAllowed property for the bound or unbound object
frame is set to Linked. Insert a linked object, or set the
OLETypeAllowed property to Embedded or Either, and then embed the
object.

2791 Microsoft Access can’t link the OLE object or the bound or unbound
object frame. The OLETypeAllowed property for the bound or
unbound object frame is set to Embedded. Embed the object, or set the
OLETypeAllowed property to Linked or Either, and then link the
object.
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2792 You can’t save a locked OLE object.

2793 Microsoft Access can’t perform the operation specified in the Action
property of the Visual Basic procedure you’re trying to run. The object
frame may be locked or disabled. Set the Locked property to No and
the Enabled property to Yes.

2794 The ActiveX control you tried to insert isn’t registered. For information
on registering an ActiveX control, click Help.

2797 This OLE object was created in an earlier version of OLE so it can’t be
displayed as an icon. For an effect similar to displaying an object as an
icon, add an image control to your form, and add the icon for the appli-
cation to the image control. Then set the image control’s OnDblClick
property to a Visual Basic procedure that opens the OLE object.

2798 You can’t use the Action property to delete a bound OLE object from
its underlying table or query. You tried to run a Visual Basic procedure
that deletes the object in a bound object frame by setting the Action
property to acOLEDelete. Delete the object in a different way, such as
with the DAO Delete method in Visual Basic.

2799 The OLE object can’t be activated upon receiving the focus. If you
selected an OLE object or a chart, and the AutoActivate property for
that control is set to GetFocus, the OLE object or chart should be acti-
vated automatically when it receives the focus. However, the ActiveX
component doesn’t support this operation. Check the component’s doc-
umentation for information on the properties and methods it makes
available to Automation operations.

2800 The object is locked, so any changes you make will be discarded when
the form is closed. Click Save As on the File menu and save the object
under a different name.

2801 The OLE object isn’t loaded because the unbound ActiveX control has-
n’t been initialized.

2802 You can’t insert an ActiveX control in a bound or unbound object
frame. ActiveX controls are automatically contained in ActiveX control
frames.

2803 You don’t have the license required to use this ActiveX control. You
tried to open a form containing an OLE object or an ActiveX control or
you tried to create an ActiveX control. To obtain the appropriate
license, contact the company that provides the licensed OLE object or
ActiveX control.
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2804 You can’t create an ActiveX control in an unbound object frame.
ActiveX controls are automatically contained in ActiveX control
frames.

2805 There was an error loading an ActiveX control on one of your forms or
reports. Make sure all the controls that you are using are properly reg-
istered. For information on registering an ActiveX control, click Help.

2806 Microsoft Access doesn’t support this ActiveX control.

2807 You can’t paste this object as the type you specified. Choose another
object type.

2808 Microsoft Access can’t find the Active Accessibility dynamic-link
library (DLL) OleAcc. Rerun the Microsoft Access Setup program.

2811 Microsoft Access is unable to create the data access page.

2812 | The path specified was invalid, or may be too long. Please check the
path and ensure it is correct.

2813 | The file could not be opened. It may currently be in use.

2814 | Unable to save the file.

2815 | Unable to save the file to an alternate location.

2816 | Unable to close the file.

2817 Microsoft Access is unable to save (or send) the data access page.

2818 Microsoft Access is unable to retrieve the file: |. Either the file is not
available, or you do not have enough disk space to copy the file.

2819 Microsoft Access is unable to open the data access page.

2820 Microsoft Access is unable to change the BASE HREF for your docu-
ment.

2821 File in use

2822 Microsoft Access encountered an unexpected error while attempting to
recover from a failed save (or send). Your data access page may not be
in a usable state. Please attempt to save to a different location.

2823 The Microsoft Access data access page name ‘|’ is misspelled or refers
to a Page that doesn’t exist. If the invalid Page name is in a macro, an
Action Failed dialog box will display the macro name and the macro’s
arguments after you click OK. Open the Macro window, and enter the
correct Page name.

2824 | You do not have adequate file permissions.

2825 | The file does not exist, or you do not have read access to the file.

2827 | File read error.
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2828 | File write error. The disk may be full.

2832 | Check file permissions and delete them from their location in your
computer’s file system.

2833 | An unexpected error has occurred.

2835 | An attempt to create this file has failed. Please select another location
and retry the operation.

2837 | There was not enough memory. Please close other applications and
try the operation again.

2838 Microsoft Access is unable to preview the selected theme.

2839 | An attempt to create a temporary file has failed. Please confirm that
you have adequate disk space on your system drive and try the opera-
tion again.

2840 | Unable to read the list of supporting files from the data access page.

2842 Microsoft Access encountered an error after saving (or sending) your
data access page.

2845 Microsoft Access is unable to open the data access page from the mail
envelope.

2846 | The save destination is full. Please clear space at the destination or
save to another location.

2847 | Unable to create a folder for the supporting files. You may not have
adequate permissions at the save destination.

2848 | The maximum path length was exceeded. Please specify a shorter file-
name, or use a folder that is closer to the root.

2849 | There are too many supporting files in your document. Please remove
a few supporting files from your document, and try again.

2850 | You do not have write permission at the save destination.

2851 | You are saving to a server that does not support long filenames and do
not have permission to create a folder. You must have permission to
create a folder at the save destination to complete this operation.

2854 Microsoft Access was unable to parse the document properties for this
data access page. They may be corrupted.

2855 Microsoft Access could not delete one or more files related to the page.

2859 Access could not load the e-mail envelope. This could be caused 
by a network connection problem or a problem with your Office 
installation.
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2860 You cannot insert a bound field to a caption or record navigation s
ection.

2861 Microsoft Access is unable to preview the selected web page.

2862 The file you attempted to load was not recognized as HTML. You may
have selected the wrong file, or tried to open a database file off of a
web server.

2863 | Unable to create or load a file due to network or access permission
problems.

2864 | This file (or a supporting file) is already in use, or has the read-only
attribute set.

2865 | The disk is write-protected.

2866 | Unexpected data corruption failure.

2867 | Unexpected data I/O failure.

2868 | You cannot save this data access page over itself because it is read-
only. Please select a different file for the save.

2869 | The file does not exist. You do not have adequate permission to mod-
ify the data access page link to point to a valid file. Please contact the
database administrator.

2870 Microsoft Access encountered an error synchronizing the HTML from
the Microsoft Script Editor. Please check the HTML for syntax errors
and try again.

2871 Microsoft Access is unable to create a data access page using the code-
page selected in Web Options. The codepage may not be installed on
your system. Please install the codepage, or select a different one in
Web Options.

2873 | The filename specified is a long filename, but you have the ‘use long
filenames’ web option turned off. Please specify a file name that uses a
maximum of eight characters for the name and three characters for the
file extension.

2874 Cannot move or paste the grouping field ‘|’ into a section at a higher
group level.

2875 | Unable to complete the save. The drive or network connection you
attempted to save to may no longer be available.

2876 The data definition of this data access page has been corrupted and
can’t be repaired. You must recreate the page. Save has been disabled.
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In a Microsoft Access database (.mdb), you can’t group on a control
bound to a field that has a Memo or OLE Object data type. In a
Microsoft Access project (.adp), you can’t group on a control bound to
a field that has an Image or Text data type.

2878 You cannot add a bound field to a caption or record navigation section.

2879 Caption and record navigation sections cannot contain bound fields.

2880 Can’t edit pages that contain framesets.

2881 This web page contains XML namespaces that may conflict with
Access namespaces. You should edit the HTML source to ensure that
all namespaces have a unique prefix.

2882 | The folder that this Web page would use to organize supporting files
is already reserved for use in the current location. Please choose a dif-
ferent name or location for this Web page.

2883 A supporting file path for this data access page has been altered out-
side of Access. Please save this page to a different location and ensure
that all supporting files are maintained.

2884 Cannot find the database or some database objects that this page refers
to. Update the connection information of the page, or fix the references
to the missing database objects.

2885 This page uses a database which is not supported. You will not be able
to make data changes until you connect to a supported database

2886 Components necessary for data access pages are not installed.

2887 | The path specified is not a valid absolute (non-relative) path or URL.
Please enter a valid path.

2888 Microsoft Access detects some HTML elements between the banner
and the section of your data access page. Saving this page in Access
will corrupt it. Close the page without saving it, and then edit the page
in another HTML editor to remove these elements.

2889 This section cannot be deleted.

2890 You cannot edit this page because it contains frames. The data access
page designer cannot edit pages with frames.

2892 You can’t move the group filter control to another section. Delete the
group filter control from the current section and create it in a different
section.

2893 A link to this data access page could not be created because the data-
base cannot be exclusively locked. To create the link later, open the
page by selecting ‘Edit web page that already exists’, and then save.
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2894 The link to the data access page specified could not be updated because
the database cannot be exclusively locked. To update the link, open this
page again when you are the only person using the database.

2895 This page was designed with a later version of the Microsoft Office
Web Components than those currently installed on your machine. If
you have not been prompted to install those components on this page,
please contact the page author for the installation location.

2896 The operation is only valid on a data access page opened in Design
View. Please switch the page to Design View and try the operation
again.

2897 You have opened a page that was last designed using Access 2000. The
page must be saved using Office 2002 Office Web Components before
you can edit this document. Would you like to convert this page?

2898 Microsoft Access has created a backup copy of your original page.
This page can be used if you want to revert to the Office 2000 Web
Components.

The backup page name is: ‘|’

2899 Microsoft Access could not create a backup copy of your original page.
This page cannot be opened.

2900 Microsoft Access could not upgrade the Office Web Components on
your page. This page cannot be opened.

2901 Error loading ActiveX control ‘|1’ on form or report ‘|2’.

2902 Access is unable to save the | object because it does not support persis-
tence, or your computer may have run out of disk space.

2903 Do you want to set this folder as the default location for data access
pages?

2904 You must match each field on the left with a field on the right.

2905 You must choose a linking field for every parameter.

2906 ‘|’ contains no fields that can participate in a relationship.

2907 Do you want to revert to the saved ‘|’?

2908 The Control ID ‘|’ is already in use. Specify a different ID for the 
control.

2909 This relationship is not valid because the fields in the first table do not
match the fields in the second table. To repair the relationship, select at
least one field from each table.

2910 This connection file refers to a provider not supported by data access
pages. Please select a different connection file.
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2911 You cannot change the data access page path while it is open. Please
close the page and try again.

2912 If you create a data access page in this version of Microsoft Access,
you can’t open it in Design view in Access 2000. However, you can
open the page in Page view in Access 2000, if you have installed the
Microsoft Office 2002 Web Components.

2913 Cannot save to a URL address with a bookmark. Please specify a valid
path.

2914 Microsoft Access could not link to a connection file. A connection
string will be embedded in the page.

2915 Microsoft Access is unable to connect to the data source specified in
the connection string of this page. The server may not exist on the net-
work, or there may be an error in the connection string information for
this page.

2916 You cannot edit HTML pages created using PowerPoint in Microsoft
Access.

2917 Invalid HTML color value.

2918 Unable to open or read this connection file. Either the file has been
damaged or the file format is not valid.

2919 You can’t place this control in the section you specified.

2920 Microsoft Access is unable to load the database schema. Save has been
disabled. Either repair or reinstall Microsoft Office 2002.

2921 Microsoft Access cannot open this page because it was created using a
newer version of Access. Try opening the page using a newer version
of Microsoft Access.

3000 Reserved error (|); there is no message for this error.

3001 Invalid argument.

3002 Could not start session.

3003 Could not start transaction; too many transactions already nested.

3004 ••••••••••

3005 ‘|’ is not a valid database name.

3006 Database ‘|’ is exclusively locked.

3007 Cannot open library database ‘|’.

3008 The table ‘|’ is already opened exclusively by another user, or it is
already open through the user interface and cannot be manipulated pro-
grammatically.
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3009 You tried to lock table ‘|’ while opening it, but the table cannot be
locked because it is currently in use. Wait a moment, and then try the
operation again.

3010 Table ‘|’ already exists.

3011 The Microsoft Jet database engine could not find the object ‘|’. Make
sure the object exists and that you spell its name and the path name
correctly.

3012 Object ‘|’ already exists.

3013 Could not rename installable ISAM file.

3014 Cannot open any more tables.

3015 Index not found.

3016 Field will not fit in record.

3017 The size of a field is too long.

3018 Could not find field.

3019 Operation invalid without a current index.

3020 Update or CancelUpdate without AddNew or Edit.

3021 No current record.

3022 The changes you requested to the table were not successful because
they would create duplicate values in the index, primary key, or rela-
tionship. Change the data in the field or fields that contain duplicate
data, remove the index, or redefine the index to permit duplicate entries
and try again.

3023 AddNew or Edit already used.

3024 Could not find file ‘|’.

3025 Cannot open any more files.

3026 Not enough space on disk.

3027 Cannot update. Database or object is read-only.

3028 Cannot start your application. The workgroup information file is miss-
ing or opened exclusively by another user.

3029 Not a valid account name or password.

3030 ‘|’ is not a valid account name.

3031 Not a valid password.

3032 Cannot perform this operation.

3033 You do not have the necessary permissions to use the ‘|’ object. Have
your system administrator or the person who created this object estab-
lish the appropriate permissions for you.

Appendixes for Web Site

PART VI
70



ErrorCode ErrorString

3034 You tried to commit or rollback a transaction without first beginning a
transaction.

3035 System resource exceeded.

3036 Database has reached maximum size.

3037 Cannot open any more tables or queries.

3038 System resource exceeded.

3039 Could not create index; too many indexes already defined.

3040 Disk I/O error during read.

3041 Cannot open a database created with a previous version of your
application.

3042 Out of MS-DOS file handles.

3043 Disk or network error.

3044 ‘|’ is not a valid path. Make sure that the path name is spelled correctly
and that you are connected to the server on which the file resides.

3045 Could not use ‘|’; file already in use.

3046 Could not save; currently locked by another user.

3047 Record is too large.

3048 Cannot open any more databases.

3049 Cannot open database ‘|’. It may not be a database that your applica-
tion recognizes, or the file may be corrupt.

3050 Could not lock file.

3051 The Microsoft Jet database engine cannot open the file ‘|’. It is already
opened exclusively by another user, or you need permission to view its
data.

3052 File sharing lock count exceeded. Increase MaxLocksPerFile registry
entry.

3053 Too many client tasks.

3054 Too many Memo, OLE, or Hyperlink Object fields.

3055 Not a valid file name.

3056 Could not repair this database.

3057 Operation not supported on linked tables.

3058 Index or primary key cannot contain a Null value.

3059 Operation canceled by user.

3060 Wrong data type for parameter ‘|’.
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3061 Too few parameters. Expected |.

3062 Duplicate output alias ‘|’.

3063 Duplicate output destination ‘|’.

3064 Cannot open action query ‘|’.

3065 Cannot execute a select query.

3066 Query must have at least one destination field.

3067 Query input must contain at least one table or query.

3068 Not a valid alias name.

3069 The action query ‘|’ cannot be used as a row source.

3070 The Microsoft Jet database engine does not recognize ‘|’ as a valid field
name or expression.

3071 This expression is typed incorrectly, or it is too complex to be evalu-
ated. For example, a numeric expression may contain too many com-
plicated elements. Try simplifying the expression by assigning parts of
the expression to variables.

3072 |

3073 Operation must use an updateable query.

3074 Cannot repeat table name ‘|’ in FROM clause.

3075 |1 in query expression ‘|2’.

3076 | in criteria expression.

3077 | in expression.

3078 The Microsoft Jet database engine cannot find the input table or query
‘|’. Make sure it exists and that its name is spelled correctly.

3079 The specified field ‘|’ could refer to more than one table listed in the
FROM clause of your SQL statement.

3080 Joined table ‘|’ not listed in FROM clause.

3081 Cannot join more than one table with the same name (|).

3082 JOIN operation ‘|’ refers to a field that is not in one of the joined
tables.

3083 Cannot use internal report query.

3084 Cannot insert data with action query.

3085 Undefined function ‘|’ in expression.

3086 Could not delete from specified tables.

3087 Too many expressions in GROUP BY clause.
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3088 Too many expressions in ORDER BY clause.

3089 Too many expressions in DISTINCT output.

3090 Resultant table not allowed to have more than one AutoNumber field.

3091 HAVING clause (|) without grouping or aggregation.

3092 Cannot use HAVING clause in TRANSFORM statement.

3093 ORDER BY clause (|) conflicts with DISTINCT.

3094 ORDER BY clause (|) conflicts with GROUP BY clause.

3095 Cannot have aggregate function in expression (|).

3096 Cannot have aggregate function in WHERE clause (|).

3097 Cannot have aggregate function in ORDER BY clause (|).

3098 Cannot have aggregate function in GROUP BY clause (|).

3099 Cannot have aggregate function in JOIN operation (|).

3100 Cannot set field ‘|’ in join key to Null.

3101 The Microsoft Jet database engine cannot find a record in the table ‘|2’
with key matching field(s) ‘|1’.

3102 Circular reference caused by ‘|’.

3103 Circular reference caused by alias ‘|’ in query definition’s SELECT list.

3104 Cannot specify fixed column heading ‘|’ in a crosstab query more than
once.

3105 Missing destination field name in SELECT INTO statement (|).

3106 Missing destination field name in UPDATE statement (|).

3107 Record(s) cannot be added; no insert permission on ‘|’.

3108 Record(s) cannot be edited; no update permission on ‘|’.

3109 Record(s) cannot be deleted; no delete permission on ‘|’.

3110 Could not read definitions; no read definitions permission for table or
query ‘|’.

3111 Could not create; no modify design permission for table or query ‘|’.

3112 Record(s) cannot be read; no read permission on ‘|’.

3113 Cannot update ‘|’; field not updateable.

3114 Cannot include Memo, OLE, or Hyperlink Object when you select
unique values (|).

3115 Cannot have Memo, OLE, or Hyperlink Object fields in aggregate
argument (|).
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3116 Cannot have Memo, OLE, or Hyperlink Object fields in criteria (|) for
aggregate function.

3117 Cannot sort on Memo, OLE, or Hyperlink Object (|).

3118 Cannot join on Memo, OLE, or Hyperlink Object (|).

3119 Cannot group on Memo, OLE, or Hyperlink Object (|).

3120 Cannot group on fields selected with ‘•’ (|).

3121 Cannot group on fields selected with ‘•’.

3122 You tried to execute a query that does not include the specified expres-
sion ‘|’ as part of an aggregate function.

3123 Cannot use ‘•’ in crosstab query.

3124 Cannot input from internal report query (|).

3125 ‘|’ is not a valid name. Make sure that it does not include invalid char-
acters or punctuation and that it is not too long.

3126 Invalid bracketing of name ‘|’.

3127 The INSERT INTO statement contains the following unknown field
name: ‘|’. Make sure you have typed the name correctly, and try the
operation again.

3128 Specify the table containing the records you want to delete.

3129 Invalid SQL statement; expected ‘DELETE’, ‘INSERT’, ‘PROCE-
DURE’, ‘SELECT’, or ‘UPDATE’.

3130 Syntax error in DELETE statement.

3131 Syntax error in FROM clause.

3132 Syntax error in GROUP BY clause.

3133 Syntax error in HAVING clause.

3134 Syntax error in INSERT INTO statement.

3135 Syntax error in JOIN operation.

3136 The LEVEL clause includes a reserved word or argument that is mis-
spelled or missing, or the punctuation is incorrect.

3137 Missing semicolon (;) at end of SQL statement.

3138 Syntax error in ORDER BY clause.

3139 Syntax error in PARAMETER clause.

3140 Syntax error in PROCEDURE clause.

3141 The SELECT statement includes a reserved word or an argument name
that is misspelled or missing, or the punctuation is incorrect.
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3142 Characters found after end of SQL statement.

3143 Syntax error in TRANSFORM statement.

3144 Syntax error in UPDATE statement.

3145 Syntax error in WHERE clause.

3146 ODBC—call failed.

3151 ODBC—connection to ‘|’ failed.

3154 ODBC—could not find DLL ‘|’.

3155 ODBC—insert on a linked table ‘|’ failed.

3156 ODBC—delete on a linked table ‘|’ failed.

3157 ODBC—update on a linked table ‘|’ failed.

3158 Could not save record; currently locked by another user.

3159 Not a valid bookmark.

3160 Table is not open.

3161 Could not decrypt file.

3162 You tried to assign the Null value to a variable that is not a Variant data
type.

3163 The field is too small to accept the amount of data you attempted to
add. Try inserting or pasting less data.

3164 Field cannot be updated.

3165 Could not open .inf file.

3166 Cannot locate the requested Xbase memo file.

3167 Record is deleted.

3168 Invalid .inf file.

3169 The Microsoft Jet database engine could not execute the SQL state-
ment because it contains a field that has an invalid data type.

3170 Could not find installable ISAM.

3171 Could not find network path or user name.

3172 Could not open Paradox.net.

3173 Could not open table ‘MSysAccounts’ in the workgroup information
file.

3174 Could not open table ‘MSysGroups’ in the workgroup information file.

3175 Date is out of range or is in an invalid format.

3176 Could not open file ‘|’.
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3177 Not a valid table name.

3179 Encountered unexpected end of file.

3180 Could not write to file ‘|’.

3181 Invalid range.

3182 Invalid file format.

3183 Not enough space on temporary disk.

3184 Could not execute query; could not find linked table.

3185 SELECT INTO on a remote database tried to produce too many fields.

3186 Could not save; currently locked by user ‘|2’ on machine ‘|1’.

3187 Could not read; currently locked by user ‘|2’ on machine ‘|1’.

3188 Could not update; currently locked by another session on this machine.

3189 Table ‘|1’ is exclusively locked by user ‘|3’ on machine ‘|2’.

3190 Too many fields defined.

3191 Cannot define field more than once.

3192 Could not find output table ‘|’.

3193 (unknown)

3194 (unknown)

3195 (expression)

3196 The database ‘|’ is already in use by another person or process. When
the database is available, try the operation again.

3197 The Microsoft Jet database engine stopped the process because you
and another user are attempting to change the same data at the same
time.

3198 Could not start session. Too many sessions already active.

3199 Could not find reference.

3200 The record cannot be deleted or changed because table ‘|’ includes
related records.

3201 You cannot add or change a record because a related record is required
in table ‘|’.

3202 Could not save; currently locked by another user.

3203 Subqueries cannot be used in the expression (|).

3204 Database already exists.

3205 Too many crosstab column headers (|).
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3206 Cannot create a relationship between a field and itself.

3207 Operation not supported on a Paradox table with no primary key.

3208 Invalid Deleted setting in the Xbase key of the Windows Registry.

3209 ••••••••••

3210 The connection string is too long.

3211 The database engine could not lock table ‘|’ because it is already in use
by another person or process.

3212 Could not lock table ‘|1’; currently in use by user ‘|3’ on machine ‘|2’.

3213 Invalid Date setting in the Xbase key of the Windows Registry.

3214 Invalid Mark setting in the Xbase key of the Windows Registry.

3215 Too many Btrieve tasks.

3216 Parameter ‘|’ specified where a table name is required.

3217 Parameter ‘|’ specified where a database name is required.

3218 Could not update; currently locked.

3219 Invalid operation.

3220 Incorrect collating sequence.

3221 Invalid settings in the Btrieve key of the Windows Registry.

3222 Query cannot contain a Database parameter.

3223 ‘|’ is invalid because it is too long, or contains invalid characters.

3224 Cannot read Btrieve data dictionary.

3225 Encountered a record locking deadlock while performing a Btrieve
operation.

3226 Errors encountered while using the Btrieve DLL.

3227 Invalid Century setting in the Xbase key of the Windows Registry.

3228 Selected collating sequence not supported by the operating system.

3229 Btrieve—cannot change field.

3230 Out-of-date Paradox lock file.

3231 ODBC—field would be too long; data truncated.

3232 ODBC—could not create table.

3234 ODBC—remote query timeout expired.

3235 ODBC—data type not supported on server.

3238 ODBC—data out of range.

3239 Too many active users.
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3240 Btrieve—missing Btrieve engine.

3241 Btrieve—out of resources.

3242 Invalid reference in SELECT statement.

3243 None of the import field names match fields in the appended table.

3244 Cannot import password-protected spreadsheet.

3245 Could not parse field names from the first row of the import table.

3246 Operation not supported in transactions.

3247 ODBC—linked table definition has changed.

3248 Invalid NetworkAccess setting in the Windows Registry.

3249 Invalid PageTimeout setting in the Windows Registry.

3250 Could not build key.

3251 Operation is not supported for this type of object.

3252 Cannot open a form whose underlying query contains a user-defined
function that attempts to set or get the form’s RecordsetClone property.

3254 ODBC—Cannot lock all records.

3256 Index file not found.

3257 Syntax error in WITH OWNERACCESS OPTION declaration.

3258 The SQL statement could not be executed because it contains ambigu-
ous outer joins. To force one of the joins to be performed first, create a
separate query that performs the first join and then include that query
in your SQL statement.

3259 Invalid field data type.

3260 Could not update; currently locked by user ‘|2’ on machine ‘|1’.

3261 Table ‘|’ is exclusively locked by user ‘|2’ on machine ‘|1’.

3262 Could not lock table

3263 Invalid Database object.

3264 No field defined—cannot append TableDef or Index.

3265 Item not found in this collection.

3266 Cannot append a Field that is already a part of a Fields collection.

3267 Property can be set only when the Field is part of a Recordset object’s
Fields collection.

3268 Cannot set this property once the object is part of a collection.

3269 Cannot append an Index that is already a part of an Indexes collection.
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3270 Property not found.

3271 Invalid property value.

3272 Object is not a collection.

3273 Method not applicable for this object.

3274 External table is not in the expected format.

3275 Unexpected error from external database driver (|).

3276 Invalid database object reference.

3277 Cannot have more than 10 fields in an index.

3278 The Microsoft Jet database engine has not been initialized.

3279 The Microsoft Jet database engine has already been initialized.

3280 Cannot delete a field that is part of an index or is needed by the
system.

3281 Cannot delete this index or table. It is either the current index or is
used in a relationship.

3282 Operation not supported on a table that contains data.

3283 Primary key already exists.

3284 Index already exists.

3285 Invalid index definition.

3286 Format of memo file does not match specified external database 
format.

3287 Cannot create index on the given field.

3288 Paradox index is not primary.

3289 Syntax error in CONSTRAINT clause.

3290 Syntax error in CREATE TABLE statement.

3291 Syntax error in CREATE INDEX statement.

3292 Syntax error in field definition.

3293 Syntax error in ALTER TABLE statement.

3294 Syntax error in DROP INDEX statement.

3295 Syntax error in DROP TABLE or DROP INDEX.

3296 Join expression not supported.

3297 Could not import table or query. No records found, or all records 
contain errors.

3298 There are several tables with that name. Please specify owner in the
format ‘owner.table’.
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3299 ODBC Specification Conformance Error (|). Report this error to the
developer of your application.

3300 Cannot create a relationship.

3301 Cannot perform this operation; features in this version are not available
in databases with older formats.

3302 Cannot change a rule while the rules for this table are in use.

3303 Cannot delete this field. It is part of one or more relationships.

3304 You must enter a personal identifier (PID) consisting of at least 4 and
no more than 20 characters and digits.

3305 Invalid connection string in pass-through query.

3306 You have written a subquery that can return more than one field with-
out using the EXISTS reserved word in the main query’s FROM
clause. Revise the SELECT statement of the subquery to request only
one field.

3307 The number of columns in the two selected tables or queries of a union
query do not match.

3308 Invalid TOP argument in select query.

3309 Property value is too large.

3310 This property is not supported for external data sources or for data-
bases created with a previous version of Microsoft Jet.

3311 Property specified already exists.

3312 Validation rules and default values cannot be placed on system or
linked tables.

3313 Cannot place this validation expression on this field.

3314 The field ‘|’ cannot contain a Null value because the Required property
for this field is set to True. Enter a value in this field.

3315 Field ‘|’ cannot be a zero-length string.

3316 |

3317 One or more values are prohibited by the validation rule ‘|2’ set for
‘|1’. Enter a value that the expression for this field can accept.

3318 Values specified in a TOP clause are not allowed in delete queries or
reports.

3319 Syntax error in union query.

3320 | in table-level validation expression.

3321 No database specified in connection string or IN clause.
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3322 Crosstab query contains one or more invalid fixed column headings.

3323 The query cannot be used as a row source.

3324 The query is a DDL query and cannot be used as a row source.

3325 Pass-through query with ReturnsRecords property set to True did not
return any records.

3326 This Recordset is not updateable.

3327 Field ‘|’ is based on an expression and cannot be edited.

3328 Table ‘|2’ is read-only.

3329 Record in table ‘|’ was deleted by another user.

3330 Record in table ‘|’ is locked by another user.

3331 To make changes to this field, first save the record.

3332 Cannot enter value into blank field on ‘one’ side of outer join.

3333 Records in table ‘|’ would have no record on the ‘one’ side.

3334 Can be present only in version 1.0 format.

3335 DeleteOnly called with non-zero cbData.

3336 Btrieve: Invalid IndexDDF option in initialization setting.

3337 Invalid DataCodePage option in initialization setting.

3338 Btrieve: Xtrieve options are not correct in initialization setting.

3339 Btrieve: Invalid IndexDeleteRenumber option in initialization setting.

3340 Query ‘|’ is corrupt.

3341 The current field must match the join key ‘|’ in the table that serves as
the ‘one’ side of one-to-many relationship. Enter a record in the ‘one’
side table with the desired key value, and then make the entry with the
desired join key in the ‘many-only’ table.

3342 Invalid Memo, OLE, or Hyperlink Object in subquery ‘|’.

3343 Unrecognized database format ‘|’.

3344 The database engine does not recognize either the field ‘|1’ in a valida-
tion expression, or the default value in the table ‘|2’.

3345 Unknown or invalid field reference ‘|’.

3346 Number of query values and destination fields are not the same.

3347 Cannot add record(s); primary key for table ‘|’ not in recordset.

3348 Cannot add record(s); join key of table ‘|’ not in recordset.

3349 Numeric field overflow.
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3350 Object is invalid for operation.

3351 The ORDER BY expression (|) includes fields that are not selected by
the query. Only those fields requested in the first query can be included
in an ORDER BY expression.

3352 No destination field name in INSERT INTO statement (|).

3353 Btrieve: Cannot find file Field.ddf.

3354 At most one record can be returned by this subquery.

3355 Syntax error in default value.

3356 You attempted to open a database that is already opened exclusively by
user ‘|2’ on machine ‘|1’. Try again when the database is available.

3357 This query is not a properly formed data-definition query.

3358 Cannot open the Microsoft Jet engine workgroup information file.

3359 Pass-through query must contain at least one character.

3360 Query is too complex.

3361 Unions not allowed in a subquery.

3362 Single-row update/delete affected more than one row of a linked table.
Unique index contains duplicate values.

3363 Record(s) cannot be added; no corresponding record on the ‘one’ side.

3364 Cannot use Memo, OLE, or Hyperlink Object field ‘|’ in the SELECT
clause of a union query.

3365 Property value not valid for REMOTE objects.

3366 Cannot append a relation with no fields defined.

3367 Cannot append. An object with that name already exists in the collec-
tion.

3368 Relationship must be on the same number of fields with the same data
types.

3369 ••••••••••

3370 Cannot modify the design of table ‘|’. It is in a read-only database.

3371 Cannot find table or constraint.

3372 No such index ‘|2’ on table ‘|1’.

3373 Cannot create relationship. Referenced table ‘|’ does not have a primary
key.

3374 The specified fields are not uniquely indexed in table ‘|’.

3375 Table ‘|1’ already has an index named ‘|2’.
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3376 Table ‘|’ does not exist.

3377 No such relationship ‘|2’ on table ‘|1’.

3378 There is already a relationship named ‘|’ in the current database.

3379 Cannot create relationships to enforce referential integrity. Existing
data in table ‘|2’ violates referential integrity rules in table ‘|1’.

3380 Field ‘|2’ already exists in table ‘|1’.

3381 There is no field named ‘|2’ in table ‘|1’.

3382 Size of field ‘|’ is too long.

3383 Cannot delete field ‘|’. It is part of one or more relationships.

3384 Cannot delete a built-in property.

3385 User-defined properties do not support a Null value.

3386 Property ‘|’ must be set before using this method.

3387 Cannot find TEMP directory.

3388 Unknown function ‘|2’ in validation expression or default value on ‘|1’.

3389 Query support unavailable.

3390 Account name already exists.

3391 An error has occurred. Properties were not saved.

3392 ••••••••••

3393 Cannot perform join, group, sort, or indexed restriction. A value being
searched or sorted on is too long.

3394 Cannot save property; property is a schema property.

3395 ••••••••••

3396 Cannot perform cascading operation. Since related records exist in
table ‘|’, referential integrity rules would be violated.

3397 Cannot perform cascading operation. There must be a related record in
table ‘|’.

3398 Cannot perform cascading operation. It would result in a null key in
table ‘|’.

3399 Cannot perform cascading operation. It would result in a duplicate key
in table ‘|’.

3400 Cannot perform cascading operation. It would result in two updates to
field ‘|2’ in table ‘|1’.

3401 Cannot perform cascading operation. It would cause field ‘|’ to become
Null, which is not allowed.
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3402 Cannot perform cascading operation. It would cause field ‘|’ to become
a zero-length string, which is not allowed.

3403 Cannot perform cascading operation: ‘|’.

3404 Cannot perform cascading operation. The value entered is prohibited
by the validation rule ‘|2’ set for ‘|1’.

3405 Error ‘|’ in validation rule.

3406 The expression you are trying to use for the DefaultValue property is
invalid because ‘|’. Use a valid expression to set this property.

3407 The server’s MSysConf table exists, but is in an incorrect format.
Contact your system administrator.

3408 Too many FastFind Sessions were invoked.

3409 Invalid field definition ‘|’ in definition of index or relationship.

3411 Invalid entry. Cannot perform cascading operation in table ‘|1’ because
the value entered is too large for field ‘|2’.

3412 Cannot perform cascading update on the table because it is currently in
use by another user.

3413 Cannot perform cascading operation on table ‘|1’ because it is currently
in use by user ‘|3’ on machine ‘|2’.

3414 Cannot perform cascading operation on table ‘|1’ because it is currently
in use.

3415 Zero-length string is valid only in a Text or Memo field.

3416 |

3417 An action query cannot be used as a row source.

3418 Cannot open ‘|’. Another user has the table open using a different net-
work control file or locking style.

3419 Cannot open this Paradox 4.x or 5.x table because ParadoxNetStyle is
set to 3.x in the Windows Registry.

3420 Object invalid or no longer set.

3421 Data type conversion error.

3422 Cannot modify table structure. Another user has the table open.

3423 You cannot use ODBC to import from, export to, or link an external
Microsoft Jet or ISAM database table to your database.

3424 Cannot create database because the locale is invalid.

3425 This method or property is not currently available on this Recordset.
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3426 This action was cancelled by an associated object.

3427 Error in DAO automation.

3428 A problem occurred in your database. Correct the problem by repairing
and compacting the database.

3429 Incompatible version of an installable ISAM.

3430 While loading the Microsoft Excel installable ISAM, OLE was unable
to initialize.

3431 This is not a Microsoft Excel 5.0 file.

3432 Error opening a Microsoft Excel 5.0 file.

3433 Invalid setting in Excel key of the Engines section of the Windows
Registry.

3434 Cannot expand named range.

3435 Cannot delete spreadsheet cells.

3436 Failure creating file.

3437 Spreadsheet is full.

3438 The data being exported does not match the format described in the
Schema.ini file.

3439 You attempted to link or import a Microsoft Word mail merge file.
Although you can export such files, you cannot link or import them.

3440 An attempt was made to import or link an empty text file. To import or
link a text file, the file must contain data.

3441 Text file specification field separator matches decimal separator or text
delimiter.

3442 In the text file specification ‘|1’, the |2 option is invalid.

3443 The fixed width specification ‘|1’ contains no column widths.

3444 In the fixed width specification ‘|1’, column ‘|2’ does not specify a
width.

3445 Incorrect version of the DLL file ‘|’ was found.

3446 Jet VBA file (VBAJET.dll for 16-bit versions, or VBAJET32.dll for 32-
bit versions) is missing. Try reinstalling the application that returned
the error.

3447 The Jet VBA file (VBAJET.dll for 16-bit versions, or VBAJET32.dll
for 32-bit versions) failed to initialize when called. Try reinstalling the
application that returned the error.
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3448 A call to an OLE system function was not successful. Try reinstalling
the application that returned the error.

3449 No country code found in connection string for a linked table.

3450 Syntax error in query. Incomplete query clause.

3451 Illegal reference in query.

3452 You cannot make changes to the design of the database at this replica.

3453 You cannot establish or maintain an enforced relationship between a
replicated table and a local table.

3455 Cannot make the database replicable.

3456 Cannot make the |2 object in |1 container replicable.

3457 You cannot set the KeepLocal property for an object that is already
replicated.

3458 The KeepLocal property cannot be set on a database; it can be set only
on the objects in a database.

3459 After a database has been replicated, you cannot remove the replication
features from the database.

3460 The operation you attempted conflicts with an existing operation
involving this member of the replica set.

3461 The replication property you are attempting to set or delete is read-only
and cannot be changed.

3462 Failure to load a DLL.

3463 Cannot find the .dll ‘|2’.

3464 Data type mismatch in criteria expression.

3465 The disk drive you are attempting to access is unreadable.

3468 Access was denied while accessing dropbox folder ‘|2’.

3469 The disk for dropbox folder ‘|2’ is full.

3470 Disk failure accessing dropbox folder ‘|2’.

3471 Failure to write to the Synchronizer log file.

3472 Disk full for path ‘|1’.

3473 Disk failure while accessing log file ‘|1’.

3474 Cannot open the log file ‘|1’ for writing.

3475 Sharing violation while attempting to open log file ‘|1’ in Deny Write
mode.

3476 Invalid dropbox path ‘|2’.
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3477 Dropbox address ‘|2’ is syntactically invalid.

3478 The replica is not a partial replica.

3479 Cannot designate a partial replica as the Design Master for the replica
set.

3480 The relationship ‘|’ in the partial filter expression is invalid.

3481 The table name ‘|’ in the partial filter expression is invalid.

3482 The filter expression for the partial replica is invalid.

3483 The password supplied for the dropbox folder ‘|2’ is invalid.

3484 The password used by the Synchronizer to write to a destination drop-
box folder is invalid.

3485 The object cannot be replicated because the database is not replicated.

3486 You cannot add a second Replication ID AutoNumber field to a table.

3487 The database you are attempting to replicate cannot be converted.

3488 The value specified is not a ReplicaID for any member in the replica
set.

3489 The object specified cannot be replicated because it is missing a neces-
sary resource.

3490 Cannot create a new replica because the ‘|2’ object in ‘|1’ container
could not be replicated.

3491 The database must be opened in exclusive mode before it can be 
replicated.

3492 The synchronization failed because a design change could not be
applied to one of the replicas.

3493 Cannot set the specified Registry parameter for the Synchronizer.

3494 Unable to retrieve the specified Registry parameter for the
Synchronizer.

3495 There are no scheduled synchronization’s between the two
Synchronizers.

3496 Replication Manager cannot find the ExchangeID in the
MSysExchangeLog table.

3497 Unable to set a schedule for the Synchronizer.

3499 Cannot retrieve the full path information for a member of the replica
set.

3500 You cannot specify two different Synchronizers to manage the same
replica.
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3502 The Design Master or replica is not being managed by a Synchronizer.

3503 The Synchronizer’s Registry has no value set for the key you queried.

3504 The Synchronizer ID does not match an existing ID in the
MSysTranspAddress table.

3505 You attempted to delete or get information about a partial filter that
does not exist in MSysFilters.

3506 The Synchronizer is unable to open the Synchronizer log.

3507 Failure writing to the Synchronizer log.

3508 There is no active transport for the Synchronizer.

3509 Could not find a valid transport for this Synchronizer.

3510 The member of the replica set you are attempting to synchronize is cur-
rently being used in another synchronization.

3512 Failed to read the dropbox folder.

3513 Failed to write to the dropbox folder.

3514 Synchronizer could not find any scheduled or on-demand synchroniza-
tion’s to process.

3515 The Microsoft Jet database engine could not read the system clock on
your computer.

3516 Destination synchronizer is not configured to support indirect syn-
chronronization, and the destination replica is unavailable for direct
synchronization.

3517 Synchronizer could not find any messages to process.

3518 Could not find Synchronizer in the MSysTranspAddress table.

3519 Failed to send a message.

3520 The replica name or ID does not match a currently managed member
of the replica set.

3521 Two members of the replica set cannot be synchronized because there
is no common point to start the synchronization.

3522 Synchronizer cannot find the record of a specific synchronization in the
MSysExchangeLog table.

3523 Synchronizer cannot find a specific version number in the
MSysSchChange table.

3524 The history of design changes in the replica does not match the history
in the Design Master.

3525 Synchronizer could not access the message database.
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3526 The name selected for the system object is already in use.

3527 The Synchronizer or Replication Manager could not find the system
object.

3528 There is no new data in shared memory for the Synchronizer or
Replication Manager to read.

3529 The Synchronizer or Replication Manager found unread data in the
shared memory. The existing data will be overwritten.

3530 The Synchronizer is already serving a client.

3531 The wait period for an event has timed out.

3532 Synchronizer could not be initialized.

3533 The system object used by a process still exists after the process has
stopped.

3534 Synchronizer looked for a system event but did not find one to report
to the client.

3535 Client has asked the Synchronizer to terminate operation.

3536 Synchronizer received an invalid message for a member of the replica
set that it manages.

3537 The Synchronizer’s client is no longer present and cannot be notified.

3538 Cannot initialize Synchronizer because there are too many applications
running.

3539 A system error has occurred or your swap file has reached its limit.

3540 Your swap file has reached its limit or is corrupted.

3541 Synchronizer could not be shut down properly and is still active.

3542 Process stopped when attempting to terminate Synchronizer client.

3543 Synchronizer has not been set up.

3544 Synchronizer is already running.

3545 The two replicas you are attempting to synchronize are from different
replica sets.

3546 The type of synchronization you are attempting is not valid.

3547 Synchronizer could not find a replica from the correct set to complete
the synchronization.

3548 GUIDs do not match or the requested GUID could not be found.

3549 The file name you provided is too long.

3550 There is no index on the GUID column.
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3551 Unable to delete the specified Registry parameter for the Synchronizer.

3552 The size of the Registry parameter exceeds the maximum allowed.

3553 The GUID could not be created.

3555 All valid nicknames for replicas are already in use.

3556 Invalid path for destination dropbox folder.

3557 Invalid address for destination dropbox folder.

3558 Disk I/O error at destination dropbox folder.

3559 Failure to write because destination disk is full.

3560 The two members of the replica set you are attempting to synchronize
have the same ReplicaID.

3561 The two members of the replica set you are attempting to synchronize
are both Design Masters.

3562 Access denied at destination dropbox folder.

3563 Fatal error accessing a local dropbox folder.

3564 Synchronizer cannot find the source file for messages.

3565 There is a sharing violation in the source dropbox folder because the
message database is open in another application.

3566 Network I/O error.

3567 Message in dropbox folder belongs to the wrong Synchronizer.

3568 Synchronizer could not delete a file.

3569 This member of the replica set has been logically removed from the set
and is no longer available.

3570 The filters defining a partial replica have been changed. The partial
replica must be repopulated.

3571 The attempt to set a column in a partial replica violated a rule govern-
ing partial replicas.

3572 A disk I/O error occurred while reading or writing to the TEMP
directory.

3573 The directory you queried for a list of replicas is not a managed 
directory.

3574 The ReplicaID for this member of the replica set was reassigned during
a move or copy procedure.

3575 The disk drive you are attempting to write to is full.

3576 The database you are attempting to open is already in use by another
application.
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3577 Cannot update replication system column.

3578 Failure to replicate database; cannot determine whether the database is
open in exclusive mode.

3579 Could not create replication system tables needed to make the database
replicable.

3580 Could not add rows needed to make the database replicable.

3581 Cannot open replication system table ‘|’ because the table is already in
use.

3582 Cannot make a new replica because the |2 object in |1 container could
not be made replicable.

3583 Cannot make the |2 object in |1 container replicable.

3584 Insufficient memory to complete operation.

3585 Cannot replicate the table; the number of columns exceeds the maxi-
mum allowed.

3586 Syntax error in partial filter expression on table |1.

3587 Invalid expression in the ReplicaFilter property.

3588 Error when evaluating the partial filter expression.

3589 The partial filter expression contains an unknown function.

3590 Violates the rules for partial replicas.

3591 Log file path ‘|1’ is invalid.

3592 You cannot replicate a password-protected database or set password
protection on a replicated database.

3593 You cannot change the data master attribute for the replica set.

3594 You cannot change the data master attribute for the replica set. It
allows data changes only at the Design Master.

3595 The system tables in your replica are no longer reliable and the replica
should not be used.

3600 Aggregation expressions cannot use GUIDs.

3605 Synchronizing with a non-replicated database is not allowed. The ‘|’
database is not a Design Master or replica.

3607 The replication property you are attempting to delete is read-only and
cannot be removed.

3608 Record length is too long for an indexed Paradox table.

3609 No unique index found for the referenced field of the primary table.
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3610 Same table ‘|’ referenced as both the source and destination in make-
table query.

3611 Cannot execute data definition statements on linked data sources.

3612 Multi-level GROUP BY clause is not allowed in a subquery.

3613 Cannot create a relationship on linked ODBC tables.

3614 GUID not allowed in Find method criteria expression.

3615 Type mismatch in expression.

3616 Updating data in a linked table is not supported by this ISAM.

3617 Deleting data in a linked table is not supported by this ISAM.

3618 Exceptions table could not be created on import/export.

3619 Records could not be added to exceptions table.

3620 The connection for viewing your linked Microsoft Excel worksheet
was lost.

3621 Cannot change password on a shared open database.

3622 You must use the dbSeeChanges option with OpenRecordset when
accessing a SQL Server table that has an IDENTITY column.

3623 Cannot access the FoxPro 3.0 bound DBF file ‘|’.

3624 Could not read the record; currently locked by another user.

3625 The text file specification ‘|’ does not exist. You cannot import, export,
or link using the specification.

3626 The operation failed. There are too many indexes on table ‘|’. Delete
some of the indexes on the table and try the operation again.

3627 Cannot find the executable file for the Synchronizer (mstran40.exe).

3628 Partner replica is not managed by a Synchronizer.

3629 Synchronizer ‘|1’ is also using the same File System dropbox ‘|2’.

3630 Synchronizer ‘|1’ is also using the same File System dropbox ‘|2’.

3631 Invalid Table Name In Filter

3632 Internet Transport not enabled on the remote Synchronizer.

3633 Cannot load DLL: ‘|’

3634 Cannot create a replica using a partial replica.

3635 Cannot create partial replica of a system database.

3636 Cannot populate the replica or change the replica’s filter because the
replica has conflicts or data errors.
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3637 Cannot use the crosstab of a non-fixed column as a subquery.

3638 A Source Controlled database cannot be made replicable.

3639 Cannot create a replica of a System database.

3640 The fetch buffer was too small for the amount of data you requested.

3641 There are fewer records remaining in the recordset than you requested.

3642 A cancel was performed on the operation.

3643 One of the records in the recordset was deleted by another process.

3645 One of the binding parameters is incorrect.

3646 The specified row length is shorter than the sum of the column lengths.

3647 A column requested is not being returned to the recordset.

3648 Cannot synchronize a partial replica with another partial replica.

3649 The language-specific code page was not specified or could not be
found.

3650 Either the Internet is very slow or there is some problem in the replica-
tion manager setup on the internet server machine.

3651 Invalid internet address.

3652 Internet login failure.

3653 Internet not set up.

3654 Internal internet failure.

3655 The wininet.dll cannot be loaded or initialized.

3656 Error in evaluating a partial expression

3657 Error in evaluating the boolean filter expression for table ‘|1’.

3658 Binary column ‘|’ cannot be used in a boolean filter.

3659 Relationship ‘|1’ is unenforced. Relationship in a partial filter expres-
sion must be enforced.

3660 Requested exchange failed because ‘|1’.

3661 Requested exchange failed because ‘|1’

3663 This operation requires a different cursor library.

3664 An asynchronous OpenConnection call is not yet complete; you cannot
yet reference the returned connection object until it is complete.

3665 You cannot modify the replication system object ‘|’.

3666 You cannot modify the replication system object ‘|’.

3667 A different operation is preventing this operation from being executed.
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3668 Cannot perform this operation because there is no active connection.

3669 Execution cancelled.

3670 Cursor is not valid.

3671 Cannot find table to update.

3672 Failed to load RDOCURS.DLL.

3673 This table contains cells that are outside the range of cells defined in
this spreadsheet.

3674 Internet dll (wininet.dll) could not be found or loaded.

3675 Failure to read from an internet handle. Try the operation again.

3676 Failure to write to an internet handle. Try the operation again.

3677 Failure to execute the HTTP request to start internet synchronizer on
the internet server. Use Replication Manager to configure internet syn-
chronizer on the internet server.

3678 Failure to connect to the FTP service on the internet server. Make sure
that FTP service is running properly on the server and supports anony-
mous connections.

3679 Failure to do open file using FTP service. Make sure that FTP dropbox
has read permissions.

3680 Failure in getting a file from the server using FTP. Make sure that FTP
dropbox has read permissions.

3681 Failure in putting a file to the server using FTP. Make sure that FTP
dropbox has write permissions.

3682 Failure to delete a file on the server using FTP. Make sure that FTP
dropbox has read and write permissions.

3683 Internet synchronizer exited unexpectedly on the server. Look at the
partner replica exchange history on the internet server to figure out the
problem.

3684 There is no suitable replica with which to exchange.

3685 Invalid HTTP address.

3686 Invalid replica path or name.

3687 Invalid SQL syntax—expected token: Option.

3688 Invalid SQL syntax—expected token: For.

3689 Invalid SQL syntax—expected token: Privileges.

3690 Invalid SQL syntax—expected a table right/privilege.
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3691 Invalid SQL syntax—expected an object name.

3692 Invalid SQL syntax—related tokens did not match. Jet expected
GRANT…TO, REVOKE…FROM, ADD…TO, or DROP…FROM.

3693 Invalid SQL syntax—expected user or group name.

3694 Invalid SQL syntax—expected token: Grant.

3695 Invalid SQL syntax—GRANT/REVOKE syntax error.

3696 Invalid SQL syntax—expected token: User (or) Group.

3697 Invalid SQL syntax—expected token: Password.

3698 Invalid SQL syntax—expected password.

3699 Invalid SQL syntax—expected token: User.

3700 Invalid precision for decimal data type.

3701 Invalid scale for decimal data type.

3702 The width of a Unicode text column must be an even number of bytes.

3703 Operation not supported on replicable databases that have not been
converted to the current version.

3704 You attempted to open a database that is already opened by user ‘|2’ on
machine ‘|1’. Try again when the database is available.

3705 Cannot make the |2 table replicable—too many columns.

3706 Cannot make the |2 table replicable—too many indexes.

3707 The cascading options for the new reference conflict with existing ref-
erence ‘|’.

3708 Syntax error in Transaction statement. Expected TRANSACTION,
WORK, or nothing.

3709 The search key was not found in any record.

3710 MAPI folder or address book not found.

3711 Recovered replicable data. This row was recovered from a corrupted
replicable database. Verify that the record contents are correct and then
reinsert the record, or delete this conflict record.

3712 Other. This record was rejected due to an undefined replication conflict
problem.

3713 Update/update conflict. Another replica also updated this record. This
record lost the conflict. Either resubmit your update or delete this con-
flict record.
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3714 Locked table. This record could not be applied during synchronization
since the table was locked by another user. Resubmit this conflict
record.

3715 Unique key violation. This record has the same key value as another
record, whereas only unique values are permitted. Either change the
key value in this conflict record or the winning record and then resub-
mit this record, or delete this conflict record.

3716 TLV violation. This record contains a field value that does not meet the
table level validation constraint. Either update the field value that is
violating the validation rule and then resubmit this conflict record, or
delete this conflict record.

3717 Delete/RI conflict. The primary key record has been deleted by another
replica, therefore this referencing record has been rejected. Either cre-
ate a new primary key record that satisfies the referential integrity con-
straint and then resubmit your update, or delete this conflict record.

3718 Update/RI conflict. The primary key record has been updated by
another replica, therefore this referencing record has been rejected.
Either create a new primary key record that satisfies the referential
integrity constraint, modify the foreign key value in this conflict record
to match a valid primary key value and then resubmit your update, or
delete this conflict record.

3719 Foreign key violation resulting from an invalid primary key record that
was involved in a replication conflict. Either create a new primary key
record that satisfies the referential integrity constraint, modify the for-
eign key value in this conflict record to match a valid primary key
value and then resubmit this conflict record, or delete this conflict
record.

3720 Cannot change field ‘|’. It is part of one or more relationships.

3721 Invalid SQL syntax—expected constraint name.

3722 Invalid SQL syntax—expected token: DEFAULT.

3723 Invalid SQL syntax—expected token: COMPRESSION to follow
WITH.

3724 Invalid SQL syntax—expected token: UPDATE or DELETE.

3725 Invalid SQL syntax—expected token: CASCADE, SET NULL, or NO
ACTION.

3726 Invalid SQL syntax—expected token: NULL.
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3727 Invalid SQL syntax—only one update rule and/or one delete rule
allowed.

3728 Invalid SQL syntax—expected token: AS.

3729 Invalid SQL syntax—expected token: SELECT.

3730 VIEW cannot contain a parameter.

3731 The number of aliases specified shall be the same as the number of
output columns.

3732 Expected query name after EXECUTE.

3733 The database has been placed in a state by an unknown user that pre-
vents it from being opened or locked.

3734 The database has been placed in a state by user ‘|2’ on machine ‘|1’
that prevents it from being opened or locked.

3735 Too many columns in inverted index.

3736 Update/delete conflict. This updated record was deleted at another
replica. Either reinsert this conflict record or delete it.

3737 Cannot create this type of replica from the given source replica.

3738 Local or Anonymous replicas must synch only to their designated hub
replica.

3739 The proxy replica has been removed.

3740 Cannot add a new column to conflict table ‘|’. Delete obsolete columns
and compact the database.

3741 Invalid partner synchronizer. Local or anonymous replica must syn-
chronize with designated hub replica.

3742 An internet function timed out.

3743 Replica has not been synchronized within the replica set retention
period.

3744 Counter columns in replicable tables cannot be modified.

3745 The combined length of Internet Server Name, HTTP Share name, and
FTP alias name should not be greater than 252 characters.

3746 Syntax error in parameters clause. Make sure the parameter exists and
that you typed its value correctly.

3747 Parameter has no default value.

3748 Parameter | has no default value.

3749 The object is not a stored procedure.
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3750 Object | is not a stored procedure.

3751 Requested row locking, but DB is in page lock mode.

3752 Requested page locking, but DB is in row lock mode.

3753 Cannot create replica of a Jet SQL replica.

3754 Cannot delete from a Prevent Deletes Replica.

3755 CHECK constraint ‘|’ does not exist.

3756 CHECK constraint ‘|’ already exists.

3757 The Jet sorting DLLs could not be loaded properly.

3758 Scaling of decimal value resulted in data truncation.

3759 Scaling of decimal value resulted in data truncation.

3760 Scaling of decimal value resulted in data overflow.

3761 The decimal field’s precision is too small to accept the numeric you
attempted to add.

3762 Invalid SQL syntax - expected token: ACTION.

3763 Concurrent schema changes caused the create replica operation to fail.
Try again.

3764 Failed to re-create one or more indexes.

3765 Syntax error in CHECK constraint clause.

3766 Only simple SELECT queries are allowed in VIEWS.

3767 Table ‘|’ could not be made replicable because it could not be opened
exclusively.

3768 FastFind cannot search on non-column references.

3769 Conflict tables cannot be renamed.

3770 Counter definition not in valid range.

3771 Local or Anonymous replicas cannot be made the design master.

3772 Without Administer permission, replica priority must be in the range
0–|.

3773 Cannot delete one or more objects: |.

3774 Pin value is not valid.

3775 Unable to load Jet SQL Server Reconciler—MSRPJT40.dll.

3776 Unable to exchange between two Jet SQL Server Replicas.

3777 Illegal Operation performed on a Jet SQL Server Replica.

3778 The Jet database is wrong or missing for this SQL/Jet replica set.
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3779 Unable to change Column Level Tracking Property on objects that are
already Replicable.

3780 Invalid SQL syntax—expected a view name.

3781 Invalid SQL syntax—expected a procedure name.

3782 Invalid SQL syntax—currently only one column-level CHECK con-
straint is allowed.

3783 Invalid SQL syntax—cannot use multiple columns in a column-level
CHECK constraint.

3784 Database is already replicable.

3785 Invalid SQL syntax—expected token: Database.

3786 Invalid SQL syntax—expected a database privilege, such as CREAT-
EDB or CONNECT.

3787 This operation is not allowed in subqueries.

3788 Cannot create an index on this MAPI folder/addressbook.

3789 Illegal column-level constraint.

3790 This object requires a newer version of the Microsoft Jet database
engine.

3791 This index requires Microsoft Jet database engine |.

3792 The index ‘|2’ requires Microsoft Jet database engine |1.

3793 The column ‘|2’ requires Microsoft Jet database engine |1.

3794 This table requires Microsoft Jet database engine |.

3795 The table ‘|2’ requires Microsoft Jet database engine |1.

3796 The version of MSRECR40.DLL that was loaded was too old. Run
setup again to get the correct version of this file.

3797 The SQL/Jet exchange failed, look in the SQLServer Agent history for
details.

3798 CHECK constraints are not allowed on replicable databases.

3799 Could not find field ‘|’.

3800 ‘|’ is not an index in this table.

3801 The object (|) cannot be used in a CHECK constraint clause.

3802 Error evaluating | CHECK constraint. |

3803 DDL cannot be completed on this table because it is referenced by
constraint | on table |.
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3804 There are no MAPI clients installed on this machine. Install a MAPI
client (like Outlook) on this machine.

3805 CHECK constraints on table | will not be transferred to this table.
CHECK constraints can only be created via SQL DDL statements.

3806 Cannot set multiple NULL, NOT NULL attributes.

3807 Query | contains an ambiguous column name that is conflicting with
the correlation (alias) name |. Either fully qualify the column name or
change the correlation (alias) name.

6000 Errors were encountered during the save operation.

6001 A form or report cannot be the subdatasheet of a table or query. Only a
table or query can be inserted into another table or query.

6002 Microsoft Access cannot expand this subdatasheet because all of the
records are locked. The RecordLocks property of the form or report or
the Default Record Locking option on the Advanced tab of the Options
dialog box (Tools menu) is set to All Records. Reset the value to No
Locks or Edited Record as appropriate.

6003 The setting for the Precision property must be from 1 through 28.

6004 The setting for the Scale property must be from 0 through 28.

6005 The table or query name ‘|’ you entered in either the property sheet or
macro is misspelled or refers to a table or query that doesn’t exist. If
the invalid name is in a macro, an Action Failed dialog box will display
the macro name and the macro’s arguments after you click OK. Open
the Macro window, and enter the correct name.

6006 Filter by selection of a partial value is only supported for fields con-
taining character data.

6007 Cannot open a form bound to a stored procedure in server filter by
form mode.

6008 Microsoft Access encountered an error closing your connection. Please
close all of your application windows before trying again.

6009 Invalid connection string. You may need to specify a valid connection
string and try it again.

6010 Invalid use of Move method. The Move method is not applicable to
subforms or subreports.

6011 Do you want to save the data changes on form ‘|’?

6012 Microsoft Access can’t set this property to No right now. You cannot
set the Allow Form View, Allow Datasheet View, Allow PivotTable
View, and Allow PivotChart View properties to No at the same time.
Set one of the other properties to Yes before changing this one to No.

Appendixes for Web Site

PART VI
100



ErrorCode ErrorString

6013 Unable to remove item. ‘|’ not found in list.

6014 The RowSourceType property must be set to ‘Value List’ to use this
method.

6015 Can’t add this item. The index is too large.

6016 Microsoft Access is unable to switch to PivotTable or PivotChart view
right now. You must set the Record Source property of the form before
attempting to PivotTable or PivotChart view.

6017 Microsoft Access doesn’t support the requested property for this type
of database object. The DateCreated and DateModified properties are
not supported for Tables, Queries, Stored Procedures, Database
Diagrams, and Functions in a Client Server database.

6018 The form or report template is open in Design view. Before creating a
new form or report, close the corresponding template.

6019 You must save new or dirty objects in the database before you can save
them to this external format.

6020 This format does not support objects named ‘Schema’. Rename the
object and try again.

6021 You cannot create a form with AutoForm or a report with AutoReport
by using a scalar function; you can use a table, view, stored procedure,
inline function, or table function.

6022 This option cannot be changed in an Access Project file.

6023 The Maximum Record Count setting cannot be a negative number.

6024 The Maximum Record Count setting cannot contain text—please enter
a number.

6025 The Requery action cannot be used on a control bound to a Recordset.

6026 The RowSourceType property must be set to ‘Table/Query’ to use this
method.

6027 You can’t save or undo the record at this time. The form’s
BatchUpdates property is set to Yes, but the form is not bound to a
record source. Either set the form’s BatchUpdates property to No, or
bind the form to a record source by setting a value in the RecordSource
property.

6028 The OLE object failed to persist itself. You will not be able to undo
this operation.

7700 Microsoft Access is unable to complete the operation. Try the opera-
tion again. If the error persists, restart Microsoft Access.
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7701 Microsoft Access can’t synchronize with Synchronizer ‘|1.’ A possible
reason for the failure to synchronize with ‘|1’ is that both the
Synchronizer and Microsoft Access were trying to write to the current
database at the same time. Try synchronizing with ‘|1’ again. Do you
want to continue synchronizing with the remaining Synchronizers?

7702 The user-supplied function named ‘|’, the program to assist you in
resolving conflicts, could not be found. Contact the author of this cus-
tomized database application.

7703 There are no synchronization conflicts to resolve.

7704 You can’t modify the design of ‘|’ at a replica. Design changes to repli-
cated objects can be made only at the Design Master. Do you want to
open it as read-only?

7705 This member of the replica set has conflicts from synchronizing
changes with other members. Do you want to resolve these conflicts
now?

7706 This member of the replica set has errors from synchronizing changes
with another member. Do you want to see the errors now?

7707 This member of the replica set has both errors and conflicts from syn-
chronizing changes with another member. Do you want to see the
errors and resolve the conflicts now?

7708 ‘|1’ was the last designated Design Master for the replica set. Has ‘|2’
been moved, renamed, deleted, or corrupted? You should never have
more than one Design Master for each replica set. Having more than
one Design Master in a replica set prevents the members of the set
from synchronizing correctly. Use Windows Explorer to determine
whether the file has been moved or deleted. Open the file to determine
whether it has been corrupted.

7709 To make this replica the Design Master for the replica set, point to
Replication on the Tools menu, click Synchronize Now, enter the path
to ‘|’ (the current Design Master), and select the Make…The Design
Master check box.

7710 To make this replica the Design Master for the replica set, first syn-
chronize this replica with all other replicas in the set. This ensures that
this replica includes all design changes made at the previous Design
Master. If you have already synchronized this replica, do you want to
make it the Design Master?

7711 This member of the replica set is now the Design Master. Microsoft
Access will now close and reopen the database in order for the changes
to take effect.
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7712 This member of the replica set has exceeded the maximum number of
days allowed between synchronizations and can’t be synchronized with
any other member of the replica set. Delete this replica set member and
create a new replica.

7713 This member of the replica set will expire in | days because it hasn’t
been synchronized with another member of the replica set. If the mem-
ber is allowed to expire, it can no longer be synchronized with any
other member of the replica set. Synchronize with another member as
soon as possible. To synchronize, point to Replication on the Tools
menu, and click Synchronize Now.

7714 Microsoft Access cannot close the database at this time. Make sure
there is no Visual Basic code executing in the current database. You
may need to run Setup again to properly install Briefcase Replication.

7715 Microsoft Access cannot complete this operation because it can’t find
or initialize the dynamic-link library Msrclr40. Rerun Microsoft Access
or Microsoft Office Setup again to reinstall Microsoft Briefcase
Replication. During Setup, click Add/Remove, and select Microsoft
Briefcase Replication. If you want to preserve your security or custom
settings, back up the Microsoft Access workgroup information file. For
information on backing up files, search the Microsoft Windows Help
index for ‘backing up files’.

7716 The database must be closed prior to synchronization. Do you want
Microsoft Access to close the database and synchronize with ‘|’?

7717 All open objects must be closed before synchronizing. Do you want
Microsoft Access to close the objects?

7718 Microsoft Access can’t synchronize this member of the replica set
because one or more objects are open. Because synchronizing may
involve updating the data in or design of the database, all objects must
be closed before you synchronize. Close all objects and try again.

7719 You can’t save design changes to ‘|’ at a replica. Design changes to
replicated objects can be made only at the Design Master.

7720 You can’t save design changes to ‘|1’ at a replica. Design changes to
replicated objects can be made only at the Design Master. Do you want
to save it as a new, local object?

7721 You can’t delete or rename ‘|’ at a replica. These operations can’t be
performed on a replica; they can be performed only at the Design
Master.
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7722 All open objects must be closed before creating a replica. Do you want
Microsoft Access to close the objects?

7723 Microsoft Access couldn’t close one or more objects. Close all objects
manually and try again.

7724 Microsoft Access has converted ‘|1’ to the Design Master for the
replica set. Only the Design Master can accept changes to the database
structure; however, data changes can be made at the Design Master or
any replica.

7725 Microsoft Access has converted ‘|1’ to the Design Master for the
replica set and has created a replica at ‘|2’. Only the Design Master can
accept changes to the database structure; however, data changes can be
made at the Design Master or any replica.

7726 Microsoft Access has created a replica at ‘|2’.

7727 Microsoft Access can’t create a replica because this database is already
open in exclusive mode. Do you want Microsoft Access to close the
database?

7728 Microsoft Access can’t overwrite ‘|’: the replica can’t be created at this
location. The file you are trying to overwrite may be open. Close any
other applications that might be using this file.

7729 Microsoft Access can’t make a new replica at ‘|’ because the source has
the same path and file name. Choose a different path or file name for
the new replica.

7730 The synchronization was completed successfully.

7731 Microsoft Access can’t synchronize this member of the replica set
because it is open in exclusive mode. To open the database in shared
mode, close the database, click Open Database on the File menu, and
clear the Exclusive check box. Then select the database.

7732 ‘|’ is saved as a local table. Changes made to it won’t be sent to the
replicas in the set. To make this table available to other members of the
replica set, close the table, select it in the Database window, click
Properties on the View menu, and then select the Replicated check box.

7733 The synchronization request has been received, and the Synchronizer
will complete the process as resources become available. Make sure
that the Synchronizer for this member of the replica set is running. It
may be several minutes before the synchronization will occur.

7734 Microsoft Access has saved the design of table ‘|,’ but it will not be
made replicable until the Table window is closed.
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7735 Changes to this object can be made only at the Design Master. Any
changes you make will be discarded when the form is closed. To save
your changes, click Save As on the File menu and save the object
under a different name.

7736 Microsoft Access has deleted ‘|’ and removed it from the replica set.
This change isn’t reflected until the database is closed and reopened.
Do you want Microsoft Access to close and reopen the database now?

7737 Microsoft Access has converted ‘|1’ to the Design Master for the
replica set and has created a replica at ‘|2’. The new replica will not
appear in the list of potential synchronization partners until this data-
base is closed and reopened. Do you want Microsoft Access to close
and reopen the database now?

7738 Microsoft Access has successfully created a replica at ‘|2’. However,
the new replica will not appear in the list of potential synchronization
partners until this database is closed and reopened. Do you want
Microsoft Access to close and reopen the database now?

7739 Microsoft Access has deleted ‘|’ and removed it from the replica set.
This change isn’t reflected until the database is closed and reopened.
Please close and reopen the database when you are finished synchro-
nizing replicas.

7740 Microsoft Access cannot synchronize with a database from a previous
version. Convert the database you are trying to synchronize with,
before synchronizing.

7741 Microsoft Access can’t make a new replica at ‘|’ because the value
entered for priority is out of range. Priority for new replicas should be
in the range of 0-100.

7742 Microsoft Access can’t make a password-protected database replicable

7743 Backup, restore, and drop database operations are only available for
Microsoft SQL Server version 7.0 or later running on your local com-
puter.

7744 Microsoft Access can’t make a new replica at ‘|’ because the value
entered for priority is out of range. Priority for anonymous replicas
should be 0.

7745 You can’t copy local objects in a replica. Design changes to replicated
objects can be made only at the Design Master.

7746 The Database administrative components failed to load or initialize.
Verify that the components are installed and registered locally.
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7747 Database Replicas cannot be converted to prior versions of Microsoft
Access.

7748 This stage of the conversion process is finished. To complete the con-
version process, synchronize this replica to the (converted) Design
Master.

7749 Open the Design Master and sync to this replica before opening.

7750 In Datasheet view, you can’t set a control property if the control is part
of an option group.

7751 In Design view, you can’t retrieve the value of the ObjectPalette prop-
erty for an OLE object contained in a bound object frame. Microsoft
Access doesn’t display the OLE object in the object frame in Design
view. Remove the reference to the ObjectPalette property, or switch to
Form view before you run the macro or Visual Basic code that refer-
ences the ObjectPalette property.

7752 Microsoft Access can’t apply the filter because all the records are
locked. The RecordLocks property of the form or report or the Default
Record Locking option on the Advanced tab of the Options dialog box
(Tools menu) is set to All Records. Reset the value to No Locks or
Edited Record as appropriate.

7753 |

7754 You can’t move columns between two frozen columns in a datasheet.
To unfreeze all columns, click Unfreeze All Columns on the Format
menu.

7755 Microsoft Access can’t start the Chart Wizard. The wizard may not be
installed, or this wizard has been disabled. To install the Chart Wizard,
rerun the Microsoft Access or Microsoft Office Setup program, click
Add/Remove, and then select the Wizards check box. To reenable this
wizard, click About Microsoft Access on the Help menu, and then click
the Disabled Items button to view a list of addins which you can
enable.

7756 The form can’t display the What’s This button if the Minimize button
or the Maximize button is displayed. Set the WhatsThisButton property
to No, or set the MinMaxButtons property to None.

7757 The form can’t display the Minimize button or the Maximize button if
the What’s This button is displayed.

7758 This ActiveX control isn’t enabled in Form view. You can’t set the
Enabled or TabStop properties to True.
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7759 This ActiveX control isn’t visible in Form view. You can’t set the
Visible or TabStop properties to True.

7760 This property is locked and can’t be changed.

7761 An error occurred when you changed the control.

7762 The pattern string is invalid.

7763 This feature isn’t installed, or has been disabled. To install this feature,
rerun the Microsoft Access or Microsoft Office Setup program or, if
you’re using a third-party add-in, reinstall the add-in. To reenable this
wizard, click About Microsoft Access on the Help menu, and then click
the Disabled Items button to view a list of addins which you can
enable.

7764 This feature isn’t installed, or has been disabled. To install this feature,
rerun the Microsoft Access or Microsoft Office Setup program, click
Add/Remove, and then select the Wizards check box. To reenable this
wizard, click About Microsoft Access on the Help menu, and then click
the Disabled Items button to view a list of addins which you can
enable.

7765 This feature isn’t installed, or has been disabled. To install this feature,
rerun the Microsoft Access or Microsoft Office Setup program, click
Add/Remove, and then click the Additional Wizards check box. To
reenable this wizard, click About Microsoft Access on the Help menu,
and then click the Disabled Items button to view a list of addins which
you can enable.

7766 This control can’t be changed to the type you requested.

7767 An error occurred while Microsoft Access was creating a section.

7768 In order to change data through this form, the focus must be in a bound
field that can be modified.

7769 The filter operation was canceled. The filter would be too long.

7770 Microsoft Access didn’t apply the filter. Microsoft Access may not be
able to apply the filter if you entered an invalid data type in one of the
fields. Do you want to close the filter anyway? If you click Yes,
Microsoft Access will build the filter, but won’t apply it to the record-
set. Then it will close the Filter By Form window.

7771 You can’t set the ColumnOrder property when you are in Form view or
Print Preview.
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7773 Microsoft Access can’t set the LimitToList property to No right now.
The first visible column, which is determined by the ColumnWidths
property, isn’t equal to the bound column. Adjust the ColumnWidths
property first, and then set the LimitToList property.

7774 You can’t set the MenuBar property while an OLE object is in-place
active.

7775 There are too many controls on the form to allow Filter By Form.

7777 You’ve used the ListIndex property incorrectly.

7778 You can’t save an object when you are in the Filter By Form window.
Switch to Form view, and then save the object.

7779 You can’t set a form’s MenuBar property from its menu bar macro.
Right-click the Form selector button (located to the left of the horizon-
tal ruler) on the form in Design view. Click Properties, click the Other
tab, and then set the MenuBar property.

7780 You’re trying to insert into a section that can’t grow enough for the
control you’re trying to add. The maximum total height for all sections
in a report, including the section headers, is 200 inches (508 cm).
Remove, or reduce the height of, at least one section. Then try to add
the control again.

7782 You can’t create a new instance of this form or report while it is in
Design view.

7784 This form or report is already being designed as a subform or subre-
port. To open this form in Design view, select the subform or subreport
and click Subform in New Window on the View menu.

7785 Microsoft Access didn’t build the filter. There is an error in the current
field. Do you want to close the filter anyway? If you click Yes,
Microsoft Access will undo the changes to the filter, and then close the
Filter By Form window.

7788 Compile error.

7789 Type mismatch.

7790 Microsoft Access can’t create the |1. Either there was an error getting
information from the table or query you selected, or a new |2 could not
be created.

7791 There was an error creating your |1. Some fields may have been
skipped because there was an error getting information about them or
because they didn’t fit on the |2.
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7792 You can’t open a subform when it is also open in Design view.

7793 You must save the form ‘|’ before you can embed it.

7794 Microsoft Access couldn’t find the toolbar ‘|’.

7795 The custom toolbar ‘|’ is the wrong type (menu, shortcut menu, or tool-
bar) for the property it’s being used in.

7796 The process failed because there is no printer installed. Because
Microsoft Access saves the printer settings with each form or report, a
printer is needed to convert, enable, copy and paste, import, or export
your forms or reports. To install a printer, point to Settings on the
Windows Start menu, click Printers, and then double-click Add Printer.
Follow the instructions in the wizard.

7797 You must save new objects in the database before you can save them to
this external format.

7798 You can only save select, crosstab, and union queries to this format.

7799 This form or report is based on a query that exceeds the limit for data
in a single record. Exclude any unnecessary fields from the query, or
change some of the field types to Memo in the original tables.

7800 You can’t create a Microsoft Access MDE database from a database in
an old format. Close the database and convert it to the current version
of Microsoft Access. Then create the MDE database.

7801 This database is in an unrecognized format. The database may have
been created with a later version of Microsoft Access than the one you
are using. Upgrade your version of Microsoft Access to the current
one, then open this database.

7802 That command isn’t available in an MDE/ADE database.

7803 Microsoft Access can’t rename |1 to |2. The convert operation failed.

7805 This is already an MDE database.

7806 This database does not have a Visual Basic project, so it can’t be made
into an MDE file. Open the database in Microsoft Access to create the
Visual Basic project.

7807 You can’t make the open database into an MDE file while running a
macro or Visual Basic code. Instead of using a macro or code, on the
Tools menu, point to Database Utilities, and then click Make MDE
File.

7808 Microsoft Access can’t replace an existing file as a result of converting
the Microsoft Access database. You must select a new file name.
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7809 You can’t rename a | object in the client/server version of Microsoft
Access.

7810 You can’t compact the open database while running a macro or Visual
Basic code. Instead of using a macro or code, on the Tools menu, point
to Database Utilities, and then click Compact/Repair Database.

7811 Microsoft Access requires Microsoft SQL Server 6.5 or later for
Access projects. You need to upgrade the selected SQL database to
Microsoft SQL Server 6.5 or later.

7812 Microsoft Access projects can only be connected to Microsoft SQL
Server

7813 Restoring a database requires that no one is currently using the data-
base. Do you want to close all objects, select a backup file, and restore
the database from backup?

7814 Dropping a database requires that no one is currently using the data-
base. Do you want to close all open objects and drop the database?

7815 Microsoft Access was unable to create an ADE database.

7816 Microsoft Access requires this Microsoft SQL Server 6.5 installation to
be upgraded to service pack 5 in order to successfully connect to this
server.

7817 The database file ‘|’ is already open. You cannot encrypt to an open file.

7818 Microsoft Access was unable to create the Database window. Please
upgrade to a newer version of Microsoft Internet Explorer.

7819 You have chosen a database template file that is not supported in the
current version of Microsoft Access. To create a database using the
Database Wizard, click the Databases tab in the New dialog box and
then double-click a database icon.

7820 Microsoft Access no longer supports Pages as startup documents.

7821 The TEMP environment variable isn’t defined. Microsoft Access can’t
find the temporary file directory.

7822 Microsoft Access can’t initialize the transfer object. Make sure you
have Microsoft SQL Server or the Microsoft SQL Server Desktop
Engine installed on the local machine.

7823 The source or destination database name is missing. The transfer
operation can’t continue.

7824 The source or destination server name is missing. The transfer
operation can’t continue.

Appendixes for Web Site

PART VI
110



ErrorCode ErrorString

7825 Microsoft Access can’t find the server ‘|’.

7826 The database object type isn’t supported by the Microsoft Access
transfer operation.

7827 The current database ‘|1’ has |2 active connections. Microsoft Access
must disconnect all applications before you can copy the database file.
What do you want to do to all the active connections?

7828 The object ‘|’ is not a valid Microsoft SQL Server database object.
Microsoft Access can’t transfer this object.

7829 The SQL script used to create database objects is corrupted. Microsoft
Access can’t create the new objects.

7830 The SQL script used to create database object ‘|’ is corrupted.
Microsoft Access can’t create the new object.

7831 Microsoft Access can’t create the file ‘|’.

7832 The current database ‘|’ is replicated and can’t be copied until you dis-
able replication. Use Microsoft SQL Server Enterprise Manager to
remove publications and subscriptions before copying the database file.

7833 The current database ‘|’ has more than one data file and can’t be
copied.

7834 The Transfer Database Wizard didn’t provide enough information to
perform the transfer operation.

7835 Microsoft Access can’t copy the database file because one or more
objects are open. Do you want to close all the objects?

7836 Microsoft Access can’t copy the database file because one or more
objects are open. Close all objects and try again.

7837 Invalid argument in script.

7838 There were errors during the database transfer operation. Open the
transfer log file for details.

7839 Errors occurred during the database transfer operation.

7840 The database transfer operation failed. The destination database ‘|’ was
created and is in an unknown state. What would you like to do with the
destination database?

7841 The destination file ‘|’ already exists. Set the Overwrite flag to TRUE if
you want to replace the existing file.

7842 This operation requires Microsoft SQL Server version 7.0 or later on
your local computer. You can install Microsoft SQL Server 2000
Desktop Engine from the MSDE2000 folder on the Microsoft Office
2002 CD-ROM.
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7843 You can only copy the database file when the current database is on
your local computer. If you want to make a copy of a database on a
remote server point to Database Utilities on the Tools menu, and then
click Transfer Database.

7844 Microsoft Access can’t copy the database file because there are active
connections to the current database.

7845 |

7846 Microsoft Access can’t compact and repair the current database.

7847 ‘|’ already exists. Microsoft Access must create a backup of your file
before performing the repair operation. Enter a name for the backup
file.

7848 The transfer operation has been cancelled. The destination database ‘|’
was created and is in an unknown state. What would you like to do
with the destination database?

7849 The repair operation has been cancelled because Microsoft Access
couldn’t create a backup of the file. You might not have adequate per-
missions or enough disk space to create the backup file. To repair the
file manually, point to Database Utilities on the Tools menu, and then
click Compact and Repair Database.

7850 Microsoft Access can’t find the wizard, or the wizard has not been
installed, or there is a syntax error in the Declarations section of a
Visual Basic module.

The wizard you need may be missing from the Libraries key of the
Microsoft Access section of the Windows Registry, or the wizard has
been disabled. To make sure that the wizard is in the Windows
Registry, run Setup to reinstall Microsoft Access, and then compile all
Visual Basic modules in the database. To reenable this wizard, click
About Microsoft Access on the Help menu, and then click the Disabled
Items button to view a list of addins which you can enable.

7851 The toolbar name ‘|’ you entered already exists. Enter a unique name
for this toolbar.

7852 The toolbar name ‘|’ you entered doesn’t follow Microsoft Access
object-naming rules. For more information about naming objects, click
Help.

7853 The default column width must be at least 0.1 inch.

7854 You can’t export database objects (except tables) from the current
version of Microsoft Access to earlier versions of Microsoft Access.
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7855 You must have a database open to create custom toolbars, and the data-
base can’t be read-only.

7856 ‘|’ cannot be imported, exported, or copied to Access project files.

7858 The Tab Width setting in the Options dialog box (Tools menu) for the
Module or Debug window must be from 1 through 32.

7859 Microsoft Access can’t start because there is no license for it on this
machine.

7860 The profile ‘|’ that you specified on the command line doesn’t exist in
the Windows Registry.

7861 ‘|’ cannot be imported, exported, or copied to Access database files.

7862 Microsoft Access can’t find the wizard. This wizard has not been
installed, or there is an incorrect setting in the Windows Registry, or
this wizard has been disabled. To reenable this wizard, click About
Microsoft Access on the Help menu, and then click the Disabled Items
button to view a list of addins which you can enable. Rerun Microsoft
Access or Microsoft Office Setup to reinstall the wizards. If the miss-
ing wizard is not a Microsoft Access wizard, reinstall it using the Add-
in Manager.

7863 Links can only be created between Microsoft Access database files.

7864 Microsoft Access doesn’t allow empty strings.

7865 There is already an existing database with the name you entered. Give
the new database a unique name.

7866 Microsoft Access can’t open the database because it is missing, or
opened exclusively by another user.

7867 You already have the database open.

7868 You can’t use a SetMenuItem macro action on a default menu.
SetMenuItem is for custom menus only.

7869 The SetMenuItem action does not have enough information to be car-
ried out. An argument is invalid, or there are not enough arguments.

7870 Microsoft Access can’t find the database ‘|.’ Check the database name
(and path, if specified) to make sure you entered it correctly.

7871 The table name you entered doesn’t follow Microsoft Access object-
naming rules. For more information about naming objects, click Help.

7872 This recordset is not updateable.

7873 ‘|’ cannot be imported, exported, or copied to another database or pro-
ject file.
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7874 Microsoft Access can’t find the object ‘|.’

• You misspelled the object name. Check for missing underscores ( _ )
or other punctuation, and make sure you didn’t enter leading spaces.

• You tried to open a linked table, but the file containing the table isn’t
on the path you specified. Use the Linked Table Manager to update
the link and point to the correct path.

7875 The table ‘|’ already exists. You created or renamed a table, and then
tried to save it. Before Microsoft Access could save the table, another
user created or renamed one using the same name.

7876 There isn’t enough temporary disk space to complete the operation.
Free disk space, and then try the operation again. For more information
on freeing temporary disk space, search the Microsoft Windows Help
index for ‘disk space, freeing’. For information on compacting a data-
base to free disk space, click Help.

7877 Microsoft Access can’t sort on the Memo, OLE Object, or Hyperlink
‘|’. The ORDER BY clause of an SQL statement can’t include any
Memo, OLE Object, or Hyperlink fields.

7878 The data has been changed. Another user edited this record and saved
the changes before you attempted to save your changes. Re-edit the
record.

7879 An invalid IDA has been passed to Microsoft Access error handling.
Please report this error and the steps that caused it.

7880 The value you entered is the wrong data type for this field. Enter an
integer.

7881 The Macro Conversion Wizard can’t be started. This wizard may not be
installed, or this wizard has been disabled. To reenable this wizard,
click About Microsoft Access on the Help menu, and then click the
Disabled Items button to view a list of addins which you can enable.
Rerun Microsoft Access or Microsoft Office Setup to reinstall this wiz-
ard. If you want to preserve your security or custom settings, back up
the Microsoft Access workgroup information file. For more informa-
tion on backing up files, search the Microsoft Windows Help index for
‘backing up files’.

7882 You can’t convert, enable, or encrypt an Access Project file.

7883 You can’t set the MenuBar property unless a database is open.

7884 You can’t export an object to itself. Select a different database to
export to, or give the object a new name.
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7885 The source database has no import/export specifications to copy.

7886 Microsoft Access can’t find the dynamic-link library (DLL) Mso.
Rerun the Microsoft Access or Microsoft Office Setup program.

7887 A unique record identifier can’t consist of more than 10 fields.

7888 You must set the default font size to a number from |1 through |2. For
more information on the FontSize property, click Help.

7889 The file ‘|’ does not exist.

7890 The file ‘|’ doesn’t contain any data. You can’t import from, or link to,
an empty spreadsheet.

7891 This database is read-only. The conditional compilation argument
option can’t be saved.

7892 An error occurred while saving module options. You may be running
Visual Basic in break mode. Reset the running code before changing
the module options.

7893 You can’t import objects into a database created in an earlier version of
Microsoft Access. Convert the database to the current version of
Microsoft Access using the Convert Database command (Tools menu,
Database Utilities submenu).

7895 Microsoft Access was unable to create a window. The system is out of
resources or memory. Close unneeded programs and try again. For
more information on freeing memory, search the Microsoft Windows
Help index for ‘memory, troubleshooting’.

7896 Error ‘|’ in the validation rule.

7897 Error ‘|’ in the default value.

7898 Execution of this application has stopped due to a run-time error. The
application can’t continue and will be shut down.

7899 Microsoft Access can’t be started. Microsoft Access was unable to ini-
tialize the Windows Registry. Rerun Microsoft Access or Microsoft
Office Setup to reinstall Microsoft Access.

7900 Microsoft Access can’t convert the database because it can’t create an
error table.

7901 Microsoft Access can’t convert the database because it can’t write to
the error table.

7902 Errors occurred converting |1 validation rules and default values. See
error table ‘|2’ for a list of errors.

Access 2002 and Jet 4 Errors

APPENDIX E

E

A
C

C
ESS

2002
A

N
D

JET
4

E
R

R
O

R
S

115



ErrorCode ErrorString

7903 Microsoft Access can’t insert this field. There are too many fields in
the table. The limit is 255.

7904 An error occurred in the Field Builder. You’ve replaced or modified the
default Field Builder, and Microsoft Access is unable to run the new
version. Reinstall Microsoft Access to correct the error.

7905 Microsoft Access can’t change these field data types. Some data in this
table violates the record validation rule. Before any data types can be
changed, remove the record validation rule or correct the data.

7906 Microsoft Access couldn’t launch the Lookup Wizard, or this wizard
has been disabled. Rerun the Microsoft Access or Microsoft Office
Setup program, click Add/Remove, and select the Wizards check box.
To reenable this wizard, click About Microsoft Access on the Help
menu, and then click the Disabled Items button to view a list of addins
which you can enable.

7907 You don’t have permission to modify the design of this table. For more
information on permissions and who can set them, click Help.

7908 You can’t modify this table now because someone else is using it.

7909 Microsoft Access can’t add another column to this table. You can have
up to 255 columns in your table.

7910 Microsoft Access can’t delete this column. Tables must have at least
one column.

7911 Microsoft Access can’t delete this index. This table participates in one
or more relationships. Delete its relationships in the Relationships win-
dow first.

7912 Once you save the change to the data type of this column, you will not
be able to change back to the previous data type. Are you sure you
want change the data type?

7913 You can’t change a random-valued AutoNumber field to an incremental
AutoNumber field. The values of random-valued AutoNumber fields
aren’t continuous.

7914 You can’t convert ReplicationID values to other data types.

7915 You can’t delete the field ‘|’; it is a replication system field. Use a
make-table query to create a new table that contains all the fields in the
table except system fields. For information on make-table queries, click
Help.

7916 Microsoft Access is unable to start the Lookup Wizard. The Lookup
Wizard doesn’t apply to fields of this data type.
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7917 ‘|’ cannot be created due to the project being disconnected. Use the
Connection… command under the File menu to connect the project to
a database.

7918 The Object Name argument for the ‘Save’ macro action is not sup-
ported within an Access Project for Table or Query objects. You cannot
save these objects with a new name in an Access Project.

7919 The default data type you selected is not supported in all versions of
Microsoft SQL Server. If the server doesn’t support the data type you
have chosen, the varchar data type will be used in its place.

7950 You can’t refer to the RecordsetClone property of a form when the
form is open in Design view.

7951 You entered an expression that has an invalid reference to the
RecordsetClone property. For example, you may have used the
RecordsetClone property with a form or report that isn’t based on a
table or query.

7952 You made an illegal function call. Check the syntax of the function you
are trying to use.

7953 The value you entered doesn’t match the type required.

• The variable, property, or object may not be of the correct type.

• You may have used an If TypeOf construct with something other than
a control.

7954 The expression you entered requires the control to be in the active
window. Try one of the following:

• Open or select a form or report containing the control.

• Create a new control in the active window, and try the operation
again.

7955 There is no current code context object.

7956 The syntax of the subquery in this expression is incorrect. Check the
subquery’s syntax and enclose the subquery in parentheses.

7957 You used a Like operator with an incorrect pattern. Make sure the
comparison value is enclosed in quotation marks.

7958 The Replication ID you entered is invalid. Make sure the Replication
ID you enter contains only digits or letters for hexadecimal numbers,
that the Replication ID is the correct length, and that it is in a canoni-
cal SQL form.
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7959 The expression contains an ambiguous name. You may have two or
more functions with the same name in different modules. Rename the
functions so that each one has a unique name.

7960 There was an error compiling this function. The Visual Basic module
contains a syntax error. Check the code, and then recompile it.

7961 Microsoft Access can’t find the module ‘|’ referred to in a macro
expression or Visual Basic code. The module you referenced may be
closed or may not exist in this database, or the name may be mis-
spelled.

7962 The index number you used to refer to the module is invalid. Use the
Count property to count the open modules and make sure that the mod-
ule number is not greater than the number of open modules minus 1.

7963 Microsoft Access can’t run the macro or callback function ‘|’. Make
sure the macro or function exists and takes the correct parameters.

7964 You entered an expression that has an invalid reference to the
Recordset property. You can only use a dynaset or snapshot recordset to
set this property.

7965 The object you entered is not a valid Recordset property. For example,
you may have used a forward-only recordset, or tried to set it to null.

7966 The format condition number you specified is greater than the number
of format conditions. Use the Count property to count the format con-
ditions for the control and then check that the format condition number
you cite is within the range of existing format conditions.

7967 A required minimum or maximum value is missing.

7968 The format condition Type you specified is invalid. Valid values for the
Type property are 0 to 2 for the first condition, and 0 to 1 for all other
format conditions.

7969 The format condition Operator you specified is invalid. Valid values for
the Operator property are 0 to 7.

7970 Microsoft Access can’t open the file ‘|.’ It may not be a database, or it
may be a database you are unable to open.

7971 Microsoft Access can’t follow the hyperlink to ‘|’. Please verify the
destination.

7972 Microsoft Access encountered an error while trying to show the
Hyperlink dialog.

7973 The hyperlink address or subaddress text you entered was too long for
Microsoft Access to store. The text was truncated to fit in the available
space, so the link may not work as expected.
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7974 Microsoft Access failed to insert a hyperlink at the current location.

7975 You chose an invalid control type for use with hyperlinks. You can only
use hyperlinks with labels, images, command buttons, or bound text
boxes.

7976 There is no stored hyperlink in this control.

7977 Microsoft Access is unable to paste the data on the clipboard as a
hyperlink.

7978 Microsoft Access is unable to add the current hyperlink to the favorites
folder.

7979 You can’t use the hyperlink property builder with more than one con-
trol selected.

7980 The HyperlinkAddress or HyperlinkSubAddress property is read-only
for this hyperlink.

7981 The values for ‘File or web page name’ and/or ‘Text to Display’ are too
long. The values will be truncated. To keep your original values, click
Cancel in the Edit Hyperlink dialog.

7983 Microsoft Access can’t follow the hyperlink because it couldn’t create
the hyperlink object.

7990 You entered an invalid project name. You may have deleted the default
project name and forgotten to specify a new one.

7991 The Microsoft Access Source Code Control Add-in is not available;
this object will be opened read-only.

7992 The Microsoft Access Source Code Control Add-in could not be
started.

7993 The object | is currently checked in and is therefore read-only. To mod-
ify the object, close it first, then check it out and reopen it.

7994 There was a problem communicating with the Source Code Control
Add-in.

7995 The menus on your form or report that are based on Microsoft Access
macros will not be visible while the Customize dialog box is open. To
have the full power of menu or toolbar customization, convert your
macro-based menus to menus or toolbars. With the macro selected in
the Database window, point to Macro on the Tools menu, and create a
menu, a toolbar, or a shortcut menu from that macro.

7996 Microsoft Access couldn’t create the Data and Misc. Objects because
the linked table ‘|’ could not be found. To create the Data and Misc.
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Objects, use the Linked Table Manager (Tools menu, Add-ins sub-
menu) to update the link to the source table or file, or delete the link
from your current database.

7997 You can’t save the standard module ‘|’ over a class module with the
same name. Save the standard module to a different name, or delete the
class module first.

7998 You can’t save the class module ‘|’ over a standard module with the
same name. Save the class module to a different name, or delete the
standard module first.

7999 Microsoft Access can’t delete this relationship because you don’t have
the Data and Misc. Objects checked out. Check out the Data and Misc.
Objects and then delete the relationship.

8000 The name you entered already exists for another object of the same
type in this database. Do you want to replace the existing |?

8001 ‘|’ has been changed since the last time you opened it, either by another
user or because another instance of it was opened on your own
machine. Do you want to replace the changes that you or another user
made?

• To save your most recent changes and discard the other user’s
changes or your previous changes, click Yes.

• To save this version of the object with another name, click No.

8002 ‘|’ has been changed since the last time you opened it, either by another
user or because another instance of it was opened on your own
machine. Do you want to replace the changes that you or another user
made?

• To save your most recent changes and discard the other user’s
changes or your previous changes, click Yes.

• To cancel saving this version of the object, click No.

8003 You must save a table or query before you can create a new object
based on it. Do you want to save and use the table or query to create a
new object?

8004 The layout of ‘|’ has been changed since the last time you opened it,
either by another user or because another instance of it was opened on
your own machine. Do you want to replace the changes that you or
another user made?

• To save your most recent changes and discard the other user’s
changes or your previous changes, click Yes.

• To cancel saving this version of the object, click No.
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8005 You can’t save this object. You must have Administer permission for
the Database object in order to save modules, forms, or reports in a
Design Master.

8006 The name you entered already exists for another object of the same
type in this database. Do you want to replace the existing |? You will
not be able to undo this operation.

8007 You cannot get into Exclusive Mode right now because this database is
opened by other users or because you do not have permissions to open
exclusively.

8008 The stored procedure executed successfully but did not return records.

8050 Do you want to save changes to the design of |?

8051 Do you want to save changes to |?

8052 Do you want to delete the | and empty the Clipboard? You tried to
delete a database object that is currently on the Microsoft Access
Clipboard. If you delete it from your database, you won’t be able to
paste it later.

8053 Do you want to delete the |? For more information on how to prevent this
message from displaying every time you delete an object, click Help.

8054 Do you want to exit Microsoft Access and empty the Clipboard?

8055 Microsoft Access can’t change the working directory to ‘|.’ Verify that
the drive is valid and the path is 260 characters or less in length.

8057 |

8058 Do you want to save changes to the layout of |?

8059 Do you want to remove the link to the |? If you delete the link, you
delete only the information Microsoft Access uses to open the table,
not the table itself.

8060 The toolbar ‘|’ is partly unreadable. Microsoft Access can’t display all
the toolbar buttons. The specified toolbar may be in a different format
than the toolbars in the current version of Microsoft Access. Click OK
to close the dialog box, and then add the buttons missing from the tool-
bar. Microsoft Access will then update the toolbar to the latest format.

8061 Are you sure you want to restore the default settings to the built-in
toolbar or menu bar |? If you previously customized, moved, changed
the visibility, or otherwise altered the toolbar or menu bar, or any of
the menus that cascade from it, Microsoft Access removes your
changes, returns the original buttons to their original order, and shows
or hides the toolbar based on the original setting. To return the built-in
toolbar or menu bar to its original state, click Yes.
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8063 The source application isn’t responding. Do you want to continue wait-
ing? The DDE channel is established, but the data exchange wasn’t
completed in the amount of time specified in the OLE/DDE Timeout
setting in the Options dialog box (Tools menu).

• To continue waiting for the data exchange to be completed, click Yes.

• To cancel the data exchange and try again later, click No.

8064 This linked table has indexes that use an unsupported sort order. If you
modify this table, the Microsoft Jet database engine can’t correctly
maintain the table’s indexes. As a result, your data may appear in the
wrong order, and functions that use the table’s indexes may have unex-
pected results. Try one of the following:

• Cancel this operation. Use the application in which the table was cre-
ated to re-create the indexes, making sure to specify an ASCII or
International sort order. Then try again to link the tables.

• Use this table on a read-only basis.

8065 You can’t delete the table ‘|’ until its relationships to other tables have
been deleted. Do you want Microsoft Access to delete the relationships
now?

8067 Do you want to permanently delete the |? If you click Yes, you won’t
be able to undo the deletion.

8069 Microsoft Access couldn’t create the custom toolbar ‘|.’

8071 Would you like to remove the compacted database from Source Code
Control?

8072 Microsoft Access must close the | in order to complete this operation.
Would you like Microsoft Access to close it now?

8073 You do not have the | checked out. Microsoft Access can’t check out an
object while it is open, and you can’t make design changes until you
check it out. If you want to make design changes to this object, first
close it, check it out, and then reopen it.

8074 Microsoft Access must save the | in order to complete this operation.
Would you like Microsoft Access to save it now?

8075 You do not have the Data and Misc. Objects checked out. You can’t
create a new table or save changes to a data access page.

8076 To import tables, relationships, menus, toolbars, import/export specs or
data access pages you must have the Data and Misc. Objects checked
out.
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8077 Are you sure you want to cut the |?

8078 This object will be removed from your local database, but not from
source code control. The next time you get this database from source
code control, the object will reappear. Are you sure that you want to
delete the local object?

8079 Microsoft Access was not able to add a reference to the type library for
this control because Data and Misc. Objects is not checked out. Check
out the Data and Misc. Objects and add a reference to the library ‘|’.

8080 An error occurred while trying to create the linked table ‘|’. Check to
make sure that the source table or file is available, and then retry the
operation on the Data and Misc. Objects.

8081 You have set |1’s Type property to Popup, which changes the toolbar to
a shortcut menu. The shortcut menu disappears because Microsoft
Access adds |2 to the Shortcut Menus toolbar. To complete the shortcut
menu, close the Toolbar Properties sheet, display the Shortcut Menus
toolbar, click the Custom category, and then add the commands you
want.

8082 Microsoft Access must save the | to the current database in order to
complete this operation. Would you like Microsoft Access to save it
now?

8086 An error occurred trying to add one or more references from the source
code control project. The library may not be registered on your com-
puter. Check your project references and add any missing references
after registering the missing components that this database requires.

8087 Restoring a database requires that no one is currently using the data-
base. Do you want to close all objects, select a backup file, and restore
the database from backup?

8088 Dropping a database requires that no one is currently using the data-
base. Do you want to close all open objects, and drop the database?

8090 Are you sure you want to delete the conflict table |? You will not be
able to undo this operation.

8091 This database is enabled for publication. Do you want to delete exist-
ing publications and drop the database?

8092 Access could not save your project. Do you want to cancel the close
operation?

•To cancel the close operation, click Yes.

•To close without saving, click No.
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8093 Send a pointer to the data access page? To send an e-mail message that
contains a pointer to your data access page, click Send Pointer. This is
the recommended method. The e-mail recipient must have access to the
server or public share to view the page. To send a copy of the page,
click Send Copy. To cancel sending the page, click Cancel. For more
information, click Help.

8094 Send a copy of the data access page? The contents of the page will be
copied into the body of the email message, however the page will con-
nect to the data source when the recipient views the message. If this is
correct, click OK. Otherwise, click Cancel, save the page to a server or
public share, and resend a pointer to the page. It is generally more
secure to send a pointer to the page than to send a copy of the page.
For more information, click Help.

8095 You tried to create a group filter based on a column type which cannot
be used in a filter.

8096 Microsoft Access can’t change the working directory to ‘|.’ Please enter
a non-Internet location.

8097 The connection string of this page specifies an absolute path. The page
might not be able to connect to data through the network. To connect
through a network, edit the connection string to specify a network
(UNC) path.

8098 Your computer has resumed operation after Critical Suspend mode.
Any unsaved changes might have been lost. To ensure proper opera-
tion, close and reopen any files. Restarting Microsoft Access is recom-
mended.

8400 The database ‘|’ is read-only. You won’t be able to save changes made
to data or object definitions in this database.

8401 You can’t make changes to the database objects in the database ‘|.’ This
database was created in an earlier version of Microsoft Access. To con-
vert this database to the current version of Microsoft Access, close the
database, point to Database Utilities on the Tools menu, and then click
Convert Database.

8402 The file ‘|’ already exists. Do you want to replace the existing file? If
you want to compact or convert to a different file name, click No. Enter
the new file name after the /compact or /convert option in the com-
mand line, and run the command again.
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8403 The setting you entered is invalid. The database’s sort order can’t be
updated. The setting you entered in the New Database Sort Order
option of the Options dialog box (Tools menu) isn’t a valid sort order
for the version of the database you are compacting.

8404 You can’t open ‘|’ for exclusive use because another user has the data-
base open or because you do not have permissions to open exclusively.
Microsoft Access will open the database for shared access.

8405 You can’t make changes to the database objects in the database ‘|.’ This
database was created in an earlier version of Microsoft Access. To con-
vert this database to the current version of Microsoft Access, close the
database, point to Database Utilities on the Tools menu, and then click
Convert Database.

8406 Does the first row of your data contain column headings?

8407 This database is a replica created in a previous version of Microsoft
Access. You can view objects in this database, but you can’t modify
their design. If you want to modify objects in this database, convert the
Design Master for this replica set to the current version of Microsoft
Access and synchronize this replica. Do you want to open the database
anyway?

8408 The name you entered already exists for another custom group in this
database. Do you want to replace the existing custom group |? You will
not be able to undo this operation.

8409 Microsoft Access has made a backup of database |1 at |2. Note: Only
server-related objects have been backed up. To protect other objects,
back up the .ADP file manually

8410 Microsoft Access successfully restored database |1 from its backup at
|2

8411 Do you want to permanently delete the custom group ‘|’? If you click
Yes, all shortcuts in the custom group will be deleted as well, and you
won’t be able to undo the deletion.

8412 The name you entered already exists for another shortcut in this group.
Do you want to replace the existing shortcut ‘|?’

8413 The project ‘|’ is read-only. You won’t be able to save changes made to
object definitions in this project.

8414 Microsoft Access encountered one or more errors during conversion.
To view a summary of these errors, open the ‘|’ table.

8415 The HTML file associated with this link has been moved, renamed, or
deleted. File: ‘|’
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8416 Renaming this user-defined function removes any existing permissions
and extended properties. Do you want to complete the rename action?

8500 A form with a subform object can’t have its DefaultView property set
to Continuous Forms. You tried to add a subform to a form in Design
view. Microsoft Access will reset the property to Single Form.

8501 You can’t modify this field because it is read-only. Some fields, such as
a calculated field, are read-only by design. However, any field can be
read-only if its Locked property is set to Yes.

8502 Microsoft Access has reached the end of the records. Do you want to
continue searching from the beginning?

8503 Microsoft Access has reached the beginning of the records. Do you
want to continue searching from the end?

8504 Microsoft Access finished searching the records. The search item was
not found.

8505 Do you want to continue to search or replace?

8506 There isn’t enough memory to save the current filter. Close unneeded
programs. Return to the form or datasheet, and then redefine and reap-
ply the filter. For more information on freeing memory, search the
Microsoft Windows Help index for ‘memory, troubleshooting’.

8507 There isn’t enough memory to execute the macro that updates the
active filter. Microsoft Access is closing the Filter window.

Close unneeded programs. Then try again to open the Filter window.

For more information on freeing memory, search the Microsoft
Windows Help index for ‘memory, troubleshooting’.

8508 Microsoft Access can’t find ‘|.’ The text string you entered in the Find
What box can’t be evaluated against the current field. Reenter the text
string so that it conforms to the data type of the field.

8509 You won’t be able to undo this Replace operation. There isn’t enough
free memory to use the Undo command. Do you want to continue?

8510 Microsoft Access can’t save the current record. Do you want to undo
the changes to the record and continue the Paste operation?

8511 Records that Microsoft Access was unable to paste have been inserted
into a new table called ‘|.’ In the Database window, open the new table
to see the unpasted records. After you fix the problems that resulted in
the paste errors, copy and paste the records from the new table.
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8512 None of the field names you pasted onto the Clipboard match the field
names on the form. Microsoft Access treats the data in the first row on
the Clipboard as field names. If you copied the data from another
application, the first row of data may have taken the place of the field
names. Do you want to paste the field names in the order you defined
with the Tab Order command?

8513 Some of the field names for the data you tried to paste don’t match
field names on the form. Microsoft Access treats data in the first row
on the Clipboard as field names. In this case, some of those field
names don’t match the field names on the form. Do you want to paste
only that data whose names match the field names on the Clipboard?

8514 Do you want to suppress further error messages telling you why
records can’t be pasted? If you click No, a message will appear for
every record that can’t be pasted.

8515 You copied a large amount of data onto the Clipboard. When you copy
data onto the Clipboard, only the reference to the object is copied. If
you close the source document, however, Microsoft Access must paste
all the data from its source. Depending on the amount of data, this can
take some time. Do you want to save this data on the Clipboard?

8516 You selected more records than can be copied onto the Clipboard at
one time. Divide the records into two or more groups, and then copy
and paste one group at a time. The maximum number of records you
can paste at one time is approximately 65,000.

8517 Do you want to suppress further error messages telling you why
records can’t be deleted? If you click No, a message will appear for
every record that can’t be deleted.

8518 You won’t be able to undo this Replace operation. Do you want to 
continue?

8519 You are about to delete | record(s). If you click Yes, you won’t be able
to undo this Delete operation. Are you sure you want to delete these
records?

8520 You are about to paste | record(s). Are you sure you want to paste these
records?

8521 You won’t be able to undo this Delete operation. The Undo command
won’t be available because this operation is too large, or there isn’t
enough free memory. Do you want to delete these items?

8522 All timers are in use. Set the TimerInterval property back to zero so
that you can start another timer.
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8523 Do you want to delete the custom palette information from this form or
report and revert to the default palette?

8524 Do you want to delete the graphic from this button?

8525 The remote data isn’t accessible. You tried to open a form or report that
includes a DDE or DDESend function in a calculated control that spec-
ifies an OLE server application. Do you want to start the application |?

8526 Microsoft Access encountered a problem while trying to switch views
and must close this window.

8527 Do you want to delete the group section for the database object ‘|’ and
its contents? You will not be able to undo this action. The group header
or footer you want to delete contains controls and will be deleted along
with the section.

8528 Deleting these sections will also delete all controls in them. You will
not be able to undo this action. Do you want to delete these sections
anyway?

8529 Do you want to delete the selected group level(s) and all associated
sections and their controls? The field or expression you’re deleting
from the Sorting and Grouping box has an associated section (a header
or footer) containing controls that will be deleted along with the sec-
tion.

8530 Relationships that specify cascading deletes are about to cause |
record(s) in this table and in related tables to be deleted. Are you sure
you want to delete these records?

8531 The section width is greater than the page width, and there are no items
in the additional space, so some pages may be blank. For example, the
report width may be wider than the page width.

8532 Do you want to remove this picture from the form?

8533 Some data may not be displayed. There is not enough horizontal space
on the page for the number of columns and column spacing you speci-
fied. Click Page Setup on the File menu, click the Columns tab, and
then reduce the number of columns or the size of the columns.

8534 When you save this form or report, any code behind it will be deleted.
You have set the HasModule property to No, creating a form or report
that opens more quickly. Any macros associated with this form or
report will not be affected, nor will code in separate modules that is
called from this property sheet. Are you sure you want to do this?
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8538 You are about to delete this section. If you click Yes, the controls you
placed in this section will be deleted. Are you sure you want to delete
these controls?

8539 Relationships that specify cascading deletes are about to cause
record(s) in this table and in related tables to be deleted. Are you sure
you want to delete these records?

8540 You are about to delete one or more records. If you click Yes, you
won’t be able to undo this Delete operation. Are you sure you want to
delete these records?

8541 Microsoft Access could not perform the delete operation. An error
occurred during the delete operation, no records were deleted.

8542 Microsoft Access did not detect a relationship between the fields you
have chosen. Do you want a relationship to be created for you now?

8543 You are about to delete this section and all related sections. If you click
Yes, the controls you placed in these sections will be deleted. Are you
sure you want to delete these controls?

8544 You won’t be able to undo this paste operation. Do you want to 
continue?

8545 Microsoft Access can’t save the filter criteria you entered in the Insert
Hyperlink dialog box. Make sure that the data access page is bound to
a record source before you set the filter criteria. Also make sure that
the criteria is in the form of a WHERE clause; for example,
EmployeeID=[EmployeeID].

9502 Microsoft Access won’t be able to undo this action or subsequent
actions. To make more resources available so that Access can record
further design actions, close and reopen this window. Do you want to
continue anyway?

9504 The file ‘|’ is not readable by JET. If you think you have a valid JET
file then this is most likely due to the recent file format change. Do
you want to attempt to upgrade the database format?

9505 The database ‘|’ needs to be repaired or isn’t a database file. You or
another user may have unexpectedly quit Microsoft Access while a
Microsoft Access database was open. Do you want Microsoft Access to
attempt to repair the database?

9507 Microsoft Access was unable to load all the library modules.
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9508 Microsoft Access couldn’t close database ‘|.’Your last change may not
have been saved because an internal buffer was locked by another user
(whose name was given in the previous message). To avoid losing data,
wait for the other user to finish using the record, and then click OK
again. If you click Cancel, you may lose changes that haven’t been
saved.

9509 You can’t undo this command and, once it’s completed, you won’t be
able to edit this object. Do you want to continue anyway?

9510 Microsoft Access can’t open the file ‘|’.

9511 |

9512 Successfully repaired the ‘|’ database.

9513 Microsoft Access was unable to completely repair the ‘|’ table and
deleted some Memo, OLE Object, or Hyperlink field values. To
recover the data, restore from your backup copy of the database.

Note that the data in the deleted field may have been damaged by a bad
sector on your hard disk. For more information on checking your disk’s
surface, files, and folders for errors, search the Windows Help index for
‘checking for disk errors’.

9514 One or more records were unrecoverable and were deleted from the ‘|’
table.

9515 The ‘|’ table was truncated; data was lost.

9516 One or more indexes from the ‘|’ table couldn’t be repaired and were
deleted.

9517 The Save As command can’t process any subforms contained in your
report. Do you want to proceed anyway?

9518 An error occurred while adding this word to the custom dictionary.

• The dictionary file may be read-only.

• There may be a disk error.

9519 An error occurred while adding this word to the Change All list. The
dictionary may be full.

9520 An error occurred while adding the word to the Ignore All list. The
dictionary may be full.

9521 The specified word is too large. Words can’t exceed 64 characters.

9523 Microsoft Access can’t open the ‘|’ custom dictionary.

9524 Microsoft Access can’t start the spelling checker because it isn’t
installed.
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9525 Microsoft Access can’t open the main dictionary file. Verify that this
file has been correctly installed.

9526 The spelling checker only works on text fields that contain text data.
You’re trying to check a field with a data type other than Text or
Memo.

9527 The spelling checker can’t proceed; you must first select data from a
table, query, view, stored procedure, or form.

9529 The spelling checker can’t proceed; form data is not updateable. The
form may be based on a query that isn’t updateable or is only partly
updateable. For information on when a query is updateable, click Help.

9530 An error occurred while trying to modify the contents of field ‘|.’ The
field may be locked or read-only, or you may not have permissions to
change it. For information on security permissions and who can change
them, click Help.

9531 An error occurred while trying to save spelling preferences.

9532 The ‘|’ field can’t be modified because it’s a read-only field.

9533 An error occurred while trying to add the word pair to the AutoCorrect
list.

9534 The current selection does not contain any fields that can be checked
for spelling errors. You can check the spelling of text box controls with
Text or Memo data types.

9535 You entered an invalid main dictionary. Please select a valid entry.

9536 The spelling check is complete.

9537 You must restart the spelling checker for the dictionary change to take
effect.

9538 The ‘|’ custom dictionary doesn’t exist. Do you want to create it?

9539 You have specified a word that isn’t found in the main or custom dic-
tionary. Do you want to use this word and continue checking?

9540 The main dictionary you selected can’t be used. It has not been cor-
rectly installed.

9541 The spelling checker can’t undo your last change. The data in field ‘|’
has been modified by another user. To resume the spelling check, click
OK.

9542 This database must be closed before you can create a replica. Do you
want Microsoft Access to close this database and create the replica? If
you proceed, Microsoft Access will close your database and convert it
to a Design Master. The database may increase in size.
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9543 The Hangul Hanja Converter can’t proceed. There is no Hangul or
Hanja data to convert.

9544 Microsoft Access can’t register the ‘|’ custom dictionary.

9545 After you have converted this file to Access 2002 File Format, the new
file cannot be shared with Access 2000 users or Access 97 users. For
more information about conversion, click Help.

9546 This data access page was created in a previous version of Microsoft
Access. To open this page in Design view, you must convert it to the
current version of Access. Once you have converted this page, you
can’t open it in Design view in a previous version of Access.

9547 After you have converted this file to Access 2000 File Format, the new
file cannot be shared with Access 97 users. Any functionality specific
to Access 2002 will not be available in Access 2000. For more infor-
mation about conversion, click Help.

9548 After you have converted this file to Access 97 File Format, any func-
tionality specific to Access 2000 or Access 2002 will be lost. For more
information about conversion, click Help.

10000 You must first save the table. Do you want to save the table now?

10001 You must first save the view. Do you want to save the view now?

10002 You must first save the stored procedure. Do you want to save the
stored procedure now?

10003 You must first save the query. Do you want to save the query now?

10004 Do you want to permanently delete the selected field(s) and all the data
in the field(s)? To permanently delete the field(s), click Yes.

10005 There is no primary key defined. Although a primary key isn’t
required, it’s highly recommended. A table must have a primary key for
you to define a relationship between this table and other tables in the
database. Do you want to create a primary key now?

10006 Changing to this data type requires removal of one or more indexes.
You can’t use indexes on fields with a Memo, OLE Object, or
Hyperlink data type. If you click Yes, Microsoft Access will delete the
indexes that include that field. Do you want to continue anyway?

10007 Deleting field ‘|’ requires Microsoft Access to delete the primary key.
Do you want to delete this field anyway?

10008 Deleting field ‘|’ requires Microsoft Access to delete one or more
indexes. If you click Yes, Microsoft Access will delete the field and all
its indexes. Do you want to delete this field anyway?
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10009 You can’t open the table ‘|’ for modification. A query or form bound to
the table is open, you may not have permission to open this table in
Design view, or another user has the table open. Do you want to open
this table as read-only? If you have opened a query or form bound to
this table, close it, and then try again to open the table in Design view.

10010 Table ‘|’ is a linked table with some properties that can’t be modified.
Do you want to open it anyway?

10011 Microsoft Access encountered errors while converting the data. The
contents of fields in |1 record(s) were deleted. Do you want to proceed
anyway?

10012 Microsoft Access can’t retrieve field properties from the system tables.
The database needs to be repaired. If you click Yes, Microsoft Access
will open the table in Design view. The settings of the FieldName,
DataType, FieldSize, Indexed, and Primary properties will remain
intact, but the settings of other field properties will be lost.

You can attempt to redefine the lost properties, but it is recommended
that you restore the database from a backup copy, or close it and use
the Repair Database command on the Tools menu (Database Utilities
submenu).

Do you want to continue anyway?

10013 Microsoft Access can’t save property changes for linked tables. Do you
want to continue anyway?

10014 Microsoft Access was unable to append all the data to the table. The
contents of fields in |1 record(s) were deleted, and |2 record(s) were
lost due to key violations.

• If data was deleted, the data you pasted or imported doesn’t match
the field data types or the FieldSize property in the destination table.

• If records were lost, either the records you pasted contain primary
key values that already exist in the destination table, or they violate
referential integrity rules for a relationship defined between tables.

Do you want to proceed anyway?

10015 Changing to this data type requires removal of the primary key. Do you
want to continue anyway?

10016 Some data may be lost. The setting for the FieldSize property of one or
more fields has been changed to a shorter size. If data is lost, valida-
tion rules may be violated as a result. Do you want to continue any-
way?
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10017 Your computer is out of disk space. You won’t be able to undo this
paste append. Do you want to continue anyway?

10018 Microsoft Access was unable to append all the data to the table. The
contents of fields in |1 record(s) were deleted, and |2 record(s) were
lost due to key violations.

• If data was deleted, the data you pasted or imported doesn’t match
the field data types or the FieldSize property in the destination table.

• If records were lost, the records you pasted contain primary key val-
ues that already exist in the destination table, or they violate referen-
tial integrity rules for a relationship defined between tables.

10019 Microsoft Access can’t find the database containing the linked table ‘|.’
The properties set in Microsoft Access for the linked table will be lost.
Do you want to continue with the conversion anyway?

10020 Data integrity rules have been changed; existing data may not be valid
for the new rules. This process may take a long time. Do you want the
existing data to be tested with the new rules?

10021 Existing data violates the new record validation rule. Do you want to
keep testing with the new rule?

• To keep the new rule and continue testing, click Yes.

• To revert to the old rule and continue testing, click No.

• To stop testing, click Cancel.

10022 Existing data violates the new setting for the ‘|1’ property for field ‘|2.’
Do you want to keep testing with the new setting?

• To keep the new setting and continue testing, click Yes.

• To revert to the old setting and continue testing, click No.

• To stop testing, click Cancel.

10023 Microsoft Access deleted | indexes on the converted fields. Some data
did not convert properly.

10024 You must save the table first. Microsoft Access can’t test your data
until you save the design changes you made. Do you want to save the
table now?

10025 This operation will test the table’s record and field validation rules, as
well as the Required and AllowZeroLength properties, for all data in
the table. This process may take a long time. Do you want to continue
anyway?

10026 All data was valid for all rules.
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10027 Existing data violates the new record validation rule. Do you want to
continue testing data with this new rule?

• To continue testing for other new rule violations, click Yes.

• To continue to test only the old validation rules, click No.

• To stop testing, click Cancel.

10028 The existing data violates the ‘|1’ property for field ‘|2.’ If you continue
testing, Microsoft Access will inform you if data violates any other
property settings in the table. Would you like to continue testing?

10029 There is no primary key defined. Although a primary key isn’t
required, it’s highly recommended. A table must have a primary key
for you to add data to this table or to define relationships between this
table and other tables in the database. Do you want to return to table
design and add a primary key now?

10030 There is no primary key defined. Although a primary key isn’t
required, it’s highly recommended. A table must have a primary key
for you to define relationships between this table and other tables in
the database. Do you want to return to table design and add a primary
key now?

10031 You must first save the function. Do you want to save the function
now?

10250 You can’t print the scrollable (unfrozen) columns on the datasheet. The
frozen columns are wider than the page. Do you want to print just the
frozen columns? If you want to print the unfrozen columns, try one or
more of the following:

• Decrease the column width and increase the row height of the frozen
columns.

• Change the page orientation to Landscape in the printer Properties
dialog box.

• Decrease the size of the left and right page margins in the Page Setup
dialog box.

10251 The column heading is too tall to fit on the page. Part of the heading
will be cut off. Do you want to print the incomplete heading? To pre-
vent headings from being cut off, try one or more of the following:

• Change the page orientation to Portrait in the printer Properties dia-
log box.

• Decrease the size of the top and bottom page margins in the Page
Setup dialog box.
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10252 At least one column is too wide to fit on the page. Data in that column
will be cut off. Do you want to print the column with incomplete data?
To prevent data from being cut off, try one or more of the following:

• Decrease the column width and increase the row height.

• Change the page orientation to Landscape in the printer Properties
dialog box.

• Decrease the size of the left and right page margins in the Page Setup
dialog box.

10253 The row height exceeds the space between the top and bottom margins.
Do you want to print the columns with incomplete data? To prevent
data from being cut off, try one or more of the following:

• Increase the column width and decrease the row height.

• Change the page orientation to Portrait in the printer Properties dialog
box.

• Decrease the size of the top and bottom page margins in the Page
Setup dialog box.

10500 You are about to run an update query that will modify data in your
table. Are you sure you want to run this type of action query? For
information on how to prevent this message from displaying every time
you run an action query, click Help.

10501 You are about to run an append query that will modify data in your
table. Are you sure you want to run this type of action query? For
information on turning off confirmation messages for document dele-
tions, click Help.

10502 You are about to run a make-table query that will modify data in your
table. Are you sure you want to run this type of action query? For
information on how to prevent this message from displaying every time
you run an action query, click Help.

10503 You are about to run a delete query that will modify data in your table.
Are you sure you want to run this type of action query? For informa-
tion on how to prevent this message from displaying every time you
run an action query, click Help.

10504 You are about to run a data-definition query that may modify data in
your table. Are you sure you want to run this type of an SQL query? If
not, click No and then modify the query or close it to run later.

10505 You are about to update | row(s). Once you click Yes, you can’t use the
Undo command to reverse the changes. Are you sure you want to
update these records?
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10506 You are about to append | row(s). Once you click Yes, you can’t use the
Undo command to reverse the changes. Are you sure you want to
append the selected rows?

10507 You are about to paste | row(s) into a new table. Once you click Yes,
you can’t use the Undo command to reverse the changes. Are you sure
you want to create a new table with the selected records?

10508 You are about to delete | row(s) from the specified table. Once you
click Yes, you can’t use the Undo command to reverse the changes. Are
you sure you want to delete the selected records?

10509 Microsoft Access can’t update all the records in the update query.
Microsoft Access didn’t update |1 field(s) due to a type conversion fail-
ure, |2 record(s) due to key violations, |3 record(s) due to lock viola-
tions, and |4 record(s) due to validation rule violations. Do you want to
continue running this type of action query anyway?

To ignore the error(s) and run the query, click Yes.

For an explanation of the causes of the violations, click Help.

10510 Microsoft Access can’t append all the records in the append query.
Microsoft Access set |1 field(s) to Null due to a type conversion failure,
and it didn’t add |2 record(s) to the table due to key violations, |3
record(s) due to lock violations, and |4 record(s) due to validation rule
violations. Do you want to run the action query anyway?

To ignore the error(s) and run the query, click Yes.

For an explanation of the causes of the violations, click Help.

10511 Microsoft Access can’t add all the records in the update or append
query. It set |1 field(s) to Null due to a type conversion failure.

A type conversion failure is caused when the data in one or more fields
doesn’t match the DataType or FieldSize property in the destination
table. For example, leaving blank fields in a Yes/No field or entering
text in a numeric field will cause this error. Do you want to ignore the
errors and run the update or append query anyway? To ignore the
error(s) and run the query, click Yes.

10512 Microsoft Access can’t delete |2 record(s) in the delete query due to
key violations and |3 record(s) due to lock violations. Do you want to
run this action query anyway?

To ignore the error(s) and run the query, click Yes.

For an explanation of the causes of the violations, click Help.
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10513 The existing | will be deleted before you run the query. Do you want to
continue anyway?

10514 You won’t be able to undo the changes this action query is about to
make to the data in a linked table or tables. Do you want to run this
action query anyway?

10515 Microsoft Access was unable to update all the records in the update
query. Microsoft Access didn’t update |1 field(s) due to a type conver-
sion failure, |2 record(s) due to key violations, |3 record(s) due to lock
violations, and |4 record(s) due to validation rule violations. For an
explanation of the causes of the violations, click Help.

10516 Microsoft Access can’t append all the records to the table. Microsoft
Access set |1 field(s) to Null due to a type conversion failure, and it
didn’t add |2 record(s) due to key violations, |3 record(s) due to lock
violations, and |4 record(s) due to validation rule violations. For an
explanation of the causes of the violations, click Help.

10517 Microsoft Access can’t add all the records in the make-table query. It
set |1 field(s) to Null due to a type conversion failure. A type conver-
sion failure is caused when the data in one or more fields doesn’t
match the DataType or FieldSize property in the destination table. For
example, leaving blank fields in a Yes/No field or adding text in
numeric field will cause this error.

10518 Microsoft Access can’t delete all the records in the delete query.
Microsoft Access didn’t delete |2 record(s) due to key violations and |3
record(s) due to lock violations. For an explanation of the causes of the
violation, click Help.

10519 There isn’t enough disk space or memory to undo the data changes this
action query is about to make. Do you want to run this action query
anyway? For information on freeing disk space or freeing memory,
search the Microsoft Windows Help index for ‘disk space, freeing’ or
‘memory, troubleshooting’.

10520 Do you want to save the changes made to the SQL statement and
update the property? The RecordSource or RowSource property con-
tained a SQL statement when you invoked the Query Builder, so the
original SQL statement was modified. To close the Query Builder with-
out changing the original SQL statement, click No.

10521 Do you want to save the changes made to the query and update the
property? The RecordSource or RowSource property contained the
name of a query when you invoked the Query Builder, so the original
query was modified. To close the Query Builder without changing the
original query, click No.
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10522 You invoked the Query Builder on a table. Do you want to create a
query based on the table?

10523 You are about to run a pass-through query that may modify data in
your table. Are you sure you want to run this type of an SQL query?
For information on how to prevent this message from displaying every
time you run an SQL query, click Help.

10524 | output column(s) in the query were unnamed and will not show any
data.

10526 Do you want to save the changes made to the SQL Statement and
update the text editor? The Stored Procedure or Function contained an
SQL statement when you invoked the Query Builder, so the original
SQL statement was modified. To close the Query Builder without
changing the original SQL statement, click No.

10600 Are you sure you want to permanently delete the selected relationship
from your database?

10601 A relationship already exists. Do you want to edit the existing relation-
ship? To create a new relationship, click No.

10602 The field name is missing in row |. You haven’t selected a matching
field for this relationship in each row of the grid. Select fields so that
the grid has the same number of fields on the left and right sides, and
then try to create the relationship again.

10603 This relationship has been modified or deleted by another user since
you opened the Relationships window. Do you want to edit the rela-
tionship and overwrite the other user’s changes? To update your
Relationships window to include the other user’s changes, click No.

10604 This relationship has already been deleted by another user. To update
your view, click OK.

10605 The layout of the Relationships window will be cleared. Do you want
to continue?

10606 You can’t display queries or linked tables in the Relationships window
for this database. The database ‘|’ was created in an earlier version of
Microsoft Access. If you want to convert this database to the current
version of Microsoft Access, use the Convert Database command on
the Tools menu (Database Utilities submenu).

10607 The relationship has been created as a one-to-many relationship
because there are duplicate entries in the related field. You’ve tried to
create a one-to-one relationship, but the data in the tables suggests that
a one-to-many relationship is more appropriate.
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10608 To create a relationship, use the mouse to drag a field from one table to
another.

10700 This document was previously formatted for the printer |1 on |2, but
that printer isn’t available. Do you want to use the default printer |3 on
|4?

10701 This document was previously formatted for the printer ‘|1 on |2’, but
that printer isn’t available. The page settings shown in the Print Setup
dialog box are for the current default printer ‘|3 on |4’. Do you want to
continue?

10750 You must save the macro before you run it. Do you want to save the
macro now?

• To save the macro and then run it, click Yes.

• To return to the Macro window for this macro or to the window you
executed the Run Macro command from, click No.

10751 Some of the macro actions you are trying to save cannot be performed
in Access 97. These actions will be permanently deleted from the
macro in the Access 97 version of your database.

10800 Microsoft Access finished adding the index ‘|.’ Add another index from
the Select Index Files dialog box, or click Close.

10801 The Microsoft Access index information (.inf) file for ‘|’ already exists.
Do you want to replace the existing Microsoft Access .inf file for the
dBASE or Microsoft FoxPro file you’re linking?

• To create a new .inf file, click Yes.

• To use the existing file, click No.

If the .inf file contains invalid or outdated information, you must click
Yes to create a new .inf file before you can link the table.

10803 The database object ‘|’ already exists. Do you want to replace the exist-
ing database object with the one you are exporting? If you want to
export this object without replacing the existing database object, click
No. You can then export the object again and rename it in the Export
dialog box.

10804 Not all of the import specifications could be imported due to name
conflicts. Conflicts existed in | of the specifications. Rename the con-
flicting import specifications, and try the import operation again.

10805 Invalid CDF file name
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10892 A form with a bound ActiveX control or an embedded object bound to
a data source can’t have its DefaultView property set to Continuous
Forms. You tried to add a bound ActiveX control to a form in Design
view. Microsoft Access will reset the DefaultView property to Single
Form.

10893 Either the data access page file has been opened by another user or you
don’t have write permission to the file. If you make changes, you will
have to save them to another file.

10894 An unexpected error occurred while saving document properties to the
data access page.

10895 You tried to drop an OLE or binary column onto your data access
page. There is no HTML control which binds correctly to this column
type.

10896 You have chosen to permanently delete the data access page. Do you
want to delete both the link and page file(s), or delete just the link?

10897 | There is a problem with Internet Explorer registry settings. Please
reinstall Internet Explorer.

10898 Microsoft Access data access pages can only be viewed in Microsoft
Internet Explorer, but it is not your default Browser. Do you want to
open Internet Explorer to view this page?

10899 A link to this data access page could not be created because the Data
and Misc. Objects are not checked out.

10900 The save operation was successful. A folder was created for your sup-
porting files at the save destination. This directory had to be created
because the server does not support long file names.

10901 You must save your data access page before you can preview it. Do
you want to save now?

10902 The data access page has been saved, but one or more of the support-
ing files (i.e., image, sound, video files) are missing. You may need to:

• Delete and recreate the HTML object(s) on the page.

• Reapply the theme, if the page has a theme.

10903 The save completed, but files for the selected theme are missing.
Please apply a new theme to your data access page, and save again.

10904 Do you want Microsoft Access to set the DataPageSize property of this
group level to All?
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10905 You have opened a page that was last designed using Access 2000. The
page must be saved using Office 2002 Office Web Components before
you can edit this document. Would you like to convert this page?

10950 Are you sure you want to delete this account? You can’t undo the dele-
tion of a user or group account. To restore a user or group account that
has been deleted, you must recreate the account using the same name
and personal identifier (PID).

10951 You don’t have permission to modify ‘|.’ To modify this object, you
must have Modify Design permission for it. If the object is a table, you
must also have Delete Data and Update Data permissions for it. Do you
want to save a copy of the object as a new object?

10952 You don’t have permission to view this macro. To view a macro, you
must have Read Design permission for it. Do you want to continue to
run the macro?

10953 You don’t have permission to modify ‘|.’ To modify this object, you
must have Modify Design permission for it. If the object is a table, you
must also have Delete Data and Update Data permissions for it. Do you
want to open it as read-only?

10954 You changed the permissions of ‘|1’ for ‘|2.’ Do you want to assign
these permissions now?

10955 You don’t have permission to open ‘|’ for exclusive use. Microsoft
Access is opening the database for shared access. To open a database
for exclusive access, you must have Open Exclusive permission for it.
For more information on permissions and who can set them, click
Help.

10956 ;LCID=0x0409

10957 You haven’t entered a workgroup ID. To ensure that your workgroup
information file is unique, enter a unique workgroup ID of up to 20
numbers or letters. Continue without a workgroup ID?

10958 The file ‘|’ already exists. Replace existing file?

10959 Workgroup Files (•.mdw)

10960 Select Workgroup Information File

10961 Open

10962 You have successfully created the workgroup information file ‘|.’

10963 Could not find file: ‘|’

10964 You have successfully joined the workgroup defined by the workgroup
information file ‘|’
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10965 It is strongly recommended that you change the system administrator
(SA) password when this operation is complete. To change the SA
password point to Security on the Tools menu, and then click Set
Login Password.

29000 There isn’t enough memory to create an input area. Close unneeded
programs. Then try to create the input area again. For more informa-
tion on freeing memory, search the Microsoft Windows Help index for
‘memory, troubleshooting’.

29001 Microsoft Access failed to save module ‘|.’Your computer may be low
on disk space. For information on freeing memory or disk space,
search the Microsoft Windows Help index for ‘memory, troubleshoot-
ing’ or ‘disk space, freeing’.

29002 Microsoft Access failed to create the Visual Basic module ‘|.’ If your
database is on a network drive, check your network connection, and
then try again.

29003 Microsoft Access failed to convert or enable your code modules. Your
computer may be low on disk space or memory.

29004 The new procedure name you provided is invalid.

29005 The procedure ‘|’ already exists. Choose another procedure name.

29006 Microsoft Access failed to create a Debug window toolbar. The system
may be out of resource memory. Close unneeded programs and try
again. For more information on freeing memory, search the Microsoft
Windows Help index for ‘memory, troubleshooting’.

29007 During the paste or import operation, Microsoft Access failed to con-
vert the ‘|’ module from an earlier version of a Microsoft Access data-
base. Your computer may be low on disk space or memory.

29008 Microsoft Access couldn’t create storage space for a Visual Basic mod-
ule. If your database is on a network drive, check your network con-
nection, and then try again.

29009 Microsoft Access couldn’t open the storage space for a Visual Basic
module. Your computer may be low on disk space. For information on
freeing memory or disk space, search the Microsoft Windows Help
index for ‘memory, troubleshooting’ or ‘disk space, freeing’.

29010 The function name is too long. Microsoft Access will truncate the
function name to 255 characters.

29011 Microsoft Access failed to save the database. Your computer may be
low on disk space. For information on freeing memory or disk space,
search the Microsoft Windows Help index for ‘memory, troubleshoot-
ing’ or ‘disk space, freeing’.
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29013 This action will reset the current code in break mode. Do you want to
stop the running code?

• To halt the execution of the program so the Module window can be
closed, select Yes.

• To leave the code in the current state, select No.

29014 You can’t add a reference to a Microsoft Access workgroup.

29015 You can’t remove this reference. Microsoft Access needs this reference
in order to work properly.

29016 You can’t add a reference to the open database.

29017 The database | was created in an earlier version of Microsoft Access.
Convert this database to the current version of Microsoft Access by
using the Convert Database command on the Tools menu (Database
Utilities submenu).

29018 You can’t use a standard module for this operation.

29019 The module name ‘|’ is invalid.

• The module name may start with the prefix Form_ or Report_.

• The module can’t be named Forms, Reports, Modules, Application,
Screen, Assistant, CommandBars, References, or DoCmd.

• The module name may have too many characters.

29020 Another user has modified this database. To see the current version,
close the database and open it again.

29021 This operation isn’t available while there is a module in break mode.
Reset the executing code and try the operation again.

29022 There were compilation errors during the conversion or enabling of this
database. The database has not been saved in a compiled state. The per-
formance of this database will be impaired because Microsoft Access
will need to recompile the database for each session. For information
on improving performance, click Help.

29023 There are calls to 16-bit dynamic-link libraries (.dll) in modules in this
database. These won’t work under Microsoft Windows 95 or Microsoft
Windows NT. Change your code to call equivalent 32-bit dynamic-link
libraries (.dll).

29024 The current user account doesn’t have permission to convert or enable
this database. To convert or enable a database, ensure the following:

• You must join the workgroup that defines the user accounts used to
access the database.
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• Your user account must have Open/Run and Open Exclusive permis-
sions for the database object.

• Your user account must have Modify Design or Administer permis-
sions for all tables in the database, or it must be the owner of all
tables in the database.

• Your user account must have Read Design permission for all objects
in the database.

• Request that other users close the database.

29025 There are calls to 16-bit dynamic-link libraries (.dll) in modules in this
database. These won’t work under Microsoft Windows 95 or Microsoft
Windows NT. Translate these calls to equivalent 32-bit dynamic-link
libraries.

29026 The database that you are trying to open or convert is currently in use,
or you do not have permission to open it exclusively. When you con-
vert a database, or the first time you open an earlier version database,
another user can’t have the database open. Try one of the following:

• Request that other users close the database.

• Using the version of Microsoft Access in which the database is writ-
ten, have your workgroup administrator grant you the permission to
open the database exclusively.

Multiple users can share the database after you convert it, or after you
open it for the first time.

29027 Microsoft Access was unable to save the project. Another user is sav-
ing the project now. Do you want to retry?

29028 The Save operation failed.

29029 You are trying to open a read-only database. The first time you open an
earlier version database, you must be able to write changes to the data-
base.

• The database file’s read-only attribute may be set; clear this attribute.

• You may have chosen the Open Read Only command in the Open
dialog box. Don’t choose this command the first time you open the
database.

• Your license to use this application may have expired.

29030 Microsoft Access can’t establish a reference to the specified database.
The referenced database can’t be found, or it’s locked exclusively by
another user so it can’t be opened. Restore the referenced database
from a backup copy or ask the user that has the database locked to
open the database in nonexclusive mode.
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29031 Microsoft Access can’t create or open the requested database now. The
database may be locked exclusively by another user.

29032 The ‘|’ module is open; Microsoft Access can’t set the permissions on
an open module.

29033 Microsoft Access can’t add references to a replicated database; changes
will be ignored.

29034 Microsoft Access is unable to import the module from the source
replica. Synchronize the source database.

29040 Microsoft Access is currently unable to rename the form, report, or
module to ‘|’. Close the database, reopen it, and then try the rename
operation again.

29041 One or more forms or reports contains an ActiveX control that could
not be loaded. These controls will not function properly until you reg-
ister them, open the forms or reports in Design view, and save the
forms or reports.

29042 One or more forms or reports contains an ActiveX control that could
not be loaded. These controls will not function properly until you reg-
ister them, open the forms or reports in Design view, and save the
forms or reports.

29043 Microsoft Access has converted the code in ‘|’ to your current version
of Visual Basic. To improve the performance of this database, do the
following:

1. Open any module in this database in Design view.

2. On the Debug menu, click Compile And Save All Modules.

29044 DAO version 3.0 is not compatible with this version of Microsoft
Access. Create a reference to DAO version 3.5. For information on set-
ting references, click Help.

29045 You can’t import, export, create, modify, or rename any forms, reports,
pages or modules in an MDE database.

29046 You can’t create a module for a form or report if it is read-only, or if
the database is read-only.

29047 Microsoft Access was unable to open the Visual Basic project for this
database. Another user is saving the project now. Do you want to retry?

29048 MDE databases can’t reference MDB databases. MDE databases can
only reference other MDE databases or type libraries.
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29049 You can’t refer to a form or report module from Form view or Report
preview if the form’s or report’s HasModule property is set to No.
Switch to Design view or set the HasModule property to Yes in order
to refer to the module.

29050 Microsoft Access couldn’t compile this database because one or more
references couldn’t be resolved. The database has not been saved in a
compiled state. The performance of this database will be slower
because Microsoft Access will need to recompile the database for each
session. For information on improving performance, click Help.

29051 The current user account doesn’t have permission to make an MDE file
from this database. To make an MDE file, do the following:

• Join the workgroup that defines the user accounts used to access the
database.

• Make sure the user account has Open/Run and Open Exclusive per-
missions for the database object.

• Make sure the user account has Modify Design or Administer permis-
sions for the MSysModules2 table in the database.

• Request that other users close the database.

29052 The Visual Basic for Applications project in the database ‘|’ can’t be
converted to the current Visual Basic format. If the database is an
MDE, you will need to rebuild the MDE from the source MDB. If you
don’t have the source MDB, you will need to obtain a new version of
the MDE that is compatible with the current version of Visual Basic.

29053 Microsoft Access can’t create any more controls on this form or report.
If you have deleted controls from this form or report in the past, you
may be able to rename the form or report and then add more controls
to it.

29054 Microsoft Access can’t add, rename, or delete the control(s) you
requested.

29055 The form or report ‘|’ has too many controls. Reduce the number of
controls on the form or report before using it in this version of
Microsoft Access.

29056 Someone else is using ‘|’ and the Visual Basic for Applications project
does not match your version of Visual Basic. You need to open the
database exclusively in order to upgrade the Visual Basic for
Applications project in this database.
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29057 The database ‘|’ is read-only and the Visual Basic for Applications pro-
ject does not match your version of Visual Basic. You need to open the
database read-write in order to upgrade the Visual Basic for
Applications project in this database.

29058 You can’t create a module for a form or report while an instance of the
form or report is in browse mode.

29059 Microsoft Access was unable do display the module.

29060 File not found.

29061 There were compilation errors during the conversion or enabling of this
database. This might be due to old DAO syntax that is no longer sup-
ported. For an example on how to fixup the code, click Help.

29062 The module name ‘|’ is misspelled or refers to a module that doesn’t
exist. If the invalid module name is in a macro, an Action Failed dialog
box will display the macro name and the macro’s arguments after you
click OK. Open the Macro window, and enter the correct module name.

29063 The Visual Basic for Applications project in the database is corrupt.

29064 You do not have exclusive access to the database at this time. If you
proceed to make changes, you may not be able to save them later.

29065 Microsoft Access can’t save design changes or save to a new database
object because another user has the file open. To save your design
changes or to save to a new object, you must have exclusive access to
the file.

29066 You do not have exclusive access to the database. Your design changes
cannot be saved at this time. Do you want to close without saving your
changes?

29067 You do not have exclusive access to the database. You cannot convert
this database at this time.

29068 Microsoft Access cannot complete this operation. You must stop the
code and try again.

29069 Microsoft Access cannot save the digital signature at this time.

• You may be in a database under Source Code Control.

• You may be in a database which is read only.

29070 Your Microsoft Access database or project contains a missing or bro-
ken reference to the file ‘|1’|2

• To ensure that your database or project works properly, you must fix
this reference.

• To learn how to fix this reference, click Help.
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29071 Missing or broken VBE reference to the file ‘|1’.

29072 Microsoft Access has detected corruption in this file. To try to repair
the corruption, first make a backup copy of the file. Then, on the Tools
menu, point to Database Utilities and click Compact and Repair
Database. If you are currently trying to repair this corruption then you
will need to recreate this file or restore it from a previous backup.

29073 You do not have exclusive access to the database. You cannot continue
with the Source Code Control command.

29074 Microsoft Access failed to create the Visual Basic module. If your
database is on a network drive, check your network connection, and
then try again.

30000 Microsoft Access could not find the SQL Server specified. Verify that
the server name is correct.

30001 Microsoft Access could not find the database on the server. Verify that
the database name is correct.

30002 Microsoft Access could not log on to the server. Verify that the log on
information is correct.

30004 The Default Max Records setting must be between 0 and 2147483647.

30005 Missing SQL command

30006 Access was not able to perform this operation because the project is
not connected to a SQL Server database.

30007 Can’t sort on one or more fields specified in ‘Order By’ property or
sorting/grouping dialog.

30008 The server you are trying to access is case sensitive. Objects of the
same name but of different case are not supported. Using these objects
may result in a loss of data.

30009 Another user or application has deleted this record or changed the
value of its primary key.

30010 Cannot apply Filter on one or more fields specified in the Filter 
property.

30011 Cannot get column information for the database object being browsed.

30012 A Server Filter cannot be applied to a stored procedure Record Source.
Filter not applied.

30013 You can’t update the record because another user or application deleted
it or changed the value of its primary key.
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30014 The data was added to the database but the data won’t be displayed in
the form because it doesn’t satisfy the criteria in the underlying record
source.

30015 The specified record source contains duplicate names for some output
fields. Use aliases in your SELECT statement to give each field a
unique name.

30016 The field ‘|’ is read only.

30017 This database is not enabled for publication.

30018 Cannot create objects of type ‘|’ against current SQL backend. Please
check your permissions and server setup.

30019 Microsoft Access cannot copy a table with a name that is longer than
64 characters.

30020 Cannot find column ‘|’.

30021 Cannot use domain functions on stored procedures.

30022 The Access project could not be opened. You may not have adequate
permissions, or the project may be read-only.

30023 Cannot use domain functions on scalar functions.

30024 Your password will not be encrypted before it is saved to the file. Users
who view the source contents of the file will be able to see the account
user name and password.

30025 Invalid SQL Statement. Check the server filter on the form record
source

30026 Access is unable to connect to ‘|1’ database on the ‘|2’ server. Make
sure that the database still exists and that the server is running.

30027 The value you entered is not consistent with the data type or length of
the column.

30028 The database name for the attached database file is blank. Enter a name
for your database.

31000 You must specify criteria for all conditional formats.

31001 A conditional format expression can’t be longer than 946 characters.

31002 Microsoft Access can’t modify the control’s conditional formats right
now. Your program tried to modify the conditional format of a control
while the conditional format was being evaluated.

31003 The setting for this property is too long. You can enter up to either 255
or 2,048 characters for this property, depending on the data type.
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31500 Microsoft Access can’t send this format in a mail message. To send
this format in a mail message, click Export on the File menu, or use
the OutputTo method to create the files and attach them to a mail mes-
sage.

31502 Microsoft Access can’t find the Microsoft Office international
dynamic-link library (DLL). Reinstall Microsoft Office.

31507 Invalid field data type.

31508 Cannot load the Office Web Components. Access had a problem load-
ing the Office Web Components Version 9.0. Try going through set-up
to re-install them.

31509 Cannot load the Office Web Components. Access had a problem load-
ing the Office Web Components Version 10.0. Try going through set-up
to re-install them.

31510 Microsoft Access can’t load the dynamic-link library |. You need to
resolve the failure and start Access again.

31511 You have chosen to alter the mode in which SQL syntax will be inter-
preted in this database. This will mean:

• Existing queries may return different results or not run at all.

• The range of data-types and reserved words will change.

• Different wildcards will be used.

It is recommended that you make a backup copy of this database
before continuing. If you agree to continue, Access will close this data-
base, compact it, and re-open in the new mode. Select OK to continue.

31512 Microsoft Access can’t open the mail session. You may not have con-
figured an e-mail client on this computer. Ensure that your e-mail soft-
ware has been installed and configured properly.

31513 All open objects must be closed prior to converting to a different ver-
sion. Do you want Microsoft Access to close the objects?

31514 Microsoft Access can’t convert this database to a different version
because one or more objects are open. Close all objects and try again.

31515 Your database is using SQL Server Compatible Syntax (ANSI 92) for
which Access 2000 has limited support. This will mean:

• Access 2000 users may not be able to see some queries.

• Existing queries may return different results or not run at all.

• The range of data-types and reserved words will change.

• Different wildcards will be used.
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It is recommended that you change the SQL Server Compatible Syntax
(ANSI 92) setting before converting this database to the Access 2000
file format. Select Cancel to abort the conversion process and change
the SQL Server Compatible Syntax (ANSI 92) setting.

31516 Microsoft Access can’t convert this database to the requested version
because it has been ‘enabled’ to work with newer versions of Microsoft
Access than it was originally created with. You can convert this data-
base to a newer format, and then retry this operation with the newly
converted database.

31517 Microsoft Access can’t convert this database to the requested version
because it is from an older version of Microsoft Access. You can con-
vert this database to a newer format, and then retry this operation with
the newly converted database.

31518 The following controls contain expressions that can’t be represented in
a Microsoft Access project PivotTable or PivotChart view: |. Do you
still want to switch to PivotTable or PivotChart view?

31519 You cannot import this file. You cannot import a text file unless it has
one of these extensions: |.

31520 You cannot import this file. You cannot import a text file that has one
of these extensions: |.

31521 Cannot establish connection to the server.

31522 Microsoft SQL Server Desktop Engine must be on the machine run-
ning Microsoft Access.

31523 Microsoft Access was unable to open the file ‘|’. The file may not be an
Access file, the path or filename specified may be incorrect, or the file
can not be opened exclusively. To repair the file manually, on the Tools
menu, point to Database Utilities, and then click Compact and Repair
Database.

31524 Microsoft Access can’t transfer the user-defined function ‘|’. User-
defined functions can only be transferred between Microsoft SQL
Servers that are version 8.0 or higher.

31525 The selected object can’t be pasted because the version of either the
source or the destination server is less than 7.0. Microsoft Access can
only copy and paste this object if both Microsoft SQL Servers are ver-
sion 7.0 or higher.

31526 You can’t create a Microsoft Access MDE database from a database in
Microsoft Access 2000 file format. Close the database and convert it to
the current version of Microsoft Access. Then create the MDE data-
base.
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31527 Path not found: |.

31528 Table ‘|’ is in use. Please close the table and retry import.

31529 View ‘|’ is in use. Please close the view and retry import.

31530 Procedure ‘|’ is in use. Please close the procedure and retry import.

31531 Microsoft Access cannot create table(s) using the information con-
tained in the document(s) you are trying to import.

31532 Microsoft Access was unable to export the data.

31533 Invalid filename.

31534 Your database is using SQL Server Compatible Syntax (ANSI 92) for
which Access 97 has limited support. This will mean:

• Existing queries may return different results or not run at all.

• The range of data-types and reserved words will change.

• Different wildcards will be used.

It is recommended that you change the SQL Server Compatible Syntax
(ANSI 92) setting before converting this database to the Access 97 file
format. Select Cancel to abort the conversion process and change the
SQL Server Compatible Syntax (ANSI 92) setting.

31535 Invalid parameters for ExportXML. Press Help for more information.

31536 The XML schema properties do not match the existing table structures.
Overwrite existing structures?

31537 There is already an object named ‘|’ in the database.

31538 Microsoft Access cannot create this file. To create the file, you must
give the file a unique name, provide a valid connection string and user
ID, and you must have the necessary connection and file creation per-
missions.

31539 There was an error loading the XSL transformation file. Please make
sure that the file is a properly formatted XSL file and is the correct file
to use for the data supplied.

31540 There was an error loading the XML data file. Please make sure that
the file is a properly formatted XML file.

31541 Microsoft Access cannot open this file. This file is located outside your
intranet or on an untrusted site. Microsoft Access will not open the file
due to potential security problems. To open the file, copy it to your
machine or an accessible network location.

31542 The startup action associated with this file may not be safe. Do you
want to execute the startup action as you open the file?
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31543 The startup action associated with this file may not be safe. If you
choose not to execute the startup action, Microsoft Access will not
open the file. Do you want to execute the startup action and open the
file?

31544 Microsoft Access cannot open this file. The author of this file has set it
to open only when a startup action is executed, and Microsoft Access is
currently set to disable startup actions. To address this problem, contact
the author of the file or your system administrator.

31545 Microsoft Access cannot open this file. The Internet Security Zone
Manager is missing or not correctly installed and therefore the safety
of this file cannot be verified. To address this problem, reinstall
Microsoft Internet Explorer or the appropriate Office System Pack.

31546 This database is a Microsoft Access 7.0/8.0/9.0 Design Master. If you
click OK, the database you selected will be renamed to |1 and then
converted to |2. Everyone using a replica of this database will have to
upgrade to Microsoft Access 2002 after the next synchronization.

31547 Microsoft Access cannot export this object to XML when it is open in
Print Preview. Close the object and try again.

31548 Microsoft Access cannot export a table to XML when it is open in
Design. Close the object and try again.

31549 Finished importing document ‘|’.

31550 Not all of your data was successfully imported. Error descriptions with
associated row numbers of bad records can be found in the Microsoft
Access table ‘|’.
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